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1. Purpose of the document

This manual contains information on the implementation of the data collection phase
for aerial triangulation workflow.

Aerial triangulation includes the following steps:

* Interior orientation of block images;

» Measurement of tie points coordinates on images, relative orientation of block images;
* Preliminary exterior orientation of block images:

o Input of ground control points (GCP) coordinates to catalogue and measurement
of these points coordinates images;

o Import and usage of preliminary exterior orientation data, obtained with inputimages.

Q In most cases, source images acquired by digital camera, might contain metadata, written
in EXIF format.

If images containing metadata are available in a project, it is possible to import from the
metadata to the project parameters of interior orientation (precise) and exterior orientation
(approximate, i.e. calculated by on-board devices).

The detailed aerial triangulation workflow is described in Section 1.1.2. After data col-
lection to form a block for aerial triangulation the block adjustment is performed (see
the “Block adjustment” User Manual).

The ultimate goal of work on aerial triangulation and block adjustment is defining of
exterior orientation parameters, that allow to proceed to block processing step, which
includes stereo vectorization, creation of DEM, orthomosaic and 3D models (see the
“Vectorization” User Manual).

Q When accurate enough exterior orientation parameters of block images are available, it is possible
to skip steps of GCP and tie coordinates measurement, as well as block adjustment step from
the workflow and proceed right away to steps of stereovectorization, DEM and orthomosaic
generation (see how to estimate accuracy of imported exterior orientation parameters in Sec-
tion 4.1.4).

Otherwise, if there are inaccurate exterior orientation parameters of block images, imported
exterior orientation parameters are used to block scheme refinement (see above).

1.1. Aerial triangulation data

1.1.1. Source data

In order to create and adjust photogrammetric network the following source data is
used:
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 data acquired on step of network creation - aerial triangulation:

o parameters of interior orientation:

m data that specify position and orientation of coordinate system of each block
image in relation to coordinate system of digital image;

m set of surveying camera parameters, that includes coordinates of image principal
point, camera focal length and objective distortion, defined during camera calib-
ration and used for interior orientation.

Interior orientation parameters of images allow to find out a position of projection
center in relation to image, in other words to restore set of projecting beams (using
method of pyramid), existed in a moment of photographing.

A

Itis necessary to perform interior orientation for central projection images acquired by film
or digital camera.

Interior orientation of scanner images — space borne images or ADS 40/80/100 data — are
not available in the system, since those images are delivered along with metadata files
which contain interior orientation parameters (see information about types of data/projects
in the “Project creation” User Manual).

o parameters of relative orientation — data of relative orientation acquired after
measurement of in-strip and inter-strip tie points coordinates on block images;

o results of measurements of ground control points (GCP) coordinates on block im-
ages (see the Section 4.2.1).

 data of interior and/or exterior orientation obtained from the data provider;

7

7

Delivery set of central projection images may include exterior orientation parameters, calcu-
lated by on-board GPS/IMU systems, or metadata with exterior orientation parameters for
UltraCam camera. For space borne scanner images — metadata with interior/exterior orient-
ation parameters or RPC-coefficients. For ADS 40/80/100 images — also metadata with interi-
or/exterior orientation parameters.

If high precision exterior orientation parameters are available for central projection images it
is possible to exclude steps of measurement of tie and GCP coordinates, as well as block
adjustment step and to proceed to project processing right away (see the “Vectorization” and
“‘DEM” User Manuals).

In this case on a step of data collection for aerial triangulation it is necessary to perform ex-
terior orientation parameters import, and then perform adjustment using imported data (see
the Section 7.5).

+ auxiliary data: overlap size of block images, quick ties data, ground sample distance
(GSD) or data about elevation difference on terrain.
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Main and additional data for aerial triangulation is used to create block layout, that is
used for visual control of block scheme during the data collection. Created block layout
may be considered for initial adjustment (see the “Block adjustment User Manual).

Block layout — approximate scheme of terrain, obtained using projecting of matched images of

a block on specified surface (Earth surface) considering images overlaps, relative position, ro-
tation by angles in a space.

1.1.2. Aerial triangulation workflow

This chapter contains recommended aerial triangulation workflow, depending on available
source data.

During all steps of aerial triangulation procedure it is recommended to perform data
accuracy control (see the Section 1.1.3).
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Fig. 1. Aerial triangulation workflow
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1.1.3. Data quality control

The system provides the following tools to perform quality control of collected data for
aerial triangulation operation:

1.

2.

3.

Project state report allows to estimate current state of the project in whole.

Choose Project » Project state or click the [¥Z| button of the main toolbar. The
Project state window opens, which displays what kind of works was performed
and contains a toolbar which allows to perform/adjust results of each processing
step.

@ Buttons of the Project state window toolbar are the same as buttons of the AT additional
toolbar and some of them duplicate items of the Orientation menu.

Completed aerial triangulation is marked by the ¥ symbol, partly performed — ¥,
not performed — 3.

r. Project state ﬁ-‘
Images: 10, sfrips: 2 | ==, || E || fﬂ |

W Interior orientation | @ || ﬁ || @ || Eg' || EEQ |
v Relative orientation | % || ﬁf || :‘53" || X H : ]

' Exterior orientation | it |

| Refresh || Close |

Fig. 2. Project state report
The Project state window shows a project state on the following processing steps:

* block forming — number of strips and images (see the “Project creation” User
Manual);

* interior orientation;

* relative orientation;

« exterior orientation (see the “Block adjustment” User Manual).

For refreshing data about project state after changes the Refresh button is used.
Interior orientation report.

Relative orientation report.
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4. Block layout allows to perform visual control using block scheme, created considering
source or collected data for aerial triangulation: overlap areas size, quick ties data,
results of ties/GCP measurement, interior orientation data, etc.

1.2. The “Orientation” menu

To perform work on data collection for aerial triangulation serves the Orientation menu,
and also buttons of the main toolbar and of the AT additional toolbar.

Table 1. Brief description of the “Orientation” menu

Buttons Functions

i3 Manage cameras (Ctrl+Alt+l) to input/edit parameters of project cameras, and
also to assign cameras to project images (see the

Section 3.3)
Interior orientation contains menu items used to perform interior orient-
ation of central projection images (see the Sec-

tion 3.1)

Quick Ties contains menu items used to perform quick ties in

order to use the data for block layout creation (see
the Section 2.2.2)

¥ Tie points list (CtrI+Alt+T) to open catalogue of all tie points with their meas-
urements (see the Section 5.3)

i1 GCP list (Ctrl+Alt+G) to open catalogue of all ground control points, includ-
ing non-measured on block images (see the Sec-
tion 4.2)
it Delete point measurements to choose types of triangulation points to be deleted
and delete them
#€ Clear point catalogue to remove the whole list of triangulation points (GCP,
check, tie) from triangulation points catalogue
i5* Automatic tie points measurements to measure tie points coordinates in automatic mode
(CtrI+Alt+A) (see the Section 5.6)
Automatic GCPs measurements... to measure GC points if supplement ground control

data are available, i.e. an orthoimage and DEM,
coverage of those considerable coincide with the
terrain showed in the imagery of the project under
processing (see the Section 4.3)

{E Report on relative orientation (Ctrl+Alt+R) |to open the report with results of images relative
orientation in order to perform analysis and removal
of errors in tie points measurements (see the Sec-
tion 5.9)

# Load triangulation points to load measured coordinates of triangulation points
to 2D-window with possibility to setup of display of
certain type of points (see the Section 6.4)

Delete points outside useful areas to delete points out of useful areas (with specified
background color) (used mainly during automatic
points measurements on spaceborne images)

10
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Buttons

Functions

Delete border points

to delete points of selected types from near-bound-
ary areas of project images marked in the list

Delete duplicated points

to delete tie points duplicates

iI2 Open selected images for measurements

to open the Points measurement module used to
measure points coordinates in manual mode on
images selectedin 2D-window

2 Open images containing marker (Ctrl+Alt+K)

to open the Points measurement module used
to measure points coordinates in manual mode on
images, that contain marker position in 2D-window

{00 Open in-strip stereopair

to open the Points measurement module used to
measure points coordinates in manual mode on
selected in-strip stereopair in 2D-window

i2 Open inter-strip stereopair

to open the Points measurement module used
to measure points coordinates in manual mode on
selected in 2D-window inter-strip stereopair

Exterior orientation data list

to open the Exterior orientation data list

Load projection centers as vectors

to load projection centers data as vector point ob-
jects and to open them in 2D-window to perform
analysis, at that an image name is saved to the Name
point attribute

Select subblock

to select part of block images to perform adjustment

Block adjustment (Ctrl+Alt+S)

to show the Adjustment toolbar, which is used to
perform adjustment, to view its results and errors
correction (see the “Block adjustment” User Manual)

&2+ Adjustment in batch mode

to specify adjustment parameters and to perform
block adjustment without using the the Adjustment
toolbar (see the “Block adjustment” User Manual)

i/ Direct georeferecing

allows to perform adjustment using imported exterior
orientation parameters

& Processing report

to open the Block processing report

Export images orientation to RPC

to export refined RPC-coefficients after adjusting a
scanner project (see the “Adjustment of scanner
blocks” and “Export of refined RPC-coefficients”
chapters of the “Block adjustment” User Manual)

Delete adjustment results

to delete adjustment data (see the “Block adjust-
ment” User Manual)

Subblock analysis

to perform the subblock analysis by triangulation
points

Import exterior orientation

to perform import of exterior orientation results

Import UltraCam Osprey orientation

to perform import of exterior and interior orientation
data from a separate file with *.eo extension (for
UltraCam Osprey projects)

Export of exterior orientation parameters

to perform export of list of source exterior orientation
parameters and adjustment results to PAT-B and
CSV formats

11
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Buttons Functions
Import orientation from metadata to perform import of exterior orientation from
metadata
Create images georeferencing files to perform export of georeference data after prelim-

inary block exterior orientation and adjustment (to
files of Arcinfo World File andMapinfo TAB formats)

Import contains menu items used to import of triangulation
points measurements from files of PAT-B, X-Points
formats from PHOTOMOD 4.x (XPT) projects, as
well as data import from flight path file

Export contains menu items used to export of triangulation
points measurements to files of PAT-B and X-Points
formats, and for export of ties or GCP for further
use them in Geomosaic module

2. Block layout

2.1. Data for block layout creation

Block layout — approximate terrain scheme (further on — block scheme), obtained by
coinciding images on adjacent overlapping areas.

Depending on data set block layout is divided into primary, rough and final. With the
accumulation of information block scheme contains more accurate data than the initial
scheme. As a result, after a correctly performed adjustment block layout represents the
final form of block scheme.

Block layout is used for visual estimation of images position. Moreover, primary block
layout is an obligatory condition for automatic measurement of tie points coordinates.

For block layout creation it is necessary to have the following data available (the data
are listed in increasing order of block layout accuracy):

* Size of images overlap areas in strip and between strips — this value is known or is
estimated using quick ties of the same points on terrain on block images. Size of
images overlap areas are used to create primary block layout;

* quick ties data, that are obtained using approximately specified points of terrain on
adjacent images of block scheme in 2D-window. Quick ties data is used to create
primary block layout and significantly refine block scheme created “by overlaps”;

* tie points coordinates are obtained using measurement of coordinates of the same
points on terrain on images with specified accuracy manually or in automatic mode;

? Block layout accuracy depends on measurements accuracy and tie points number. For ex-
ample, for primary block layout it is enough to measure coordinates of coordinates of a small
number of tie points between images and use this data instead of quick ties data. With the

12
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accumulation of “qualitatively measured” tie points coordinates a block layout accuracy in-
creases (see the Section 5.6, Section 5.4).

* GCP coordinates (if any) — are used to create block layout. As a result, block layout
created by GCP shows a block scheme in real coordinate system;

* exterior orientation results (if any) — are imported to a project and are used for block
layout creation;

5 block layout, created by exterior orientation parameters is a projection of images considering
real coordinates of projection centers and images rotation by interior orientation angles (see
the Section 7.5).

 adjustment results — are used as imported adjustment results or after performing of
block adjustment (if there are adjustment data enough). Block layout, created by ad-
justment results is a final kind of a block scheme (see the “Block adjustment” User
Manual);

» ground sample distance (GSD) (if any) — are specified manually or calculated auto-
matically using digital elevation model (DEM) data.

é GSD parameter influences on a size of images during block layout creation (see the Sec-
tion 2.2.1).

2.2. Block layout creation
To create block layout perform the following actions:

1. Collect data for block layout creation.

§ If exterior orientation parameters are available it is recommended to use first of all imported
data to create block layout. Creating block layout considering exterior orientation parameters
significantly reduces processing time during aerial triangulation step, and if the parameters

are quite accurate it is possible even to skip the step.

ﬁ It is recommended to create block layout once more after adding new images to a project.

2. Choose Window > Block layout (Ctrl+Alt+L) or click the |8 button of the main
toolbar. The Block layout window opens.

13
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r. Block layout Iﬁﬁ
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Fig. 3. Parameters of block layout creation

3. Inthe Mode section select one of three modes of block layout creation or choose
to skip block layout creation step:

+ By ties — used to create block layout by tie point coordinates or by other data,
selected by checkboxes in the Block layout window;

» Wi/o layout — used to cancel block layout creation, returns a block scheme to its
initial state after images loading;

* By EO — used to create block layout by imported exterior orientation parameters
only, other data is out of scope.

§ This mode allows just images scaling and DEM considering.

* By centers — used to create block layout by coordinates of images projection
centers and is intended for creation of UAS images block scheme.

% This mode allows just images scaling and DEM considering.

14
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@ As other data is accumulated and becomes available, a block layout, created by projection
centers coordinates is automatically adjusting using the Block > Block layout » Refresh
menu item.

4. [optional] To create block layout by part of images block, set the Use subblock
checkbox on and click the Select subblock button. Choose images to define con-
tains of a subblock with standard images selection tools and click OK.

5. Setup parameters of selected mode.
In the By ties mode set the following checkboxes:

+ Initial approximation: overlap — allows to specify size of overlap area between
interstrip in strip images (in percent), if size of the overlaps are constant within a
block. This data is necessary for creation of primary block layout. In other case,
for layout creation different data is used — quick ties, for instance;

* QuickTies — allows to use manual linking lines between the same points of terrain
roughly specified on adjacent images (with accuracy of several hundreds of
pixels). It is recommended to set at least two “links” for each stereopair and two
“links” between strips of a block;

@ The Edit button allows to proceed to create/edit data mode on the QuickTies layer.

+ Tie points — allows to use tie points coordinates measured in manual or automatic
modes;

? For primary block layout it is possible to measure a small amount of tie points on in-strip
and inter-strip images instead of quick ties, that provides more accurate “ties” between
images on a block scheme.

* GC points — allows to use coordinates of measured GCP;

? Block layout created by GCP displays block scheme in real coordinate system.

* Imported exterior orientation — allows to use preliminary imported exterior ori-
entation parameters. Select the Projection centers and angles or the Projection
centers only option. Block layout, created by projection centers coordinates and
exterior orientation angles, is projection of images considering real coordinates
of projection centers and rotation angles;

§ This parameter allows to consider exterior orientation data for creation of block layout
along with other data, in contrast to the By EO mode, which considers only exterior ori-
entation parameters.
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* Adjustment results — allows to use adjustment results that were imported or
obtained during block adjustment. Block layout, created by adjustment results is
a final version of a block scheme.

A For block layout creation it is more preferable to use adjustment results in contrast to
other data. It means that if there are no adjustment results available for block images,
so during block layout creation for these images the system considers other data specified

in the Block layout window. Otherwise, just adjustment results are considered.

@ The ¥ button allows to clear all selected checkboxes.

In the By ties, By EO, By centers modes setup the following parameters:

» the Image scaling slider allows to display images zoom in 2D-window (for ex-
ample, X4.00 — leads to zoom in an image 4 times); it is used for visual control
of images position without overlaps;

» the Account for DEM button allows to use ground sample distance (GSD),
specified manually or calculated automatically by DEM data during block layout
creation (see Section 2.2.1);

é In order to use GSD value during block layout creation it is necessary to have interior
and exterior orientation parameters (projection centers coordinates, at least).

c When using tie and GCP coordinates or adjustment results (appropriate options should

be selected in the Block layout window) GSD value is not considered during block
layout creation.

« ifimage GSD is unavailable, relief elevation data specified in project properties
is considered for block layout creation (see the “Project creation” User Manual).

c Relief elevation is considered during block layout creation only if GSD data is unavailable.

6. [optional] In order to resolve specific problems caused by incorrect data input click
the More button. The Block layout (additional) window opens.
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r. Block layout (additional) |
Scale difference D
min max
Curving D
min max
Images deformation D
min max
Paoint rejection percent D
min max
Rotate all blodk by 0 =1
[ oK ] | Cancel |

Fig. 4. The Block layout (additional) window

Setup the following parameters:

Scale difference — parameter proportional to scale difference between adjacent
images in a strip;

Curving — parameter proportional to rotation angle between adjacent images in
a strip;

Images deformation — parameter proportional to difference of images boundaries
shapes on a block scheme;

Point rejection percent — percent of tie points which coordinates are not con-
sidered during block layout creation;

Rotate all block by — angle of a block scheme rotation in degrees.

7. Click the Apply button. As a result, the block scheme in 2D-window is rebuild con-
sidering specified parameters (the Block layout window is opened meanwhile).

If the Use subblock checkbox is set on and images contain subblock are chosen,
the block scheme in 2D-window is rebuild considering parameters of chosen images.
All images are not included in the subblock is no longer displayed.

7

In order to create a block layout without parameters setup, double click the name of block layout
mode in the Mode section of the Block layout window.

The system provides possibility to create a block scheme by UAS images if angular
exterior orientation parameters of block images are specified with low accuracy or are
unavailable. For this operation it is necessary to use the *{ button on the Exterior
orientation parameters window toolbar:
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’. Compute Kappa angle by flight direction [&J

@ For allimages

For the selected images

Mare ] | QK | | Cancel

by o

Fig. 5. The Compute Kappa angle by flight direction window

Specify how to compute Kappa angle by flight direction — for all images of for the
selected images only. For each highlighted image the program calculates the direction
from previous to next center in a strip (for utmost images of a strip — from adjacent image
to the current one) and kappa angle is setup from this direction.

é If the survey time is available the correct images order is checked, otherwise images in strips
should be located in chronological order only.

é If the survey time is available the correct images order is checked, otherwise images in strips
should be located in chronological order only.

For quick access to functions of block layout creation it is used the additional Block
layout toolbox which buttons partly duplicate the Block > Block layout menu. To open
the Block layout toolbox select Window » Toolbars » Block layout.

The Block layout menu contains menu items used to perform the following operations:

« 48 Refresh — allows to rebuild a block layout after some changes (equivalent to the
action of the Apply button in the Block layout window);

§ Block layout mode is not change when the 5 Refresh button or menu item is used.

« HE W/o layout — allows to cancel block layout creation, and reverts a block scheme
to its initial state after images load (equivalent to the W/o layout mode in the Block
layout window);

- B2 By exterior orientation — allows to create a block layout using only imported ex-
terior orientation parameters (equivalent to the By EO mode in the Block layout
window);

* Load... —allows to load previously saved block layout from file with *.x-1ini extension
from active profile resources;

+ Save... — allows to save current block layout to file with *.x-ini extension in active
profile resources;
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» Delete auto block layout results — allows to delete results of block layout created
by UAS images in automatic mode, including thelmage Transforms.x-ini file with
matching results.

2.2.1. DEM use for block layout creation

During block layout creation the system allows to consider GSD value, specified
manually or calculated automatically by DEM. GSD value is influenced on a size of
block image.

é In order to use GSD value during block layout creation it is necessary to have interior and exter-
ior orientation parameters (projection centers coordinates, at least).

ﬁ When using tie and GCP coordinates or adjustment results (appropriate options should be se-
lected in the Block layout window) GSD value is not considered during block layout creation.

To create block layout considering GSD value perform the following actions:

1. Choose Window > Block layout (Ctrl+Alt+L) or click the §§ button of the main
toolbar. The Block layout window opens.

2. Click the Account for DEM button. The Ground sample distance (GSD) window

opens.
-
@ Ground sample distance (GSD) e e
E RN SetGsDvale
GsD:

Mame G50, m Int.er. Ext. or. GSD modified "

N Calculator
J '0.1?89... - + Image pixel size, pm
V| 665 01797... - + 5 ; .
7] 666 01799... - + i :
V| 667 01798... - +

Unset GSD Set GSD

V| 668 01804... - + I—I I—I
V| 669 01800... - + Compute by DEM
¥ 670 01800... - * DEM dem2m.x-dem - (2x 2) m
V|67 01804... - +

472 | Use Z-value for NULL DEM cells
V| 680 01769... - + 0.00 = m
JI 679 01792... - + To compute image GSD by DEM the image interior and exterior orientation parameters are
V| 678 01804... - + to be spedified.
v| 677 01808... - +

Compute
7] 676 01798... - . 2
J| 675 01802... - +
V| 674 01795... - +
J| 673 01807... - +
OK Cancel

Fig. 6. Specifying of GSD by DEM or manually

3. Choose block images in the table in order to setup GSD value for them.

ﬁ There is a possibility to specify GSD value of project images in advance — on step of block
forming using the Block » Set GSD menu item (see the “Project creation” User Manual).
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4. Choose one of the following ways of GSD value defining:

+ to specify image GSD value manually input this value to the GSD field in the Set
GSD value section and click the Set button. Specified GSD value will be shown
in the table;

* to calculate image GSD value using calculator perform the following actions:

1. In the Image pixel size, um field input a pixel size in micrometers or click
the From project button for automatic detecting of pixel size.

2. Inthe Survey scale field specify a survey scale.
3. Click the Set button. Calculated GSD value will be shown in the table.
* to calculate image GSD value using DEM data perform the following actions:
A To calcul_ate image GSD vglue u_sing IZ_)EM data during bloc_k Ia_yout creation itis necessary
to have interior and exterior orientation parameters (projection centers coordinates, at

least).

1. Inthe Compute by DEM section in the DEM filed click the _... | button, specify
file name and its location in active profile resources.

2. [optional] To fill in blank cells of DEM by specified elevation values, set the
Use Z-value for NULL DEM cells checkbox and specify Z coordinate value.

3. Click the Compute button. Calculated GSD value is displayed in the table.

5. [optional] To cancel input or calculated GSD values, select images in the table and
click the Unset GSD button. As a result in the GSD, m column of the table for se-
lected image the — sign is displayed for selected images.

6. To save input or calculated GSD values, click the Apply button.

7. To create block layout considering GSD values, click OK in the Ground sample
distance (GSD) window then click the Apply button in the Block layout window.
If during block layout creation tie or GCP coordinates are not used, a block scheme
is rebuild considering input or calculated GSD values.

2.2.2. Manual images linking (quick ties)

Quick ties between images are used to create primary block layout. Quick ties include
setting of “links” between images using approximately specified (up to several hundred
pixels) same points of terrain on adjacent images in 2D-window.

It is necessary to consider the following recommendations for manual images linking:
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1. Itis recommended to link together all the images in strips first, and then to link the
strips.

2. It is recommended to set at least two “links” for each stereopair and two “links”
between adjacent strips.

3. A pair of identical terrain points should be selected in different parts of the strip
images.

@ At sufficiently precise and stable overlaps size within the entire block it is necessary to have a
bit of quick ties data to improve a block scheme. Thus, if the size of in-strip overlap (between
stereo pairs) in all strips is fixed, then link only strips.

1:1:5 Block scheme. 8 x

Ot e E @EDAQTRAAR s |

T T !

y
= i o ] [ U | =)= =] (@0 e &)
[580755.087703 m; 541028 1,885550 m; 0.000000 m _(R=068 G=054 E=162) [Cartesian Right

Fig. 7. Manual images linking (quick ties)
To create quick ties between images perform the following actions:

1. Choose Orientation » QuickTies > Edit or click the Edit button in the Block layout
window. The Quickties active layer is created in the Manager.

2. Draw/edit quick tie lines between block images in the following way:

» to add a link place marker to selected terrain point on one image and press the
Insert key, then place marker to corresponding terrain point on another image
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(appeared rubber line is stick to the first selected point) and press the Insert key.
Set “links” are displayed in 2D-window by turquoise lines;

+ to cancel link line when the first point is already specified, press the Esc key and

the rubber line will disappear;

 to delete link line select it by double click or place marker in the neighborhood of
the link line and press the S key (link line becomes yellow) and press the Delete
key. To delete multiple link lines press and hold the Shift key, while dragging a
rectangular by mouse over the area where lines are located (rectangular selection
mode should be on (more details see in the Vector objects selection chapter in

the “Vectorization” User Manual));

+ to delete all quick ties choose Orientation > QuickTies » Clear.

3. Choose Orientation > QuickTies » Save to save quick ties data.

@ Quick ties data are saved automatically during block layout creation and during completing

of work session in the system.

3. Images interior orientation

3.1. The “Interior orientation” menu

To determine project cameras and to perform interior orientation of central projection
images the system provides the following interface elements:

+ the Orientation > Manage cameras menu item allows to create cameras of a project;

+ the Orientation » Interior orientation menu items allow to perform interior orientation

and accuracy control;

 buttons of additional AT toolbar duplicate menu items and are used for quick access
to the items. In order to open the AT toolbar, choose Window » Toolbars » AT.

Table 2. Brief description of the “Interior orientation” menu

Buttons

Functions

[ Report on interior orientation

to open a report about interior orientation results
(see the Section 3.5.6)

[} Manual interior orientation

[only for film camera images] to measure manually
coordinates of fiducial marks on images

. Semiautomatic interior orientation

[only for film camera images] to perform semiauto-
matic interior orientation, which is to use image-
standard with template of fiducial marks position
used to search the same fiducial marks on other
project images
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Buttons Functions

¥ Automatic interior orientation [only for film camera images] to perform automatic
interior orientation, which is the automatic recogni-
tion of fiducial marks by their type, peculiar to certain
analog camera images

Jc Calculate interior orientation to re-calculate interior orientation parameters

Delete interior orientation data to open the Select images window that is used to
delete results of fiducial marks measurements on
selected images

3.2. Interior orientation workflow

Interior orientation is performed to calculate parameters which define a position and
orientation of film image coordinate system relatively to coordinate system of digital
image. Besides, interior orientation allows to define parameters describing a systematic
film image distortion can be found.

Result of interior orientation operation is obtaining of interior orientation parameters
used to transform measurement results from the digital image coordinate system to the
film image coordinate system.

Three types of transformation from the digital image coordinate system to the film image
coordinate system are implemented in the system (according to camera passport data):
affine, projective and rotation-scale-shift. Affine and projective transformations are
usually performed if during calibration fiducial marks coordinates were specified in
surveying camera coordinate system. These transformations are executed while exclud-
ing systematic distortion on images.

To define parameters of affine transformation it is necessary to measure coordinates
of at least three fiducial marks, and to define projective transformation parameters — at
least four fiducial marks. Otherwise it is necessary to apply simple rotation-scale-shift
transformation.

5 Interior orientation is performed for central projection images acquired by film or digital camera.
Interior orientation of scanner images — space borne images or ADS 40/80/100 data — is not
available in the system, since metadata files containing interior orientation parameters are de-
livered along with images from RS data provider (information about types of data and projects
see in the “Project creation” User Manual).

In general case, to perform interior orientation of central projection images the system
provides the following workflow:

1. Defining project cameras that includes the following steps:
* input of camera passport data;

» assign cameras to project images;
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+ define directions of camera axes for project images.
2. Perform interior orientation for the following types of images:
* images acquired by digital camera;
* images acquired by film camera.
3. Accuracy control of obtained interior orientation results (see the Section 3.5.6).

In most cases, source images acquired by digital camera, might contain metadata,
written in EXIF format. If images containing metadata are available in a project, it is
possible to import from the metadata to the project parameters of interior orientation
(precise) and exterior orientation (approximate, i.e. calculated by on-board devices).

In this case, the process of interior orientation actually comes down to importing the
necessary data.

When deleting images from a project it is strongly recommended to synchronize the data in the
project to remove redundant orientation results. To do this choose Project » Synchronize.

3.3. Project cameras management

3.3.1. Images selection and highlighting

The system provides a set of standard tools and ways of selection and highlighting of
project images in lists and tables of the system’s dialogue windows.

Project images

W E: F =E oF &2 G
Mame Int. or. Camera Rotation
4 1

DMCx-cam  180°
DMCx-cam  180°
DMCx-cam  180°
DMCx-cam  180°

= RJ W = Ln
+ + + + +

W DMCx-cam  180°
4 | 2

10+ DMCoc-cam  0°

¥ 8 + DMCoc-cam  0°

V| 8 + DMCoc-cam  0°

S 7 + DMCoc-cam  0°

6 + EDMC.x-cam os

Fig. 8. Standard ways of images selection in lists/tables
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To select/highlight images in a table or list there are the following tools:
* selection of images/strips using checkboxes near the image or strip name;

* highlighting of images/strips by mouse click on the image or strip name;

@ In order to highlight multiple images or strips, press and hold the Ctrl or Shift key while
clicking mouse.

+ selection of images using standard toolbox, which contains the following buttons:
o i@ — allows to select all images;
o EE — allows to unselect all images;
o =2 — allows to inverts images selection;
o = — allows to select highlighted images;
o O — allows to unselect highlighted images;

o kkh8 — allows to select in a table or list those images which are highlighted on a block
scheme in 2D-window;

o kB8 — allows to highlight on a block scheme in 2D-window those images which are
selected in a table or list.

3.3.2. Project cameras management

Prior to executing interior orientation it is necessary to define parameters of cameras
which were used to acquire project images.

In order to define project cameras, input their parameters from passport data, assign
cameras to project images and define directions of cameras axes for specific project
images the Manage cameras window is used.

In order to open the Manage cameras window choose Orientation » Manage cameras
or click the @ button of the AT additional toolbar.
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. Manage project cameras Iﬂ
Project images Project cameras
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WO oE O dEEd 88 & >N
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664 - Zeiss... 0°
665 - Zeiss ... 0°
666 - Zeiss ... 0° Change camera for selected images
667 - Zeiss .. 0° Assign selected camera to selected images
668 - Zeiss... 0° . .
Zeiss . OF [] set camera rotation for selected images
Zeiss... 0° @ o° 90° dodkwise
i = Execute
Zeiss. 0 180® 270" dockwise
Zeiss .. 0° 570
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Zeiss .. 0° o “ I;' ﬂ;ﬁ
Zeiss .. 0°
- Zeiss... 0°
675 - Zeiss ... 0°
674 - Zeiss... 0°
673 - Zeiss ... 0°

14592 x 15104 pix

Close

Fig. 9. The Manage cameras window
the Manage cameras window contains the following sections:

» the Project images section is used to select project images and to view statistics for
each image: assigned camera, camera axes orientation and current step of interior
orientation; the section also includes a table of all project strips/images, their para-
meters and standard toolbox for images selection;

» the Project cameras section is used to define project cameras: to form a list of
cameras of current project, to input/edit camera parameters, to import, export, remov-
ing and renaming of cameras. The section contains a list of project cameras with
data about number of assigned images, as well as a toolbox used for camera man-
agement;

+ the Change camera for selected images section allows to assign selected camera
to selected project images, and to specify orientation of camera axes on project im-
ages;

» the image preview section is used to display highlighted image in a table. The section
includes image name, preview window of highlighted image with display of camera
axes and toolbox used to perform interior orientation and view its results in report,
as well as image size in pixels.
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Table 3. Toolbox for camera management

Buttons Function
e to input a new project camera
0 to import a camera from another project to current one
6 to import a camera from file
3 to edit parameters of a camera selected in a list
e to copy selected in a list camera with all its parameters
Lc:] to rename selected in a list camera
& to remove selected in a list camera
il to unassign a camera selected in a list from project images. After that in the Project
cameras list in the Num. of images column the “0” value is displayed
L7 to select all images, for which the selected camera was assigned

To input a new project camera perform the following actions:

1. In the Manage cameras window click the gi button. The Camera window opens.
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2.

=)

. Camera
Import Export Standard cameras
Camera: MNew camera
Camera type Fiducial marks
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Show digital camera parameters in
. [None V]
@) mm pix
ME X, mam ¥, mm
Focal
length, mm: 0.0000 1 1059990 -106.0020
Calibration date: [ | 4 Jul 2024 2 -106.0030 -106.0050
3 -106.0010 1060030
N JE3) C-C000 4 106.0040 106.0060
Prindipal point, mm:
Y 0.0000
Description:
CERIE|
Distortion
4 directions "x" v]
Paint of symmetry {zero distortion), mm:
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R, mam dR1, makm dR2, mkm dR3, makm dR4, mKm L 2
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60.0000 0.500 0.800 -0.500 0.700
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<H =B #- 10 n?
Ok ] [ Cancel

Fig. 10. Film camera parameters

Input a camera name and specify camera parameters according to its passport
(see the Section 3.3.4 and Section 3.3.3) or import camera parameters (see the

Section 3.3.5).

Click OK. A name of new camera is shown in a list of the Project cameras section,
and in active profile resources in the current project folder the Cameras folder is
created. It contains file with the camera description Camera name. x-cam.
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@ The @& button allows to edit all camera parameters, except for its name, specified in the
Camera field. To rename camera selected in a list use the @2 button.

4. [optional] Repeat steps 1-3 to define other cameras in a project if project images
are acquired using different cameras.

In order to assign camera to selected images perform the following actions:

1. In the Manage cameras window select a camera in the Project cameras list.

2. Selectimages in the Project images table.

3. Setthe Assign selected camera to selected images checkbox to assign selected
camera to images.

@ To recalculate interior orientation without assigning new camera, clear the Assign selected
camera to selected images checkbox and click the Execute button.

4. Set the Set camera rotation for selected images checkbox and select rotation
angle — 0°, 90°, 180° or 270°.

5. Click the Execute button. Selected camera will be assigned to selected project
images.

3.3.3. Digital camera parameters
Perform the following actions to input digital camera parameters:

1. Choose Orientation » Manage cameras or click the @ button of the AT additional
toolbar. The Manage cameras window opens.

2. Click the g button to specify a new project camera. The Camera window opens.

@ Use the & button to edit parameters of existing camera.
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Fig. 11. Parameters of digital camera by the example of DSS camera

In the Camera type section set the Digital option.

@ When entering characteristics of a digital camera, principal point coordinates, focal length
and point symmetry (zero distortion) are defined in mm, and pixel size and value of distortion
coefficient — in microns.

[optional] In order to change units of digital camera parameters, in the Show digital
camera parameters in section choose millimeters or pixels.
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é It is not recommended to change units of digital camera parameters repeatedly, since it

may cause insignificant loss of accuracy. Recalculation is made by using the Pixel size
parameter.

@ During save of camera parameters the data is saved in the system in millimeters regardless

of the selected units. When the window opens the default data is also displayed in milli-
meters.

5. In the Point of origin section specify pixel position, with respect to which shift of
principal point and symmetry point is specified to consider distortion from camera
passport: In image center or In lower left corner.

Scheme of coordinate system is shown to the right from the Point of origin section.

@ If the Sensor size is specified, the = button allows to recalculate a position of principal
point and point of symmetry when coordinates origin is changed.

6. Input the Pixel size value to X and Y input fields in microns.

é Regardless of the units of digital camera parameters, the Pixel size is specified in microns,
and the Sensor size — in pixels.

ﬁ The Pixel size parameter should be specified to display camera parameters in pixels.

7. [optional] In order to define the Sensor size, enter its size by X and Y in pixels.

% The &= button allows to swap sensor size values by X and Y to fix errors of data input.

% The Sensor size value could be imported from metadata or from a file with *. cal extension.
This parameter is used to control camera axes orientation during import.

8. Input the Focal length value in mm.

9. Input X,Y-coordinates of principal point with regard to image center (in mm) to the
Principal point input fields.
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Fig. 12. Dependence between image and monitor coordinate systems

Here:
 X'and Y' - axes of image coordinate system — Right;
« XP and YP — axes of Pixel/Monitor coordinate system— Left;

* Xpp and y,, — principal point coordinates, measured from upper left corner of the
image (from origin of Pixel/Monitor coordinate system);

. xipp and yipp— principal point coordinates, measured from central pixel of the image
(from the image coordinates origin).

. Image coordinates origin may differ from origin of Pixel/Monitor coordinate system. In this

case it is necessary to recalculate principal points coordinates, specified in the camera
passport, considering used coordinate system.

10. [optional] Input the Description — arbitrary text used for example, for easy identific-
ation of the camera and projects where it is used.

11. In the Distortion list select one of the following distortion types according to passport
data of survey camera distortion:

* None — no passport data;
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* Formula (Physical) — to input distortion coefficients of Brown-Conrady model;

In order to consider distortion using formula, it is necessary to input coordinates
of symmetry points, coefficients of radial and tangential distortion, and coefficients
of image deformation.

Distortion

[Formula (Physical) V]
Tearr = & — kyz1? — kpar?! — kaar® — kyar® — kgor®® — (1 4 Pyr? + Purt) - (P (r® + 20%) + 2Pomy) — bux — bay
Yeorr = Y — kiyr® — kayr® — kayr® — kygr® — ksyr'® — (14 Por® + Pur) - (P (v + 20%) + 2Pixy) — arx — agy

. o

Point of symmetry (zero distortion), mm:

®: 0.0000 ¥: 0.,0000

Radial distortion coeffidents:

ki: 0 k2 0 k3: 0O kd: 0 ks: 0 %8

Tangential distortion coefficients:

P1: 0 P2: 0 P3: 0 P4: 0

Image deformation coeffidents:

bi: 0 b2: 0

al: 0 a2 0

Fig. 13. Formula and distortion parameters

@ Only distortion coefficients b1 and b2 relatively to X-axis are used for camera self-calib-
ration.

The ZH button is used to transform distortion calculated by formula to a radial
one.

s !
. Converting formula distortion to radial distertion @

() Use current radius table
(0 lines, max radius 0.0000 mm, mean step 0.0000 mm)
@ Create new radius table

Step, mm:

Max radius, mm:

QK ] ’ Cancel

Fig. 14. Parameters of distortion transformation

* Formula (Mixed) — to input distortion coefficients of mixed model,
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In order to consider distortion using formula, it is necessary to input coordinates
of symmetry points, coefficients of radial and tangential distortion, and coefficients
of image deformation.

Distortion

|Formula (Mixed)

Teare = T — knzr® — fazr® — kyar® — P, [2..-"‘ + .'"'J — 2PaTy — i T — G2y — MT° — G4TY — GRYf° — GpToY — apTy—
i R ] 5 vl L] 3
—— O+ Ol + ST g+ GETY T Gl + orif)
c
Yoorr = 1 — K1y = kagrr? = kg™ — Py [ﬁ_e,"' i J"l] QP gy — b — baip — by — by — beiy” — bga®y — brry®
1, E - 3 o
—il g (r'; 4 CaXy + |'4_r.|" + e'-_.."“ + opry + cpy” + r'l—_l,l"J
=
rd =a’ + _|J|!
Point of symmetry (zero distortion), mm:

¥ 00,0000 Y 0,0000 To principal point

Radial distortion coefficients:

ki: 0 k2: 0 k3: 0 He

Tangential distortion coefficents:

P1: 0 P2: 0

Image deformation coefficients:

al: 0 a2 0 ak 0 as a ai: 0 at: 0 a7: 0
b1: 0 b2: 0 b3: 0 b4 0 b3 |0 be: 0 b7: 0
cl: 0 c2: 0 c3: 0 o4 a 3 |0 e 0 [ HI]

Fig. 15. Formula and distortion parameters

Radial — to input table values of radial distortion by radius-vector distance;

» 4 directions + —to input table values of distortion by directions of image coordin-
ate axes;

+ 4 directions “X” — to input table values of distortion by diagonal directions;

» 8 directions —to input table values of distortion by directions of image coordinate
axes and by diagonals.

During input of distortion data the point of symmetry coordinates are specified —
zero distortion (in mm) and table values of distortion (in microns) or distortion
coefficients (formulas). To use principal point coordinates as point of symmetry
coordinates click the To principal point button.
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Distortion

4 directions "x" -

Point of symmetry (zero distortion), mm:

¥: 0.0000 ¥: 0.0000
R, nana dR1, mim dR2, mkm dR3, mkm dR4, mkm t <
10.0000 -0.600 0.200 -0.200 -0100 ><
200000 -0.600 0.500 -0.600 0.100 . .
30.0000 -0.400 0.300 -0.700 0.300
40.0000 -0.100 0300 -0.400
50.0000 -0100 0.100 -0100 0,600
50.0000 0.500 0.800 -0.500 0.700
70.0000 0.300 0.800 0.200 0.400
80.0000 0.500 0.100 0.200 0.500
90.0000 0.100 0.300 0.700 0.500
100.0000 0.400 -0.500 0.200 0.300

=8 WE - W w*

Fig. 16. A table of distortion values by diagonal directions

The figure above shows a table of distortion values by diagonal directions. Directions
orientation is shown on a scheme right of the table. Each row of the table allows to
input the following values: distance from point of symmetry (radius) in the first
column, and distortion values in the columns corresponding to the numbers of dir-
ections.

The following buttons are used to add, delete lines and edit values in the table:

» =f — allows to add a new line (Ctrl+Ins);

» ®H — allows to delete selected line (Ctrl+Del);

« #- —allows to revert a distortion sign;

» ¥ — allows to multiply distortion values by 1 000, to convert them into microns;

» w* — allows to divide distortion values by 1 000, to convert them into microns.

Positive values of distortion coefficients mean “shift” of image awayfrom the center, and
negative — fowards the center.

12. Click OK to complete input of camera parameters.
3.3.4. Parameters of film camera
To input parameters of film camera perform the following actions:

1. Choose Orientation » Manage cameras or click the button on the AT toolbar. The
Manage cameras window opens.
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2. Click the g button to specify a new project camera. The Camera window opens.

@ Use the @ button to edit parameters of existing camera.

( . Camera

Import  Export  Standard cameras

Camera: Mew camera
Camera type Fiducial marks

(7) Digital @ Film [Fiducial coordinates

Fiducial marks
Show digital camera parameters in

. [None V]
@) mm pix
M2 X, mam ¥, M
Focal
length, mm: 0.0000 1 105.9990 -106.0020
Calibration date: [T | 4 Jul 2024 2 -106.0030 -106.0050
3 -106.0010 106.0030
o (K 00000 4 106.0040 106.0060
Principal paint, mm:
¥: 0.0000
Description:
=H =@
Distortion
4 directions "x" -
Point of symmetry (zero distortion), mm:
X 0.0000 Y: 0.0000
R, rana dR1, mkm dR2, mkm dR3, MK dR4, mKm 2
10.0000 -0.600 0.200 -0.200 -0.100
20.0000 -0.600 0.500 -0.600 0.100 3
30.0000 -0.400 0.300 -0.700 0.300
40.0000 -0.100 0300 -0.400
50,0000 -0.100 0100 -0.100 0,600
60.0000 0.500 0.800 -0.500 0,700
70.0000 0.300 0.800 0.200 0.400
80.0000 0.800 0100 0.200 0.500
80.0000 0100 0.300 0.700 0.500
100.0000 0.400 -0.500 0.200 0.300
= WE ®- n*
(o]4 ] [ Cancel

Fig. 17. Parameters of film camera

3. Inthe Camera type section set the Film option.

4. Specify a camera name in the Camera input field.
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10.

1.

Input focal length (in mm) in the Focal length input field.
[optional] Set the Calibration date checkbox and select calibration date.
Input principal point coordinates (in mm) in the Principal point fields.

[optional] Input the Description — arbitrary text used for example, for easy identific-
ation of the camera and projects where it is used.

In the Fiducial marks list choose one of the following data types according to the
camera calibration data (if any):

* Principal point only — principal point coordinates Xo and Yo (in mm). If calibration
data is unavailable and there are no fiducial marks, interior orientation is performed
only using principal point coordinates;

» Fiducial marks — this option is used if there are no reference values of distances
between fiducial marks and fiducial coordinates values, but there is a possibility
to calculate principal point coordinates in a crossover point of lines connecting
fiducials;

+ Calibrated distances — allows to set reference values of distances between fi-
ducial marks (in mm) by XY axes: Lx and Ly;

» Fiducial coordinates — allows to set coordinates of fiducial marks XY, if they
are available in the camera passport (see also Section 3.5.2).

[optional] In the Fiducial marks template list select appropriate camera-template,
which type of fiducial marks corresponds to current camera. Selected type of fiducial
marks contains all necessary information about fiducials: their numbering, template
and search area. Using camera-template allows to perform automatic interior ori-
entation.

ﬁ A list of camera-templates is available only if in the Fiducial marks list the Calibrated
distances or Fiducial coordinates option is selected.

In the Distortion list select one of the following distortion types according to passport
data of survey camera distortion:

* None — no passport data;

* Formula (physical) — to input distortion coefficients of Brown-Conrady model;

In order to consider distortion using formula, it is necessary to input coordinates
of symmetry points, coefficients of radial and tangential distortion, and coefficients
of image deformation.
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Distortion

[Formula {Physical) v]

Tegrr = T — krzr? — kpzr? — kyzr® — kyor® — kgzr'® = (1 4 Pyr? + Port) - (P (r? + 22%) + 2Psay) — bz — boy

Yomr = ¥ — k1yr® — kayr® — kayr® — kygr® — kpyr'® — (1 + Pr? + Por?) - (B2 (72 + 20°) + 2Piay) — v — any
=t gy

Point of symmetry (zero distortion), mm:

X: 0.0000 ¥: 0.0000

Radial distortion coeffidents:

ki: 0 k2: 0 k3: 0 k4 0 k5: 0 | | %5E

Tangential distortion coefficents:

FL: 0O PZ: 0 P3: 0 P4 0

Image deformation coefficents:

bi: 0 b2 |0

al: 0 aZ: 0

Fig. 18. Formula and distortion parameters

é’ Only distortion coefficients b1 and b2 relatively to X-axis are used for camera self-calib-
ration.

The %B button is used to transform distortion calculated by formula to a radial
one.

ra '
. Converting formula distortion to radial distortion @

() Use current radius table
(0 lines, max radius 0.0000 mm, mean step 0.0000 mm)
@ Create new radius table

Step, mm:

Max radius, mm:

QK ] ’ Cancel

Fig. 19. Parameters of distortion transformation

* Formula (Mixed) — to input distortion coefficients of mixed model,

In order to consider distortion using formula, it is necessary to input coordinates
of symmetry points, coefficients of radial and tangential distortion, and coefficients
of image deformation.
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Distortion

|Formula (Mixed)
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P

Py [ﬁ_e,"' i J"l] QP gy — b — baip — by — by — beiy” — bga®y — brry®

i E : - P
== (r'; 4+ CoXy + |'4_r.|" + e'-_.."“ + f-l.l'd_||l + |"i.."_|,l‘I + r'l—_l,l"J
C

Point of symmetry (zero distortion), mm:
¥ 00,0000 Y 0,0000
Radial distortion coefficients:

ki: 0 k2: 0 k3:

Tangential distortion coefficients:
Pi:z |0 P2: 0

Image deformation coefficients:

al: 0 a2 0 a3
b1 0 b2: 0 b3:

cl: 0 c2: 0 (5=

To principal point

+

a4 a a5: 0 ag: 0 arf: 0
b4: 0 bs: 0 b&: 0 b7: 0
(e a c3: (0 ch: 0 c7: 0

Fig. 20. Formula and distortion parameters

Radial — to input table values of radial distortion by radius-vector distance;

» 4 directions + —to input table values of distortion by directions of image coordin-

ate axes;

» 4 directions “X” — to input table values of distortion by diagonal directions;

» 8 directions —to input table values of distortion by directions of image coordinate

axes and by diagonals.

During input of distortion data the point of symmetry coordinates are specified —
zero distortion (in mm) and table values of distortion (in microns) or distortion
coefficients (formulas). To use principal point coordinates as point of symmetry
coordinates click the To principal point button.
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Distortion

4 directions "x" -

Point of symmetry (zero distortion), mm:

¥: 0.0000 ¥: 0.0000
R, nana dR1, mim dR2, mkm dR3, mkm dR4, mkm t <
10.0000 -0.600 0.200 -0.200 -0100 ><
200000 -0.600 0.500 -0.600 0.100 . .
30.0000 -0.400 0.300 -0.700 0.300
40.0000 -0.100 0300 -0.400
50.0000 -0100 0.100 -0100 0,600
50.0000 0.500 0.800 -0.500 0.700
70.0000 0.300 0.800 0.200 0.400
80.0000 0.500 0.100 0.200 0.500
90.0000 0.100 0.300 0.700 0.500
100.0000 0.400 -0.500 0.200 0.300

=8 WE - W w*

Fig. 21. A table of distortion values by diagonal directions

The figure above shows a table of distortion values by diagonal directions. Directions
orientation is shown on a scheme right of the table. Each row of the table allows to
input the following values: distance from point of symmetry (radius) in the first
column, and distortion values in the columns corresponding to the numbers of dir-
ections.

The following buttons are used to add, delete lines and edit values in the table:

» =f — allows to add a new line (Ctrl+Ins);

» ®H — allows to delete selected line (Ctrl+Del);

« #- —allows to revert a distortion sign;

» ¥ — allows to multiply distortion values by 1 000, to convert them into microns;

» w* — allows to divide distortion values by 1 000, to convert them into microns.

Positive values of distortion coefficients mean “shift” of image away from the center, and
negative — fowards the center.

12. Click OK to complete input of camera parameters.
3.3.5. Import and export of camera parameters

The Camera window provides opportunities of import and export of camera parameters,
as well as possibility to use features of standard cameras.

% The Camera window opens using the g5 and g buttons in the Manage cameras window.
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To import of camera parameters perform one of the following actions in the Camera
window:

» choose Import » From file to import camera parameters from file, located in folder
of Windows file system. The Load camera window opens. Select file with camera
parameters and click OK. Camera’s parameters will be loaded to appropriate fields
of the Camera window. The available camera parameters file formats:

o *,x-cam — file with the camera description, used by PHOTOMOD system;
o *,txt — file with the camera description, used by 3DM CalibCam;

o *,txt — file with the camera description, used by Australis;

o *,txt — file with the camera description, used by Australis v7;

o *, cal — file with the camera description, used by CalCam;

o *.ini — file with the camera description, used by PhotoModeler,

o *,cam — file with the camera description, used by Pix4D,;

o *,txt — file with the camera description, used by SimActive;

o *, cal — file with the camera description, used by TerraPhoto;

o *,txt — file with the camera description, used by USGS.

* choose Import » From resource to import camera parameters from *.x-canm file,
located in folder of active profile resources.

The Open window opens, that displays a tree of active profile resources. In the folder
of active profile resources select file with camera parameters *.x-cam and click OK.
All parameters of camera from selected file will be loaded to appropriate fields of the
Camera window;

@ By default the Cameras folder is used to store *.x-cam files with camera parameters in the
profile resources of each project.

» choose Import > Import from CAL-file (EnsoMOSAIC) to import digital camera
parameters from the *.cal file of theEnsoMOSAIC system.

To import of camera parameters from another project to a current one perform the fol-
lowing actions:

1. In the Manage cameras window click the g button. The Open window opens.
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r.D‘pen &Jw
BEEX t+nk 0E®

» France_Group EJ o Name Size Time Path
* fromintergeo ‘backup 26.08.2016 12:... backup

> (GaoFen-3
> GeoEye Zeiss LMK15.x-cam 347 KB 03.07.2024 12:32... Zeiss LMK15.x-c...

» geoeye 1 koHeeep
» Geobye_Group
> GeoMosaic
¢ GeoMosaic_autoradiometry
¢ (GeoMosaic_Sample_Roman
¢ GeoMosArtifacts
> IKONOS
» IKONOS Peland monoblock konua
> InfoMap_Group
InvalidLAS
> Kanepus-B_Group
» KazEOSat Aaporeogesva FIXED
» LAS China
> Lite
> Master-class_Portugal_Pachworks
> MegaTiff_Rome
> Moscwo_kanopusB_NCOMZ
4 New_Zealand_Group
4 New_Zealand
backup
Cache
4 (Cameras
backup

m

1

Filter
Resource name Cameras hd
Open Cancel

| fTechsupport/Mew_Zealand_Group/New_Zealand/Cameras | 2 resources [ 3.47 KB (selected: 0 resources / 0 B)

Fig. 22. Camera selection in resources of another project
2. Select the camera file *.x-cam in the Cameras folder of another project in active
profile resources.
3. Click Open. As a result, the camera name appears in the camera list.

To export of camera parameters to *.x-cam file the Export » To file or Export » To re-
source in the Camera window are used.

For automatic input of standard cameras data to input fields of the Camera window the
Standard cameras menu is intended. The menu is used, if the camera parameters are
fully or partly coincide with parameters of standard camera, that allows to significantly
reduce time of manual input of new camera parameters.

Camera description in the *. x- cam file includes the following main lines, which correspond
to parameters shown in the Camera window:

* Name — camera name;

* calibration date — calibration date;
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* description — camera description;
» focus — focal length;

* principal point — principal point coordinates.

i h'
. [Techsupport/Mew_Zealand_Group/New_Zealand/Cameras/Zeiss LMK15.x-cam @
I3 %
k:?xml version="1.0" encoding="utf-3"7> &

<IDOCTYPE phini SYSTEM "phini4. dtd "=
<phini=<!-—-8.0,4578 x64 —>
<g n="name" v="Zeiss LMK 15.x-cam™/=
<5 n="calibration_date™ v=""=
<% n="description”=
iz
<d n="focus" v="1,522129999999999%e+02"/ >
<x n="principal_point™><d n="x" v="0.0000000000000000e +007 = <d n="y" v="-1,4100000000000000e-02" = < fx =
<x n="int_or"»
«g n="type" v="Digital"/>
<y n="pixel_size"><d n="x" v="1.0000000000000000e-03"><d n="y" v="1.0000000000000000e-03"/>< fx>
<y n="sensor_dims"><i n="x"v="0"><i n="y"v="0"z <=
<5 n="digital_camera_arigin” v="Center"/=
<fxz
<x n="distortion™=
<g n="type" v="Directed 4"/ >
<5 n="direction” v="CamToMm">
<3 n="symmetry_point™=<d n="x"v="0,0000000000000000e+00">=d n="y" v="0.0000000000000000e +00"/= < x>
<x n="table_x"=
LHE
=d n="r" v="1.0000000000000000e+01%/>
xn="dr'=
=g v="-5,9999999999993995e-04" =
<d v="-2,000000000000000 1e-04"=
=d v="-2,000000000000000 1e-04"=
<d v="-1,0000000000000000e-04"/=
<fuz
<fux
LW
<d n="r" v="2.0000000000000000e+01"/>
“xn="dr=
«<d v="5,99999959999999952-04" =
=g v="-5,000000000000000 1e-047/= L

m

3554 0: 0

Fig. 23. Camera parameters in the file of *.x-cam format
3.4. Interior orientation for digital camera images

Interior orientation of image acquired by digital camera is to determine the principal
point position relative to the center of the lower left pixel of the image.

To perform interior orientation of images acquired by digital camera perform the following
actions:

1. Input correctly all parameters from digital camera passport to appropriate input
fields of the Cameras window (see the Section 3.3.3).

43



PHOTOMOD 8.1 Aerial triangulation (Windows x64)

@ It is necessary to pay attention to parameters units, and to define point of origin, which will
be used to specify coordinates of principal point and symmetry point (zero distortion point):
relative to the lower left pixel or the center of the image.

2. Assign the camera to project images and setup camera axes direction for selected
images in the Camera management window (see the Section 3.3).

3. Choose Orientation » Interior orientation » Calculate interior orientation or click
the & button of the AT additional toolbar to recalculate interior orientation.

4. Choose Orientation > Interior orientation > Report on interior orientation or click
the [f& button of the AT additional toolbar to control results and fix errors of interior
orientation.

@ Another pressing the [ button (nyHkTa meHio Orientation > Interior orientation » Report
on interior orientation) directly opens the Report. Reload the project to change again
the parameters the interior orientation report is generated according to.

@ The interfaces of the window used to set parameters to generate the interior orientation
report, as well as the window containing the Report, itself, are similar to the tools used
for creating and viewing interior orientation report for a project containing analog imagery

(see Section 3.5.6).

In most cases, source images acquired by digital camera, might contain metadata,
written in EXIF format. If images containing metadata are available in a project, it is
possible to import from the metadata to the project parameters of interior orientation
(precise) and exterior orientation (approximate, i.e. calculated by on-board devices). In
this case, the process of interior orientation actually comes down to importing the ne-
cessary data.

3.4.1. Interior orientation report
Report on interior orientation for digital camera contains information whether the interior

orientation is done. It also includes camera parameters and principal point coordinates,
calculated relative to the center of the lower left pixel.

44



PHOTOMOD 8.1 Aerial triangulation (Windows x64)

149 s B8 &k

Interior Orientation Report

Biack] [Refresh] [Repart parameters

Block Statistics

Project: Waldkirch_docs
Number of strips: 2, selected for the report 2
Murnber of images: 6, selected for the report 6

Report date: 17 wapra 2014 r, 12:20:61

Interiar arigntation
Strips Images Number of gelected images
Complete | Erors | Mot complete
1 2 0714—2 0710 3 3 1} 1}
2 3.0720—3 0724 3 3 [t} 0
[Ton]
Strip: 1
Axes Mumber of fiducials Transform Residuals, RMS,
Image Camera Camera type
orientation measured type i
. 5 o714 RC_waldkirh.x- F\dl{mal 00 m Affine a7
cam coordinates
. 30712 RC_waldkirh. x- Fiducial 0° 44 Affine 0.072
cam coordinates
+ | zorio RC_waldkirh. - Fiducial o 444 Aine 0148
_ cam caordinates hd

Close:

Fig. 24. Report on interior orientation of digital camera images block

{2 d BB &

Interior Orientation Report for the Image 2_0714 i

Back| [Refresh] [Report pararneters

Camera: RC_waldkirh.x-cam.

Axes orientation: 0%

Interior orientation complete.

Irmage size: (9556.000, 9244.000) pix., (241.4518, 231.1504) mm
Pixel size: (0.0250, 0.0250) mm.

Carmera type: Fiducial coordinates.

Focal length: 153.5030 mm

Principal point position: (4811.008, 4623 .388) pix

Transform type: Affine

Murnber of fiducials measured: 4 of 4

o Coordinates from the camera calibration Image measurements, Residuals nix Residuals. mm
Fiducial repart, mm pis. o '
mark
X ¥ X ¥ Ew E, Ey E. Ey Ey
Limit {max) 0.707 0.707 0707 — — —
1 106.0010 -105.2970 9053.074 386.868 -0.092 -0.072 0.117 -0.0023 -0.0015 0.0029
2 -106.0010 -106.0000 575.000 361.000 0.092 0.07z2 0117 0.0023 0.0018 0.0029 _
3 -106.0020 105.9930 568.557 8355 924 -0.092 -0.072 0.117 -0.0023 -0.0015 0.0029
4 106.0000 105.99%0 9047.000 8565000 0.0%2 0.072 0117 0.0023 0.0018 0.0029
Limit far
AMS 0.500 0.500 0.500 — — —

Close |

Fig. 25. Report on interior orientation of digital camera image
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3.5. Interior orientation of film camera images

3.5.1. Interior orientation modes

In order to perform interior orientation of images acquired by film camera the system

provides the following modes:

* interior orientation in manual mode using measurement of coordinates of fiducial
marks on all project images (see the Section 3.5.2);

* interior orientation in semi-automatic mode using image template, with already
measured coordinates of fiducial marks and available interior orientation (see the
Section 3.5.4);

interior orientation in automatic mode using camera template with defined type of fi-
ducial marks (see the Section 3.5.5).

3.5.2. Manual measurement of fiducial marks coordinates

To perform Interior orientation of image the Interior orientation window is used.

. 680 - New_Zealand_Dima - Interior orientation @
cefir> @b B

QaQae

Camera information

aaqe

Measurements

Marker coordinates

Name Zeiss LMK15[poly] [selfcal]. x-cam # X, mm Y, mm Xp, pix. Yp, pix. Ex, mm Ey, mm Xi 14074.000 .
Camera type Fidudal coordinates i i 14083.000
coen - _
length, mm 1527174000 2 11000456 -110.0046 14102.000  329.000 00084 00053 X: 110.010 =
mm
Distortion  Formuia 3 109983 -1098834 352000 302000  -0.0084  -0.0053 relinons =
—
LiacSuiunaioy 4 -1100187 1100187 323000 14056000 00083 00053
Width, pix. 14338 Transform type:
Heigh, px.t 15360
[1:56] / [1:1] Marker: (14074.000, 14083.000) pix, (110.0104, 110.0134) mm (camers) / (109.9343, 110.0461) mm | Pixel size: (0.0160, 0.0160) mm
Ok J I Cancel I { Apply J

Fig. 26. Manual measuring of fiducial marks
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The window includes the following parts and contains the following interface elements:
+ toolbar with buttons used to perform the following operations:

o &= 4, &, == — to pass to adjacent image of a block located left, top, bottom or
right side, respectively;

o #=, =+ — to pass to previous or to next unprocessed image (with unmeasured fidu-
cials);

o i3 — to open the Manage cameras window;

o [ — to open the Semi-automatic interior orientation window;

o [# — to open the Automatic interior orientation window;

o [ — to open the Report on interior orientation window;

o @ — to remove all fiducial marks measurements on a current image;

o T — to open the Marker settings window used to setup marker shape, size and
color.

» the Image information and Camera information sections are used to display gen-
eral information about selected image and about camera parameters;

» the main window of image view is used to fiducial marks search and the additional
lens-window is used for precision marker position in fiducial center. Image manage-
ment in windows is performed using the standard buttons;

§ The Ctrl+F8 shortcut allow to show/hide scroll bars in the main window and in the lens-window.

+ the table of fiducial marks in the Measurements section is used to display fiducials
coordinates from camera passport, in mm, (see Section 3.3.4), measured coordinates
acquired after measuring of fiducial coordinates, and values of their discrepancies
after interior orientation operation;

» marker coordinates (in pixels and mm), buttons used to measure and delete fiducial
coordinates, a list used to choose a transform type;

 the status bar used to display image zoom ratio in the main window and the lens-
window, and marker coordinates (in pixels). After measuring of two fiducial marks,
the status bar shows also marker coordinates on image (in mm)/marker coordinates
on image considering distortion (in mm) and pixel size (in mm);
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» the Apply button allows to perform image interior orientation after measuring of its
fiducial marks.

In order to perform manual measurement of fiducial marks coordinates on project images
perform the following actions:

1. Highlight a block in 2D-window anB choose Orientation > Interior orientation »

Manual interior orientation or click the [} button of the AT additional toolbar. The
Interior orientation window opens.

. 680 - New_Zealand_Dima - Interior orientation @
cefli+=>abd B r &
Qaqe Qaae ®

Camera information Measurements

Marker coordinates

Name Zeiss LMK15[poly] [selfcal].x-cam #  X.mm ¥, mm Xp, pix. ¥p, pix. Ex, mm Ey, mm Xi 14074.000 -
Camera type Fiducial coordinates ¥: 14083.000
Focal
length, mm 1527174000 2 1100046 1100046 14102000  329.000 0.0084 0.0053 X: 110.010
mm
Dstorton [Formi 3 1098830 -109983 352000 302000 00081 -0.0053 Yol
i Delete measurement
TR 4 1100187 1100187 323000  140%.000 00083 00053
Width, pix. 14336 Transform type:
Height, ix.: 15350

[1:56] / [1:1] Marker: (14074.000, 14083.000) pix., (110.0104, 110.0134) mm (camera) / (109.9343, 110.0461) mm | Pixel size: (0.0160, 0.0160) mm

I OK H Cancel H Apply I

Fig. 27. Manual measuring of fiducial marks

2. Choose a fiducial mark which coordinates to be measured in the Measurements
table of fiducial marks coordinates, which displays XY-coordinats of the mark (in
mm) from camera passport. Find on image and show by marker the mark in the
view window. In the right lens-window selected fiducial mark is displayed.

3. Perform precision positioning of marker on chosen fiducial mark in the lens-window
using mouse cursor and arrow keys. Marker position coordinates (in pixels and

mm) are displayed in the Marker coordinates (pix) and Marker coordinates (mm)
input fields.
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Click the Measure mark button to fix measured fiducial coordinates. After fiducial
coordinates measurement the fiducial table shows the measurement result — co-
ordinates of measured fiducial Xp and Yp (in pixels).

Repeat pp. 2-4 to measure coordinates of the second mark. After measurement of
two fiducial marks a status bar will display information about pixel size, marker co-
ordinates on image (in pixels and mm), and marker coordinates, calculated consid-
ering distortion (in mm).

Repeat pp. 3-4 for the rest of fiducials. After measurement of first two fiducial marks
a marker will be automatically positioned to vicinity of the next fiducial mark on image
in image view window and in the lens-window.

After measurement of all fiducials coordinates choose one of the following trans-
formation type: Rotation, Scale, Shift; Affine; Projective in the Transform type
list.

Click the Apply button to perform interior orientation. After that the fiducials table
will display the Ex and Ey values of discrepancies (in mm) between fiducial marks
specified in camera passport and measured on image.

@ Maximal error should not exceed the size of the pixel. To perform accuracy control of interior
orientation results using report click the ff& button.

[optional] After measuring fiducial marks coordinates at least on one block image
click the & button to try to perform interior orientation of the rest block images in
semi-automatic mode.

10. Choose Orientation > Interior orientation » Report on interior orientation or click

the [f& button of the AT additional toolbar to control results and fix errors of interior
orientation (see the Section 3.5.6).

3.5.3. Image management

This chapter contains a description of standard image managing options in image view
window. A toolbox of image view window contains the following buttons used to manage
an image:

&, — to zoom in an image by one step (*);
4, — to zoom out an image by one step (/);
& - to fit to page data of opened layers (AIt+Enter);

@, — to display data in 1:1 scale, when one pixel of the image corresponds to one

pixel on the screen,;
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« [# - to center image by marker in working area of 2D-window.

To turn on panning mode that allows to move an image using mouse in a view window —
press and hold the Alt key while moving mouse.

Qaae s

Fig. 28. Standard toolbar of the Interior orientation window
3.5.4. Semi-automatic interior orientation

Principle of operation of semi-automatic mode is the automatic search and measurement
of fiducial marks coordinates on all project images in accordance with selected template-
image and further interior orientation for all block images. As a template-image one of
project images is used. For this image fiducial mark template is defined and interior
orientation is performed. Thus, semi-automatic interior orientation of the entire images
block requires interior orientation results of at least one image of a project, obtained
after manual measurement of fiducial marks coordinates.

To execute semi-automatic interior orientation perform the following actions:

1. Choose Orientation > Interior orientation > Semi-automatic interior orientation
or click the [ button of the AT additional toolbar. The Semi-automatic interior
orientation window opens.
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Fig. 29. Defining of fiducials search area and reference mark

2. Inthe Project images table select a template-image, which will be used for search
and measurement of fiducial marks coordinates on other projectimages. To choose
a template-image select the image in the table and click the ¥ button. Left of the
image name the Template label is displayed.

% Any image of the project with performed interior orientation could be used as template-image.

3. Usesliders in the Marks search parameters section to define the following search
parameters:

* Mark area size is used to define fiducial template. Setup the fiducial area size
in such way that fiducial image is fully located in search area;

+ Search area size is used to define fiducial location. If images are sliced unevenly
and fiducial marks are located at different distances from image edge on different
images, it is recommended to set sufficiently large search area (outer rectangle,
which circumscribe a fiducial mark).
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@ In order to specify search areas use the image view window and the lens-window, along
with buttons of toolbar. The Ctrl+F8 shortcut allows to show/hide scroll bars in view windows.

4. For automatic search of fiducial marks using correlator that compares fiducial mark
image with its template, define threshold value in the Correlation threshold input
field (0.9 by default).

5. Choose images in the Project images table to perform interior orientation in semi-
automatic mode.

6. [optional] In the Search for marks section set the Search images with int. or.
already performed checkbox to include to calculation the images (from selected
ones), which have interior orientation results available, i. e. to recalculate interior
orientation for them in accordance with the selected template.

7. Choose one of the following transformation type: Rotation, Scale, Shift; Affine;
Projective in the Transform type list.

8. Click the Start button to perform semi-automatic interior orientation.

9. Choose Orientation » Interior orientation » Report on interior orientation or click
the [f& button of the AT additional toolbar to control results and fix errors of interior
orientation (see the Section 3.5.6).

Below the table of images there are the buttons that allow to open the following windows:
* {#@ — Project cameras management ;

« [ - Interior orientation (manual);

. Efv — Automatic interior orientation ;

« - Report on interior orientation .

@ The Orientation > Interior orientation » Delete interior orientation data menu item is used
to remove interior orientation data in case of unsatisfactory results.

3.5.5. Automatic interior orientation

The system provides possibility to perform interior orientation in automatic mode, if
template-camera is specified in properties of film camera in the Fiducial marks section
(see the Section 3.3.4).

Interior orientation in automatic mode consists in automatic search and measurement
of fiducial marks on project images according to specified type of fiducial marks, and
further interior orientation. Specified Fiducial marks parameter already contains inform-
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ation about fiducials typical for the selected camera: their numbering, template and
search area.

7

Current version of the system supports types of fiducial marks for RC 20, RC 30 and LMK
cameras.

To correctly perform automatic interior orientation, orientation of the camera image axes should
be set correctly (see the Section 3.3).

To execute automatic interior orientation perform the following actions:

1.

Choose Orientation > Interior orientation » Automatic interior orientation or
click the B button of the AT additional toolbar. The Automatic interior orientation
window opens.

To perform interior orientation in automatic mode select images in the Project im-
ages table.

. Automatic interior orientation &]
Project images s
m 88 B
3 : 43k =@ O
. E EE | OE Marks search parameters:
Name Int.or. Camera Rotation Correlation threshold
4 01 0.80 [
664 - Zeiss... 0°
665 - Zeiss... 0° Search for marks
666 - Zeiss .. 0° Search images with int.or. already performed
667 - Zeiss... 0°
668 B Teics ... 0O Transform type
665 - Zeiss... 0° Affine -
670 - Zeiss... 0° Rotation, scale, shift
671 - Zeiss ... 0° L=
e Projective
| 68O - Zeiss .. 0°
V| 679 - Zeiss .. 0°
V| 678 - Zeiss .. 0°
V| 677 - Zeiss .. 0°
V| 676 - Zeiss .. 0°
V| 675 - Zeiss .. 0°
V| 674 - Zeiss .. 07
VI 673 - Zeiss .. 07
Execute ” Cancel

Fig. 30. The Automatic interior orientation window

For automatic search of fiducial marks using correlator that compares fiducial mark
image with its template, define threshold value in the Correlation threshold input
field (0.8 by default).

[optional] In the Search for marks section set the Search images with int. or.
already performed checkbox to include to calculation the images (from selected
ones), which have interior orientation results available, i. e. to recalculate interior
orientation for them in accordance with the selected template.
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5. Choose one of the following transformation type: Rotation, Scale, Shift; Affine;
Projective in the Transform type list.

6. Click the Start button to perform automatic interior orientation.

7. Choose Orientation > Interior orientation » Report on interior orientation or click
the [f& button of the AT additional toolbar to control results and fix errors of interior
orientation (see the Section 3.5.6).

Right from the Project images section there are the buttons that allows to open the
following windows:

* #@ — Project cameras management ;
« I - Interior orientation ;
« [ —Semi-automatic interior orientation;

« - Report on interior orientation .

@ The Orientation > Interior orientation » Delete interior orientation data menu item is used
to remove interior orientation data in case of unsatisfactory results.

c Itis strongly recommended to synchronize the data in the project to remove redundant orient-

ation results when deleting images from a project. To do this choose Project > Synchronize.

3.5.6. Interior orientation report

Report about interior orientation allows to estimate a quality of interior orientation of
film camera images.

To view the report on interior orientation perform the following actions:

1. Choose Orientation > Interior orientation » Report on interior orientation or click
the {f& button of the AT additional toolbar. The Report on interior orientation
window opens.
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Fig. 31. Main parameters of interior orientation report

2. On the Main parameters tab specify the following report parameters:
+ in the Show report section choose the All images or Selected images option;

» choose a type of residual: RMS (root mean square), Mean abs. value (mean)
or Max (maximal) and specify the Threshold for interior orientation residuals
value in the appropriate field in pix or mm.

v‘i If project images were scanned by photogrammetric scanner, mean absolute value E,
should not exceed a half pixel size. The approximate ratio of the mean, maximum and
mean square error is calculated as follows:

Epar® 2 Epean and RMS= V2 Epeqy

where: E,.., — mean residual, E,,.,,= V2 0.5pix — max residual, RMS — quadratic
mean RMS.

3. On the Additional tab specify the following additional parameters:
» choose format of residuals: Fixed point or Exponential;

+ define accuracy of residual values output: Normal, Higher or Maximum.
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Fig. 32. Additional parameters of interior orientation report

4. Click OK. After that a report opens, which contains general information on the im-
plementation of interior orientation and consists of the following sections:

» Links used to return to previous view place or to the beginning of the report, to
refresh report data after calculating of interior orientation, and to change a report
parameters.

 Block statistics — project name, data on number of all/selected strips/images in
a block, time and date of the report creation, strips table with the following general
information: on which strips/images and to what extent the interior orientation is
performed, and whether the residuals values satisfy a given residuals tolerance
for measurement of fiducial marks on images. The Strips column contains links —
strips names, that allow to pass to tables of images in each strip.

» Tables of images in each strip show general information about images — camera
data, axes orientation, number of fiducial marks measured on the image, type of
image transformation and interior orientation residual of selected type (RMS,
mean module or maximal) in selected units (pix or mm) on the Main parameters
tab of the Report on interior orientation window. The first column contains links
that allow to open selected image in the Interior orientation window to edit fiducial
marks measurements. The Images column contains links — names of images
that allow to pass to detailed report about interior orientation of selected image.

§ Red color is used to mark images/strips, for which interior orientation is not performed,
yellow color is used for images/strips for which interior orientation is performed incorrectly
or incompletely, i.e. with residuals exceeding a threshold value, and also when not all fiducial

marks are measured. Residuals themselves also appear in red.
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7

Another pressing the [ button (nyHkTa meHio Orientation > Interior orientation » Report
on interior orientation) directly opens the Report. Reload the project to change again
the parameters the interior orientation report is generated according to.

The figure below displays an example of interior orientation which is not satisfactory
under the following conditions and with the following data: threshold value for mean
module — 0.2 pix, coordinates of one of the marks on image of the 9-th strip are not
measured, and coordinates of all marks of one of images of the 10-th strip are not
measured.

- (=08

dk|a BB al

M= B3

Interior Orientation Report

Back] [Refresh] [Report parameters

Project: Infahdap_copy

Block Statistics

Report date: 17 mapta 2014 r., 12:03:58

Murber of strips: 2, selected far the repaort 2

Murmber of images: B, selected for the report B

Interior arientation
Strips Images Mumber of selected images
Complete Etrors | Mot complete
2 R10_S05—R10_S07 3 1 1 _
1 RO9_S87—R09_585 3 3 0 0
[Top]
Strip: 2
Image Camera Camera type .AXES. ialares of el e Regiduals, RMS, pix.
arientation measured type
= | pipas | REEx Fiducial a1 Afine 0096
cam coordinates
- - e FIdL.ICIal o Ane _
cam coordinates
- RIS M FIdL.ICIal 4'“1 Afine _
- cam coordinates -

Fig. 33. Report on interior orientation of film camera images block

Toolbar in upper part of interior orientation report contains the following buttons:

« 4] (Backspace) — allows to go back to previous view;

. (F5) — allows to refresh a report after change of the report parameters;

« @& (Ctrl+F) — allows to perform data search in a report (by keyword or its part);

+ [ - allows to save a report to HTML-file in any folder out of active profile re-
sources;
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. — allows to save a report to HTML-file in active profile resources;
« & — allows to print a report;
« [} (CtrI+P) — allows to open print preview window.

5. In the table of images click the link of selected image in the Image column. After
that a detailed report on interior orientation of selected image is opened. The report
contains the following data:

* links to pass to the following places:

o [Edit] — allows to open the Manual interior orientation window where it is
possible to “re-measure” fiducials coordinates and recalculate interior orienta-
tion;

o [Back] — allows to return to previous window of the report;
o [Refresh] — allows to o6HOBUTL OTYET Npu change a report parameters;

o [Report parameters]— allows to open window used to change a report paramet-
ers.

* image statistics — camera parameters, image size, pixel size, interior orientation
data;

* table of fiducial marks on image contains the following data:

o maximal residual threshold Ex, Ey, Exy specified on the Main parameters tab
of the Report on interior orientation window;

§ If threshold value on RMS or mean residual is specified, threshold on maximal residual
is automatically calculated in selected units (pix or mm).

o marks coordinates taken form camera passport (in mm) — X,Y;
o marks coordinates on image (in pix) — X,Y;

o values of discrepancies between passport data and measured data (in pix and
mm) — Ex, Ey, Exy;

o specified threshold value on selected residual in selected units on the Main
parameters tab of the Report on interior orientation window;

o calculated on all marks residual values by RMS, mean abs. and max Ex, Ey,
Exy (pix or mm).
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Residuals that are out of thresholds are highlighted by red color. Thus, the report
displays by red color the following residuals:

o residuals on all marks, that exceed defined threshold on selected residual

(RMS, mean abs. or max);

o residuals on each mark, that exceed defined threshold on maximal residual.

* Report

M= B3

Carmera: RC 20.x-cam
Axes orientation: 180°

Interior arientation complets.

Pixel gize: {0.0210, 0.0210) mm.

Camera type: Fiducial coordinates.

Focal length: 153.4080 .

Transform type: Affine.

Principal point position: (5616.869, 5633.155) pix.

Murmber of fiducials measured: 4 of 4.

Image size: (11230.000, 11213.000) pix., (235.8790, 235.5007) mm.

Sl Comiieilzs frnrren thne et Eel bl Image measurements, pix. Regiduals, pix. Residuals, mm
mark ol
4 b X Y Ex Ey = Ex Ey (=
Lirnit {max) 0.707 0707 0.707 — — —
1 106.9290 -106.0020 S60.000 10B68.000 -0.362 - 0.0172 0.0075 00189
2 -106.0030 -106.0050 10651.571 10B893.143 0.369 -| 0.0172 -0.0078 001839
3 -106.0010 106.0030 10675.000 558.000 -0.368 -| 0.0172 0.0075 00189
1 106.0040 106.0080 550.000 574.333 0.369 -| 0.0172 -0.0078 00189
L‘g‘&é”’ 0500 | 0500 | 0500 — — —
RMS 0.369 - 0.0172 0.007s 00189
Mean abs. 082 0.369 0.901 0.0172 0.007s 00189
hax 0.822 0.369 0.901 0.0172 0.0075 00189

Fig. 34. Report on interior orientation of film camera image

3.6. Interior orientation control

Close |

Prior to perform aerial triangulation it is necessary to make interior images orientation.
During interior orientation in some cases radially directed systematic errors occur.

Also, when execute images interior orientation in some cases errors occur because of
incorrectly specified focal length or due to incorrect distortion considering. In order to
determine the presence of such errors, it is necessary to perform block adjustment using
GCP and the projection centers.
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Accuracy of focal length, principal point coordinates and accounting distortion determ-
ining are interrelated. An error in focal length calculation results in error distortion con-
sidering and error of determining the principal point coordinates. It is necessary to
specify correct values of focal length and principal point coordinates in order the distortion
value does not exceed the specified tolerance. It is recommended to verify the sign of
the distortion correction and distortion units.

4. Images exterior orientation

One of the stages of building a triangulation network is defining parameters of block
exterior orientation.

An exterior orientation of block images implies the following actions:
» Import and usage of preliminary exterior orientation data, obtained with input images;

* Input of ground control points (GCP) coordinates to catalogue and measurement of
these points coordinates images.

When accurate enough exterior orientation parameters of block images are available,
it is possible to skip steps of GCP and tie coordinates measurement, as well as block
adjustment step from the workflow and proceed right away to steps of stereovectorization,
DEM and orthomosaic generation (see how to estimate accuracy of imported exterior
orientation parameters in Section 4.1.4). Otherwise, if there are inaccurate exterior ori-
entation parameters of block images, imported exterior orientation parameters are used
to block scheme refinement (see above).

4.1. List of exterior orientation parameters

Exterior orientation parameters of image are geometric parameters of image, that specify
its position and orientation in relation to object of photogrammetric survey in a moment
of the survey. There are linear and angular exterior orientation parameters of image.

Linear exterior orientation parameters of image — coordinates of center of optical image
projection in coordinate system of photogrammetric survey object.

Angular exterior orientation parameters of image — parameters that define image angular
orientation in coordinate system of photogrammetric survey object, slope and rotation
angles of image.

In order to view, import, input or edit exterior orientation parameters choose Orientation »
Exterior orientation data list or click the [iZ| button of the main toolbar of the system
or of the AT additional toolbar.

The Exterior orientation parameters window opens, which contains a table (list) of
exterior orientation parameters and its toolbar.

60



PHOTOMOD 8.1

Aerial triangulation (Windows x64)

7

Use the Ctrl+mouse wheel to quickly scroll through the list (aHanornyHo nonocam NPoKpyTKK
okHa). To navigate through the rows rotate the mouse wheel.

@ Exterior orientation parameters = | B
BT X b ey M 2w [

Code Name Xm Y.m Zm Omega® Phi,® Kappa.® Time Type(XYZ) Type (angles) Std.dev.X.m Std.dev.Y,m Std.dev.Zm Std.dev.Omega ® Std.dev.Phi° Std. dev. Kappa,®
42 DMCL.. 396.. 607.. 111.. 0.018450000 -0.029090000 -1.698240000 Control Check 0.2000000 0.2000000 0.1000000 0.005000000 0.005000000 0.005000000

43 DMCL.. 396.. 607.. 112.. -0.005820000 -0.023110000 -1.639320000 Control Check 0.2000000 0.2000000 0.1000000 0.005000000 0005000000 0.005000000

44 DMCL.. 396.. 607.. 112.. 0081230000 -0.009730000 -1.703310000 Control Check 0.2000000 0.2000000 0.1000000 0.005000000 0005000000 0.005000000

45 DMCL.. 397.. 607.. 113.. 0006230000 -0.022830000 -1.692000000 Control Check 0.2000000 0.2000000 0.1000000 0005000000 0.005000000 0.005000000

46 DMCL. 397.. 607.. 113.. 0017600000 -0.025790000 -1.682100000 Control  Check 0.2000000 0.2000000 01000000 0.005000000 0005000000 0.005000000

47 DMCL. 397.. 607.. 113.. 0002690000 -0.025270000 -1.677720000 Control  Check 0.2000000 0.2000000 01000000 0.005000000 0005000000 0.005000000

48 DMCL. 397.. 607.. 113.. -0.068280000 -0.032180000 -1.677010000 Control  Check 0.2000000 0.2000000 01000000 0.005000000 0005000000 0.005000000

DMCL.. 397.. 113.. -0.023240000 -0.024750000 -1.681350000 Control Check 0.2000000 0.2000000 0.1000000 0.005000000 0005000000 0.005000000
m&mm—-———
DMCL.. 398.. 114.. -0.003600000 -0.035940000 -1.683240000 Control Check 0.2000000 0.2000000 0.1000000 0.005000000 0005000000 0.005000000

52 DMCL.. 398.. 607.. 114.. -0.004250000 -0.027450000 -1.663390000 Control Check 0.2000000 0.2000000 0.1000000 0.005000000 0.005000000 0.005000000

53 DMCL. 39%.. 607.. 113.. -0.076600000 -0.017860000 -1.669080000 Control  Check 0.2000000 0.2000000 01000000 0.005000000 0005000000 0.005000000

54 DMCL. 39%.. 607.. 113.. -0.007960000 -0.029260000 -1.663130000 Control  Check 0.2000000 0.2000000 01000000 0.005000000 0005000000 0.005000000

75 DMCL. 39%.. 607.. 114.. 0002460000 -0.021420000 -1.667740000 Control  Check 0.2000000 0.2000000 01000000 0.005000000 0005000000 0.005000000

76 DMCL.. 398.. 607.. 114.. 0039920000 -0.041260000 -1.673230000 Control Check 0.2000000 0.2000000 0.1000000 0.005000000 0005000000 0.005000000

i DMCL.. 398.. 607.. 114.. 0107160000 -0.047140000 -1.663430000 Control Check 0.2000000 0.2000000 0.1000000 0.005000000 0005000000 0.005000000

78 DMCL.. 398.. 607.. 113.. -0.089670000 -0.008760000 -1.690610000 Control Check 0.2000000 0.2000000 0.1000000 0.005000000 0005000000 0.005000000

79 DMCL.. 398.. 607.. 113.. -0.018620000 -0.012540000 -1.679400000 Control Check 0.2000000 0.2000000 0.1000000 0.005000000 0.005000000 0.005000000

8  DMCL. 397.. 607.. 113.. 0.085680000 -0.040960000 -1.677990000 Control  Check 0.2000000 0.2000000 01000000 0.005000000 0005000000 0.005000000

8 DMCL. 397.. 607.. 114.. 0018630000 -0.021840000 -1.679830000 Control  Check 0.2000000 0.2000000 01000000 0.005000000 0005000000 0.005000000

8  DMCL. 397.. 607.. 115.. 0031920000 -0.040370000 -1.674700000 Control  Check 0.2000000 0.2000000 01000000 0.005000000 0005000000 0.005000000

a3 DMCL.. 397.. 607... 115.. -0.070840000 -0.026660000 -1.636930000 Control Check 0.2000000 0.2000000 0.1000000 0.005000000 0005000000 0.005000000

84 DMCL.. 397.. 607.. 114.. 0069190000 -0.033510000 -1.706110000 Control Check 0.2000000 0.2000000 0.1000000 0.005000000 0005000000 0.005000000

85 DMCL.. 396.. 607.. 114.. 0044820000 -0.014050000 -1.671330000 Control Check 0.2000000 0.2000000 0.1000000 0.005000000 0005000000 0.005000000

86 DMCL.. 396.. 607.. 114.. 0.057070000 -0.008320000 -1.717750000 Control Check 0.2000000 0.2000000 0.1000000 0.005000000 0.005000000 0.005000000

8  DMCL. 3%.. 607.. 113.. -0.116970000 0028080000 -1.654940000 Control  Check 0.2000000 0.2000000 01000000 0.005000000 0005000000 0.005000000

ok || cancd || Reset Apply

Fig. 35. List of exterior orientation parameters

The list of exterior orientation parameters contains the following exterior orientation
data of project images:

* project images code and name;

» XYZ — projection center coordinates in meters;

Omega-Phi-Kappa — angles of exterior orientation in degrees;

* survey time;

type and RMS of projection centers coordinates and angles.
The table displays adjusted and initial values of angles and GC points coordinates.

The toolbar buttons allow to work with the table, to perform import/export of exterior
orientation parameters, to define a type of exterior orientation parameters, to exclude
coordinates, to define kappa angle, etc.

Excluded coordinates values are displayed in the table by grey color. It is possible to edit these
values, and after that the coordinates are automatically considered during adjustment.

If there are XY points or Z points with unused coordinates available, the coordinates values are
not deleted and are displayed in the table as inactive.

7
7
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@ Points with not specified angles RMS, but at least one angle value is specified, are displayed
in the table as inactive. If both angles RMS values and angles values are not specified in the
table, then the angles are not shown in the table.

If there are no exterior orientation parameters for some images but survey time is spe-
cified for them, the [= button is used to calculate missing exterior orientation parameters
for all or for selected images using linear interpolation by time.

@ Itis recommended to calculate missing exterior orientation parameters using linear interpolation
by time for UAS images, since the time data is acquired from images containing metadata.

The system provides connection between the Exterior orientation parameters window
and 2D-window: images selected in 2D-window are automatically selected in the table
of the Exterior orientation parameters window. When the images are selected in the
table, they are automatically selected in 2D-window.

Table 4. The “Exterior orientation parameters” toolbar

Buttons Functions
to turn on/off the editing mode of the table data (data shown in the Code and Name

columns are not editable)

@ to perform a search in the table for image by its name (Ctrl+F)

' to delete highlighted rows from the table

b to delete all data from the table

to import a list of exterior orientation parameters from text file

to export the list of exterior orientation parameters to text files with *.csv and *.txt ex-
tensions

[ to change coordinate system for selected/all images in the table

] to swap X and Y coordinates of projection centers for selected/all images in the table

B to shift the coordinates of projection centers for selected/all images in the table

*# to make exterior orientation parameters (angles and/or projection centers) of images

selected in the table GCP

* to make exterior orientation parameters (angles and/or projection centers) of images
selected in the table check

2 to make exterior orientation parameters (angles and/or projection centers) of images
selected in the table excluded

ki to include all three coordinates (X, Y, Z) of projection centers for selected images in the
table, if some coordinates were excluded

Y to exclude Z-coordinate of projection centers for selected images in the table (for points
with XY coordinates)

_Z to exclude X, Y-coordinates of projection centers for selected images in the table (for
points with Z coordinate)

] to open the Set exterior orientation parameters accuracy window used to specify
threshold values in meters for RMS by XY and Z for projection centers, and for angles
accuracy values for selected/all images in the table

L to change the kappa angle by a predetermined value for selected/all images in the table
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Buttons Functions
2 to calculate missing data on projection centers coordinates and/or angle using interpol-
ation of exterior orientation parameters by time
* to specify the kappa angle value in accordance with the flight path
Ja to copy “adjusted” exterior orientation parameters to corresponding fields of initial exter-

ior orientation parameters for images selected in the table

=
=

is to show/hide initial data (input to the table manually or obtained during import)

to show/hide “adjusted” data — exterior orientation parameters corrections, calculated
during block adjustment operation

&2 to show/hide “adjusted” data — exterior orientation parameters corrections, calculated
during block adjustment operation, taking in account the rolling shutter effect (see the
“Adjustment parameters of central projection images block” chapter in the “Block adjust-
ment” User Manual).

g The effect of rolling shutter is the distortion of object shapes in an image when a picture is not
captured at the same instant but the image is captured progressively. This effect appears at the
short shutter speed of focal plane shutters or interline transfer CCD.

Survey data containing such distortions can be obtained using cameras installed aboard some
UAS. Itis recommended to use rolling shutter compensation algorithms if appropriate information
about the properties of the equipment used is available (see the “Adjustment parameters of
central projection images block” in “Block adjustment” User Manual).

4.1.1. Import orientation from metadata

In most cases, source images acquired by digital camera, might contain metadata,
written in EXIF format. Metadata of converted source images (in TIF format or in system’s
internal format MS-TIFF) is stored in the folder, which contains these images, in separate
files with *.md extension.

Metadata of digital maps — is data that allows to describe content, volume, position in space,
quality and other features of digital maps, as well as geodetic, gravimetric, photogrammetric
and cartographic data, which is used during creation (updating) and application of digital maps.

In both cases, if images containing metadata are available in a project, it is possible to
import from the metadata to the project parameters of interior orientation (precise) and
exterior orientation (approximate, i.e. calculated by on-board devices).

Exterior orientation parameters imported from images metadata allow to split a project
on strips using imported exterior orientation, rotate images by block layout using imported
data, adjust block scheme by imported exterior orientation parameters, and proceed to
block processing step, that also includes stereo vectorization.

é Prior to orientation data import from images metadata it is recommended to specify height dif-
ference of terrain in the project in the Project properties window (see the “Project creation”
User Manual).

To perform import of orientation data from images metadata perform the following ac-
tions:
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1.

2.

Choose Orientation » Import orientation from metadata. The Import orientation
from metadata window opens.

. Import onentation from metadata [ﬁj

| Import interior orientation

Replace existing data

| Impart exterior orientation
Replace existing data

Import EQ angle values

K ] | Cancel

Fig. 36. Import orientation from metadata

[optional] To perform images interior orientation to a project, the Import interior
orientation checkbox is set by default. Set the Replace existing data checkbox
to replace interior orientation data that already exists in the project.

% If the project already contains file with name containing camera serial number, then it is
recommended to create backup of this file if the Replace existing data checkbox is set.

[optional] To perform images exterior orientation to a project, the Import exterior
orientation checkbox is set by default. Set the Replace existing data checkbox
to replace exterior orientation data that already exists in the project.

% Set the Import EO angle values, if needed.

Angular exterior orientation parameters of image — parameters that define image angular
orientation in coordinate system of photogrammetric survey object, slope and rotation
angles of image.

ﬁ To perform import of exterior orientation parameters it is necessary that a project is in co-
ordinate system consistent with WGS-84 coordinate system.

Click OK. After that the exterior and interior orientation parameters are imported
from images metadata to the project. At that a camera file with name containing
camera serial number is created for each project camera.

c After orientation import from images metadata it is recommended to specify once more
height difference of terrain in the Project properties window (see the “Project creation”
User Manual)
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4.1.2. Import of exterior orientation parameters from text file

The exterior orientation parameters are projection centers coordinates of each block
image, 3 angles (omega, phi, kappa), as well as survey time. All the above parameters
describe image position in space.

When accurate enough exterior orientation parameters of block images are available,
it is possible to skip steps of GCP and tie coordinates measurement, as well as block
adjustment step from the workflow and proceed right away to steps of stereovectorization,
DEM and orthomosaic generation (see how to estimate accuracy of imported exterior
orientation parameters in Section 4.1.4).

Otherwise, if there are inaccurate exterior orientation parameters of block images, im-
ported exterior orientation parameters are used to block scheme refinement.

There are the following conditions of successful import of exterior orientation parameters:
» correct images exterior orientation;

« terrain elevation difference data (Zmin, Zmax in meters), which should be specified
either on project creation step (see the “Project creation” User Manual), or directly
during import of exterior orientation data in the Import exterior orientation paramet-
ers window.

5 When terrain elevation difference on block images is more than 1/10 of flight altitude, it is

recommended to use GSD data to block layout creation using imported data (see the Sec-
tion 2).

In general case perform the following steps to import images exterior orientation para-
meters:

1. Choose Orientation > Direct georeferencing or click the ¢ button of the AT
toolbar. After that the information window opens, it contain information about number
of images adjusted using exterior orientation parameters.

% If a project contains measured tie points, their relative orientation is performed automatically.

2. Perform accuracy control of imported exterior orientation parameters.

3. Depending on quality of imported exterior orientation parameters, perform one of
the following steps:

« if the exterior orientation parameters are precise enough, pass to project pro-
cessing (to stereovectorization, DEM generation and orthomosaic creation);
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» otherwise, perform steps of tie and GC points measurement and then block ad-
justment, after that pass to project processing step.

To import exterior orientation parameters to a project perform the following actions:

1. Choose Orientation > Import exterior orientation or click the button in the
Exterior orientation parameters window. The Open window opens.

2. Select a file containing exterior orientation parameters and click OK. The Exterior
orientation import — Step 1 of 3: File window opens. The File name input field
displays selected file placement and name. To select another file which contains
exterior orientation parameters, click the _... | button.

c If the imported data contains information about time stamps, this information must be
presented in Unix time (POSIX time) format.

Unix time is represented by an integer that increments with each passing second. The in-
teger system used is convenient for comparing and storing dates.

If one needs to access date elements (day, month, year), seconds can be converted into

any suitable format (and vice versa). A signed integer type is used in programs to store
Unix time.

& Exterior orientation import S
File
Step 10f 3
Line template Name X ¥ Z Omega Phi Kappa - @& (2] &
Startimport from line 1 + previewmaximum 10 [ lines

V] Automatically validate template

Field separators Decimal separator Misc
Comma Tabulation Space @ Pointonly UTF-8
Semicalon Point or comma Parse @' "

Available fields

Name Z Kappa  STDDEVZ STDDEVKappa
X Omegs STDDEVX STDDEVOmega T
¥ Phi  STDDEVY STDDEVPhi

[ Preview file: C:\Users\guk\Desktop ipunepe! dafinos ana PHOTOMOD \orient, csv

Mame
CODENAME, TIME, XY, Z TYPE_XYZ STDDEVX, STDDEVY,STDDEVZ, OMEGA_DEG,PHI_DEG,KAPPA_DEG, TYPE_ANGLES,STDDEVOMEGA_DEG,STDDEVPHI_DEG,STDDEVKAPPA_DEG
46,Aalen_05~0046_rgb,*,580341.488166,54099532.058002,1180.629778, control,1.000000,1.000000,1.000000,-0.408848017579,-0.371978000231, -0.56648 2003037, control,0.100000000000,0.100000000000,0.100000000000
47, Aalen_05~0047_rgb,*,580556.619517,5409951.087742,1181.077358, contrel,1.000000,1.000000,1.000000,-0,61 2921009897, -0.397289997839,0.9358780023220, contrel,0.100000000000,0.100000000000,0.100000000000
48 Aalen_05~0043_rgh,*,580771.587563,5403950.143097,1182.034713, control, 1.000000,1.000000,1.000000,-0.607340027500, -0.474678998032,1.002643997571, control, 0.100000000000,0.100000000000,0 100000000000
49 Aalen_05-0049_rgh,*,580986.547833,5409949.928587,1183.186939, control, 1.000000,1.000000,1.000000, -0.605610999985, -0.358733000026,1.121 365002450, control,0.100000000000,0.100000000000,0 100000000000
50,Aalen_05-0050_rgh, *,581201.382746,5409950.507183,1184.173202, control, 1.000000,1.000000,1.000000,-0.633116030538, -0.214965000009,1.375061001941, contral,0.100000000000,0.100000000000,0 100000000000
112 Aalen_04~0112_rgb,* 581187 .483547,5410523.882411,1191.366807, control,1.000000,1.000000,1.000000,0.211941939973,0.346330000016,178.221 088004380, cantrol,0.100000000000,0.100000000000,0.1 00000000000
113, Aalen_04~0113_rgb,”,580972.630916,5410525.843548,1192.720992, control,1.000000,1.000000,1,000000,0.765833017946,0.181 568003562, 178.276255001310, control,0.100000000000,0.100000000000,0.100000000000
114, Aalen_04~0114_rgb,”,580757.382570,5410596.957738,1193.208080, control,1.000000,1.000000,1,000000,0.771842000007,0.069772999926,178.392563994 507, control 0.100000000000,0.100000000000,0.1 00000000000
115,Aalen_04~0115_rgb,”,580542.189912,5410596.214251,1192,938946, contrel,1.000000,1,.000000,1,000000,0.909945010312,0.081856001115,179.393529001 328, centrol 0.100000000000,0.100000000000,0.100000000000
File name  C: /Users/quk/Desktop/Npuneps: daiinos Ans PHOTOMOD orient.csv
V| Loose matching of image names in file against names in project

1
2
3
4
5
6
7
8
9

10

@

Match by record number

Setup...
PAT-B matrix

@ €SV (projection centers, Omega/Phi/kappa angles and GPS time)
CSV (navigation data: latitudelongitude/altitude WG5S 84, heading/pitch/roll angles and time)
CSV (navigation data: projection centers in working c.s., heading/pitch/roll angles and time)

Fig. 37. The Exterior orientation import window (the file string template is not specified)
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3. [optional] If images names in file and in project are not the same, perform one of
the following actions:

+ set the Loose matching of image names in file against names in project
checkbox. The system performs search for common substrings and matches
images names. For example, it searches for common substring 0718 02595 in
image name RGBI_018 02595 in file and image name 018 02595 in project.

If the Loose matching of image names in file against names in project checkbox is
set the image name with file extension is also imported.

+ set the Match by record number checkbox and click the Setup... button. The
Match images by numbers window opens.

‘ Match images by numbers — S

Mumbers in the file

Serial numbers of records matching the template

@ Read from the Name field

Mumbers of images in the project
@ Serial numbers of images

Read from image names

File record with number It

LR L

matches project image with number 1

[ oK ” Cancel |

Fig. 38. Images matching by numbers
1. In the Numbers in the file section set the following parameters:

o Serial numbers of records matching the template — used to match a
list of records numbers in a file by order;

o Read from the Name field — used to match a list of records numbers in
a file by the last number from the filename.

2. Inthe Numbers of images in the project section set the following paramet-
ers:

o Serial numbers of images — used to match a list of records numbers in
a project by order;

o Read from images names — used to match a list of records numbers in
a project by the last number from the filename.
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3. Input necessary parameters to the File record with the number and matches
project image with number input fields.

% For convenient setup of necessary parameters it is recommended to place windows
in that way that allows to display on screen a name of the first image in the table
of the Exterior orientation parameters window, and also allows to display first
rows in the Preview file table of the Exterior orientation import window. It is re-
commended to place the Match images by numbers window in such a way that

allow to show both windows mentioned above.

4. Choose one of the following formats to specify a type of imported file:

* PAT-B matrix — file containing coordinates of projection centers and rotation
matrices (see Section B.1).

@ If the PAT-B file contains exterior orientation parameters, calculated for negative plane,
set the Negative checkbox.

@ In case of data export from the PAT-B matrix, the further line template setup is not re-
quired. Click Next to move to the second step.

* CSV (projection centers, Omega/Phi/Kappa angles and GPS-time) — file
containing coordinates of projection centers in any coordinate system, as well
as exterior orientation parameters, and precise time from GPS-receiver.

Line template by default: Name, X, Y, Z, Omega, Phi, Kappa (see below).

a CSV format is exchange text format with *. csv extension, which is supported by major
applications in different industries. It is used as exchange format when special geospatial
data formats are not applicable for some reason.

« CSV (navigation data: latitude/longitude/altitude WGS-84, heading/pitch/roll
angles and time) — file containing navigation data (latitude/longitude set in de-
grees, altitude in meters, angles in degrees, radians or gons) and precise time
from GPS-receiver.

Line template by default: Name, Lat, Lon, H, Heading, Pitch, Roll.

ﬁ To perform import of exterior orientation parameters it is necessary that a project is in
coordinate system consistent with WGS-84 coordinate system.

+ CSV (navigation data: projection centers in working c.s., heading/pitch/roll
angles and time) — file containing navigation data (coordinates of projection
centers in project coordinate system, angles in degrees, radians or gons) and
precise time from GPS-receiver.
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Line template by default: Name, X, Y, Z, Heading, Pitch, Roll.

5. [optional] If data is imported from *. csv format, it is necessary to setup a current
line template.

The Line template field displays the list of main and additional fields, contained in
each line of imported file (depending from selected import format):

* Name — image name;
* X, Y, Z (or Lat, Lat, H) — coordinates of center of optical image projection;

» Omega, Phi, Kappa (or Heading, Pitch, Roll) — Omega, Phi, Kappa angles (or flight
heading, roll and pitch);

* [optional] STDDEVX, STDDEVY, STDDEVZ — accuracy of linear exterior orientation
parameters (RMS);

* [optional] STDDEVOmega, STDDEVPhi, STDDEVKappa — accuracy of angular exterior
orientation parameters (RMS);

* T —time from GPS device;
+ * —fields, that will be missed during import.

The Preview file table contains data of imported file. Fields type according to the
template, located in the Line template field, are automatically assigned to the table
columns.

All objects are saved using the same template. Each line of a file contains the same
number of fields, that equals to number of fields in template. Lines which does not
correspond to the template, are skipped.

In order to begin the setup of active template, perform the following:

* [optional] To display necessary number of lines in the Preview file table, set the
Preview maximum parameter. Default number of lines is 10.

* [optional] To specify a line from to start data import, define the value of the Start
import from line parameter.

ﬁ In many cases, the imported file may have a first row containing headers describing the
contents of the columns in the file. Accordingly, this row should not be included in the
imported data, but its display in the Preview file table may be useful when setting up
the row template. It is recommended to set this parameter at the very end, when pro-

ceeding to the next step.
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* In the Field separators section set on one or multiple checkboxes to specify
possible fields delimiter symbol: Comma, Space, Tab, Semicolon or Other de-
limiters. Default settings are comma and space.

In the Decimal separator section setup the following parameters:
o Point only — to use point only as a decimal separator in coordinates;

o Point or comma - to use both point and comma as a decimal separator in
coordinates.

c If comma is used as Field separator, it is not recommended to use comma as
Decimal separator, since it may cause import of incorrect data.

[optional] In the Misc section set the checkbox:

o UTF-8 — is used to recognize text in Unicode encoding;
Unicode — symbols encoding format that allows to provide symbols of almost all
written languages.

o Parse °’ “ —is used to recognize records of projection centers or GCP.

When using this parameter it is highly recommended to check points coordinates recog-
nition correctness after import.

@ Exterior orientation import (S
File
Step 10f3
Line template Name - @ (B[]
Start mport from line: 1 <] preview masimum 10 [ ines
] autor idate tenplate
tors Misc
Tabulation [] space UTFs
Semicolon Parse ®
Avalable fields
Name Z Kappa  STDDEVZ STDDEVKappa
X Omega STODEVX STDDEVOmega T
¥ Phi  STDDEVY STDDEVPhi
[Preview file: C:WUsers\guic\DesktopV paweps! bafinos A7 FHOTOMOD orient. csv @
Name
1 [CODE|NAME TIME X Y Z TYPEXYZ STDDEVX STDDEVY STDDEVZ OMEGADEG PHIDEG KAPPADEG TYPEANGL. STODEVOMEGADEG STDDEVPHIDEG STDDEVKAPPA DEG
2 46  Ade. * S8 54. Il. control 1000000 1000000 1.000000 -04088480.. -03719.. -0.5664820.. control [ 0 0
3 47 Aele. * S8 S 1000000 1000000 1000000 -06129210.. -03972. 0S35670.. control o o o
4 48 Ade. * S8 54. Il control 1000000 1000000 1000000 -06073400.. -04746.. 10026430.. contral [ 0 0
5 49 Aal 56... 54 1000000 1000000 1000000 -0.60S6105.. -0.3587.. 11213650.. control o o 0
6 50 Asle. " SB. 54 1000000 1000000 1000000 -06331160.. -0.2149.. 13750610.. control [} o o
7 12 Ade. * 5. 54 1000000 1000000 1000000 0.21194199.. 034683.. 17822108.. control o o 0
8 113 Ade. * S8 54 1000000 1000000 1000000 076583301.. 018156.. 17827625.. control o o o
8 14 Adde. * S8 54. 1l 1000000 1000000 1.000000 0.77184200.. 0.06977.. 1783925.. control [ o 0
10 115 Asle.. S8 54 1000000 1000000 1000000 090994501.. 0081ES.. 17939353... control o 0 o
File name  C:/Users/guk/Desktop/Mpunepe! (afinos ans PHOTOMOD forient.csv =)
] Loose matching of mage names in il against names in project
Match by ber Setup..
PAT-B matrix
® CSV orojection centers, OmegaPhifappa angles and GPS tine)
csv tude WGS 34, oll angles and time)
CSV {navigation data: projection centers in working ¢.s., heading/pitch/roll angles and time)

Fig. 39. Setup a file string template for import of exterior orientation parameters (the table is divided

into columns, but their order is not correct)
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In order to finish the setup of the active template, perform one of the following ac-
tions:

» drag by mouse field name from the Available fields list to the head of the column
of the Preview file table. After that the template in the Line template field
changes. In order to cancel field selection, double click the column of the Preview
file table column;

» change a template manually in the Line template field. After that column types
in the Preview file table will be changed automatically.

@ To cancel the field name double click the column.

& Exterior orientation import =5
File
Step 1of 3

Line template * Name, T, X,Y,Z,* STDDEVX,STDDEVY,STDDEVZ,Ome + [1]
Start import from line ’ % Preview maximum 10 = lines
Automatically validate ate

Field separators )ﬂ Decimal separator  Misc

Comma bulation [7] Space @ Pointonly [F] utF-8

|l SEmI(uw () Pointer comma [ Parse '

Avail fields

Name Z Kappa STDDEVZ STDDEVKappa

XVEQE STODEVX STDDEVOmega T

¥ hi STDDEVY STDDEVPhi
[Preview ﬂIe‘sers\guk\DeskmpV‘\pwmapb\ taitnos Ana PHOTOMOD \orient.csv @

*  Name * STDDEVX STDDEVY STDDEVZ Omega Phi STDDEVOmega STDDEVPhi STDDEVKappa

1 m---mm

2 Aale... control 1.000000 1.000000 1.000000 -0.4088480.. -0.3719.. -0.5664820.. control 0.100000000000 0.100000000000  0.100000000000

EREY Aale.. * 58.. 54.. 1l.. control 1.000000 1.000000 1.000000 -0.6129210.. -0.3972.. 09358780.. control 0.100000000000 0.100000000000  0.100000000000

4 48 Aale.. * 58.. 54.. 1l.. control 1.000000 1.000000 1.000000 -0.6073400.. -0.4746.. 1.0026439.. control 0.100000000000 0.100000000000  0.100000000000

5 49 Aale.. © 58.. 4. 1l.. control 1.000000 1.000000 1.000000 -0.6056109.. -0.3587.. 11213650.. control 0.100000000000 0.100000000000  0.100000000000

6 50 Aale.. © 58.. 4. 1l.. control 1.000000 1.000000 1.000000 -0.6331160.. -0.2149.. 13730610.. control 0.100000000000 0.100000000000  0.100000000000

7 112 Aale.. © 58.. 4. 1l.. control 1.000000 1.000000 1.000000 0.21194199.. 0.34683.. 178.22108.. control 0.100000000000 0.100000000000  0.100000000000

g 112 Aale.. © 58.. 4. 1l.. control 1.000000 1.000000 1.000000 0.76583301.. 0.18156.. 178.27625.. control 0.100000000000 0.100000000000  0.100000000000

9 114 Aale.. © 58.. 4. 1l.. control 1.000000 1.000000 1.000000 0.77184200.. 0.06977.. 178.39256.. control 0.100000000000 0.100000000000  0.100000000000

10 115 Aale.. © 58.. 4. 1l.. control 1.000000 1.000000 1.000000 0.90994501.. 0.08185.. 179.39333.. control 0.100000000000 0.100000000000  0.100000000000
File name  C:/Users/quk/Desktop Mpumeps: dhaiinos ana PHOTOMOD forient.csv )

Loose matching of image names in file against names in project

[] Match by record number

() PAT-B matrix
Negative
@ C5V {projection centers, Omega/PhifKappa angles and GPS time)
") CSV {navigation data: latitude/longitude/altitude WGS 84, heading/pitch/roll angles and time)
() €SV {navigation data: projection centers in working c.s., heading/pitch/roll angles and time)

Fig. 40. Setting up the file line template to import exterior orientation parameters (correct data entered
in the Line template field). The first line of the file that needs to be excluded from import is highlighted,
starting the import from line 2

@ The fif button allows to use the default template.

@ The %] button is used to compare the Line template field with data shown in the Preview
file table.

@ The & button is used to replace specified field names by field values taken from the first
line of the Line template table.
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[optional] The Automatically validate template checkbox is set on by default that
allows to select current template automatically. In order to configure the template
for file containing lines with different columns number, set off the Automatically
validate template checkbox and configure the template in the Line template field
manually.

6. Click the Next button. The Exterior orientation import — Step 2 of 3: Import
settings window opens.

r ™
. Exterior crientation import I&

Import settings
Step 2of 3

Angles

Measurement units

Radians @ Dearees Gons

Add to the kappa angle

_________________

Invert sign for angles:

Omega Phi Kappa

Predsion (std. dev.)

| Projection centers | Exterior arientation angles
¥ 0,20000 + M omega 0.00500 = °
¥ 0,20000 s m  phi 0.00500 =
Z 0,20000 s m  kappa 0.00500 =

< Back | [ Mext = ] | Cancel

Fig. 41. Exterior orientation import — Step 2
Define the following parameters of import:

* Inthe Angles section specify measurement units for angles coordinates according
to data of the file to be imported:

o radians;
o degrees;

o gons — plane angle measurement unit that equals to 1/100 of flat right angle
measurement unit, and full angle is 400 gons.
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 [optional] In order to make correction to kappa angle, set on the Add to the kappa
angle checkbox and input correction value to the input field.

* [optional] In order to Invert sign for angles Omega, Phi, Kappa (or Heading,
Pitch, Roll), set on corresponding checkboxes.

* [optional] In the Precision (std. dev.) section change precision of a priori RMS
of measurements of projection centers coordinates and exterior orientation angles.

g If Projection centers and Exterior orientation angles checkboxes are cleared, the
appropriate data are imported from the file (if the data are available and the import
parameters are correctly configured in the Exterior orientation import — Step 1 of 3:
File window). Imported data may differ from image to image. If the checkboxes are set,
the values manually specified by a user are used during import (the same for all images).

7. If import of exterior orientation parameters is performed using the Exterior orient-
ation parameters window, then click the Execute button. After that the exterior
orientation parameters are imported to the list of exterior orientation parameters.

If import of exterior orientation parameters is performed using the Orientation >
Exterior orientation import... menu item, then click the Next button. The Exterior
orientation import — Step 3 of 3: Additional actions window opens.

r Ny
. Exterior crientation import [&J

Additional actions
Step 3of 3

| 5plit block into strips by EQ data

| Create block layout by EQ data
Adjust block based on imported EO data
Rotate images in block scheme by block layout

< Back | [ Ok ] | Cancel

Fig. 42. Exterior orientation import — Step 3

Select and set the following checkboxes to perform automatic execution of these
actions just after import of exterior orientation parameters from file:

» Split block into strips by EO data — to split block images into strips using im-
ported exterior orientation parameters (if all images were loaded to a single strip
on a step of project creation);
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» Create block layout by EO data — to create block layout considering imported
exterior orientation parameters;

» Adjust block based on imported EO data — to perform block adjustment using
imported exterior orientation parameters;

* Rotate images in block scheme by block layout — to re-create a block scheme
in 2D-window using block layout no HakmgHomy MoHTaxy (this checkbox is
available if the Create block layout by EO data is set).

8. Click the Execute button. After that the exterior orientation parameters are imported
to the list of exterior orientation parameters .

9. Estimate accuracy of imported exterior orientation parameters by block layout, by
measured GC points coordinates and/or by values of vertical parallax during
measurement of coordinates of multiple tie points.

4.1.3. Import of orientation parameters for data obtained by UltraCam
Osprey

During UltraCam Osprey data processing, import of exterior and interior orientation
parameters is carried out from a separate file with *.eo extension.

g UltraCam cameras employ the syntopic exposure principle of imagery collection when the final
image is composed form several fragments obtained sequentially by the system of several lens
and panchromatic CCD-sensors as they pass over the same point of space.

The UltraCam Osprey model is used for simultaneous vertical and oblique imaging. The camera
allows for obtaining orthophotomaps and textured digital terrain models.

& To import orientation from the *.eo file, it is necessary to check the structure of the file to be
imported and correlate the names of images uploaded to the project with the names of images
if the file.

é The process of import of orientation for UlfraCam Osprey imagery is described below. When
processing data collected by other cameras from the UltraCam family, the orientation can be
presented as metadata, e.g. contained in raster image files of the camera.

? An *.eo file can be viewed using standard word processor.

To import orientation from an *. eo file, perform the following:

1. Choose Orientation » Import UltraCam Osprey orientation. Select the *.eo file
and click OK. Import UltraCam orientation — Step 1 of 3: Data correlation window
opens:
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. Import UltraCam orientation |

Data matching
Step 1of 3

Correlated image names Unfound image names in file
0 i“_

In project In file Fo 14 Pan -
Aa\en705~0046,rgb T 6 Pan 15 Pan
Aslen_05-0047_rgh | 16 pan
ARG 17_pan
Aalen_05~0048_rgh 18 Pan
Aalen_05~0049_rgb 19_Pan
Aalen_05~0050_rgh 20_Pan
Aalen_D4~0112_rgh 112_Pan 2 _Pan
Azlen_04~0113_rgb 113 Pan 22 Pan
23 Pan
Aalen_04-0114_rgb 114_Pan 24 Pan
Aalen_04~0115_rgh 115_Pan 25 Pan

Aalen_04-0116_rgb 116_Pan 26_Pan -

Reset

Fig. 43. The UltraCam orientation — Step 1 of 3: Data correlation window

The UltraCam orientation — Step 1 of 3: Data correlation window contains the
following elements:

The Correlated image names table containing the list of names of images up-
loaded to the project (In project column) and the list of matching names of images
from the file (In file column). The names of images uploaded to the project for
which the relevant data in the file were not found are highlighted in yellow;

The Unfound image names in file table containing the list of image names in
file except for those matched against the names of imagery uploaded to the
project (Correlated image names table, In file column).

Buttons B+ and §% used to match/clear matching image names in project against
image names in file;

The Reset button is used for canceling all user actions undertaken during
manual matching of image names.

2. [optional] To match the name of the image uploaded to the project against the name
of the image in file, perform the following:

Select arow in the Correlated image names table which contains wanted name
of the image uploaded to the project by left mouse button click;

% For matching operation, both the rows of unmatched names highlighted in yellow and
the rows of matched names (e.g. in case of incorrect matching) are available.

The system provides possibility to perform matching of several pairs of image names
at once.

Select a row in the Unfound image names in file table which contains wanted
name of the image in file by left mouse button click;
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« Click the Wi+ button to match image names. Data in both tables will be updated.

3. [optional] To clear the matching between a pair of image names, in the Correlated
image names table select a row containing the appropriate pair of names (by left
mouse button click) and click the §X button. Data in both tables will be updated:;

@ The system allows to clear matching of several pairs of image names at once.

4. [optional] To cancel all user actions undertaken during manual matching of image
names, click the Reset button;

5. Click the Next button. The UltraCam orientation — Step 2 of 3: Import parameters
window opens;

’. Import UltraCam orientation I,&J

Import settings
Step 2 of 3

Camera position influence
Correct center values

Correct angle values

Predision (std. dev.)

Projection centers Exterior orientation angles
¥ 0.20000 % [Units] omega 0.005 ==
Y |0.20000 | [Units] phi  |0.005 “le
Z [0,20000 | [Units]  kappa |0.005 =
| Uniform predsion by all axes | Uniform predsion by all axes
< Back | [ Mext = ] | Cancel

Fig. 44. The UltraCam orientation — Step 2 of 3: Import parameters window
6. [optional] Set the Correct center values checkbox in the Camera position influ-
ence section, if needed;

7. [optional] Set the Correct angle values checkbox in the Camera position influence
section, if needed;

8. [optional] In the Precision (std.dev.) section change precision of a priori RMS of
measurements of Projection centers coordinates and Exterior orientation angles.
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7

To cancel automatic setting of the same precision by all axes, clear the Uniform precision

by all axes checkbox.

9. Click the Next button. The UltraCam orientation — Step 3 of 3: Additional actions
window opens;

-
’. Impaort UltraCam orientation

)

Additional actions
Step 3of 3

| Split into strips
By image names
By exterior orientation

Max angle deviation |2.000
@ Auto mode
| Create block layout by EQ data

Adjust block based on imported EO data
Rotate images in block scheme by block layout

< Back

| [ (]9 ] | Cancel

Fig. 45. The UltraCam orientation — Step 3 of 3: Additional actions window

10. [optional] set the Split into strips checkbox to split block images into strips (if all
images were loaded to a single strip on a step of project creation). Strips recognition
could be made by the following methods:

+ By image names — allows to split images into strips using images names;

* By exterior orientation — allows to split images into strips by imported exterior
orientation parameters;

o Enter Max angle deviation in degrees to account for deviations due to survey-

ing aircraft evolution.

Too large values of maximum deviation angle may result in errors in the splitting of
imagery taken by vertical and oblique cameras into strips.
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Unsorted images are to be added to strips having names of unsorted X type, where
X is the number of a strip containing unsorted images.

+ Auto mode — allows to split images into strips using both images names and
imported exterior orientation parameters.

11. [optional] set the Create block layout by EO data to create block layout considering
imported exterior orientation parameters;

12. [optional] set the Adjust block based on imported EO data to perform block ad-
justment using imported exterior orientation parameters;

13. [optional] set the Rotate images in block scheme by block layout to re-create a
block scheme in 2D-window using block layout.

5 This checkbox is available if the Create block layout by EO data is set) .

14. Click Execute.
4.1.4. Imported data accuracy control

In order to perform aerial triangulation in some cases it is necessary to perform import
of images exterior orientation parameters. After data import it is recommended to perform
imported data accuracy control using methods listed below.

Accuracy control of block layout creation by exterior orientation parameters

To reveal blunders occurred during block layout creation, it is recommended to visually
estimate the block scheme, created by exterior orientation parameters (see the Sec-
tion 2). At that it is necessary to keep in mind that beside errors occurred during data
import, errors of interior orientation step, as well as errors of defining of terrain height
difference are also influence on block layout creation.

If visual control of a block scheme using block layout is satisfactory, it is necessary to
perform accuracy control of measured GCP coordinates, and control of vertical parallax
residuals on tie points.

Accuracy control of measured GCP coordinates
To reveal errors in GCP coordinates, use one of the following ways:
First way:

1. Measure coordinates of 2-3 GC points on block images (see the Section 4.2.1).
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2. Choose Orientation > Direct georeferencing. After that the system displays inform-
ation window, which contains information about number of images adjusted using
exterior orientation parameters.

3. Choose Orientation > Block adjustment or click the &# button. The Adjustment
toolbar opens.

4. Estimate residuals vectors on GC points (see the Block adjustment User Manual).

Second way:

1. Place marker on GC point in a block image in 2D-window.

2. Choose Orientation > GCP list or click the £* button of the main toolbar or the AT
additional toolbar. The Triangulation points window opens.

3. Compare GCP coordinates shown in the Triangulation points window with marker

coordinates displayed in status bar.

Control of vertical parallax residuals in stereomode

To reveal vertical parallax residuals on tie points:

1.

2.

Measure coordinates of 6-10 tie points on block images (see the Section 5).

Choose Orientation > Direct georeferencing. After that the system displays inform-
ation window, which contains information about number of images adjusted using
exterior orientation parameters.

Choose Orientation » GCP list. The Triangulation points window opens.

Choose tie point and open images containing measurements of selected tie point
using the £ button. The Points measurement module is opened.

Choose the “left” and active image of stereopair and click the ] button of the main
module toolbar. Selected stereopair is opened in a stereo window (see the Sec-
tion 5.5).

Click the & button of the stereo window toolbar.

Estimate value of vertical parallax calculated on tie points in stereomode, shown
in the top right corner of the stereo window.

§ In mono mode residuals control is performed using the /& and & buttons of the main
toolbar of the Points measurement window.
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4.1.5. Projection center shift

The system allows for shifting projection centers for selected/all images in the table of
the Exterior orientation parameters window.

For this, perform the following:

1. [optional] select the required images in the table of the Exterior orientation para-
meters window;

2. Click the & button of the Exterior orientation parameters window toolbar. The
Shift center’s coordinates window opens:

i 4
. Shift centers coordinates [ﬁ,'
X 0.00 = m
¥ 0.00 = m
i 0.00 = m
@ Far allimages
For the selected images
K ] | Cancel
L™ &

Fig. 46. The Shift center’s coordinates window

3. Set the shift for the projection center coordinates by X, Y and Z axis, in meters;

4. Choose either shift projection center coordinates For all images or only For the
selected images;

5. Click OK.

@ To undo changes, click the Reset button in the Exterior orientation parameters window.

4.2. GCP list

GC point is a terrain point with known geodetic coordinates, which is a source point for
photogrammetric measurements.

Measurement of GC point coordinates means adding of known terrain point coordinates
to GC points list and measurement of its pixel coordinates on image. In order to use
GC points during block adjustment perform the following actions:
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1. Input coordinates of GCP to coordinates list.

2. Measure coordinates of GC points on project images.

A To perform correct block adjustment it is recommended to measure coordinates of all input
GC points on block images, since all points — both measured and unmeasured — take part
in statistics during block adjustment. Otherwise, it is possible to exclude unmeasured points

on steps of coordinates measurement and block adjustment.

Adding and measurement of GC points coordinates on block images in the system allow
to calculate exterior orientation parameters of images block, when metadata with exter-
ior orientation parameters, obtained from a provider, is not available.

@ Generally, adding and measurement of GC points coordinates is performed on a step of tie
points coordinates measurement and relative orientation. Then it is necessary to adjust a block
and calculate exterior orientation parameters. After that project images block is fully prepared

for further processing, including stereo vectorization, DEM and orthomosaic generation.

If the GC points coordinates data is unavailable at the time of data collection for aerial
triangulation procedure, the system provides possibility to adjust a block in a free
model (without GC points), that allows to proceed to project processing step directly
(see the “Block adjustment” User Manual).

é When deleting images from a project it is highly recommended to synchronize data in a project
to remove redundant results of orientation. To do this choose Project » Synchronize.

To open the GCP list, choose Orientation » GCP list or click the £ button of the main
toolbar. The Triangulation points window opens on the GCP list tab:

@ Aalen_DMC_training_Brusnikin - PHOTOMOD = | B S
Triangulation points [total: 275 / visible: 8] x
:QEGCP Ijst] | “X Tie points |
Bl FE T ER-G wBew 2 unt w0 B AEL EE
Code Mame Type X,’m ¥, m Zm  Std. dev. X, m Std. dew.¥, m Std. dev. Z, m Mumber of meas.
15421 (01450007 Ground Control 580303.6307 5410896169 475422 0.2 0.2 0.2 2
15420 00330101 Ground Control 580342.2065 5410576.536 479331 0.2 0.2 0.2 2
15425 02410031 Ground Control 580464.645 5410072308 482411 0.2 0.2 0.2 2
15426 03850029 Ground Control 580821.4026 541052741 488609 0.2 0.2 0.2 2
15424 01750031 Check 580836.3151 5410912.538 520657 0.2 0.2 0.2 2 i
15423 01640032 Ground Control 580936.8092 5400606.248 490705 0.2 0.2 0.2 2 Cancel
15427 04980011 Ground Control 580941.3261 5410131.409 499344 0.2 0.2 0.2 3
15422 (01640010 Ground Control 581368.7509 5410059.165 513.552 0.2 0.2 0.2 1 Iﬁl
15428 04980069 Ground Control 581405405 5410505.799 520888 0.2 0.2 0.2 1 | Apply |

Fig. 47. The GCP list

The toolbar of the GCP list tab is used to input/import/editing of GC points coordinates,
and also allows to open the module of GCP coordinates measurement on project images.

ﬁ The Points measurement module is described in appropriate chapter (see Section 5.2).
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Table 5. Toolbar on the GCP list tab

Buttons

Functions

to turn on/off the editing mode of GC points in the table

to search for GCP in the list using its name (Ctrl+F)

to add a new GCP to the list

to delete either selected ground control points, or measurements the selected ground
control points in reference points directory.

to delete either all the ground control points from the directory along with the measurement
results, or the measurement results only

to import the GCP list from text file to the list

to export the GCP list from the list to text file

to swap X and Y coordinates for selected/all GCP in the list

to re-calculate the coordinate system for selected/all GCP in the list

to consider all three X, Y, Z coordinates in case of XYZ GC points (default parameter)

to use XY GC points, i.e. to exclude the Z-coordinate of selected/all points of the list

to Z GC points, i.e. to exclude the XY-coordinates of selected/all points of the list

S | S| M) 3| 82 o) K| =B BB

to open the Set exterior orientation parameters accuracy window used to define ac-
curacy of coordinates (RMS) by XY or by Z for selected/all GC points of the list

to assign the Ground control type to points selected in the list

" B[

to assign the Check type to points selected in the list (see below)

to assign the Excluded type to points selected in the list (see below)

o

&

to open the Point properties window to view a name, type, code and coordinates of
selected point (see the Section 5.4.3)

e

to open the Points measurement module to measure/view on image a GCP selected
in the list. Thus the button allows to display the GCP on the images where it was already
measured or may be measured in the future

to open the relative orientation report

s

to load a DEM used to obtain or refine Z coordinate values for GCP from the list (the
status bar in the lower part of the Triangulation points window displays the path to
opened DEM and its name, and there is also the X button allowing to close the DEM).
DEM loaded this way is not displayed in 2D-window, in Layer manager or in Map window

to acquire (extract) Z coordinate from loaded () DEM for GCP selected in the list (if
the DEM is already used in the project, it is loaded automatically)

[only for the “Points measurement” module] to acquire GCP from DEM considering ad-
justment results, i.e. to measure the GC point in marker position on selected images in
the Points measurement module. Coordinates of the GC point are measured using the
following way: X, Y — adjusted coordinates, Z — is taken from DEM (see the description
in Section 4.5)

B

allows to turn on the automatic selection of images, that contain the point’s position: if
the mode is on, click the Ek button or double click the point’s record in the coordinates
list allows to open all images in the Points measurement module, where the coordinates
of the selected point are already measured, otherwise — all images of the block, that
contain the point’s coordinates

to create raster outline of triangulation points
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421

. GCP adding

In order to input GC points coordinates to the GCP list perform the following actions:

1. C

hoose Orientation » GCP list (Ctrl+Alt+G) or click the £# button of the main

toolbar. The Triangulation points window opens on the GCP list tab.

@ Use Ctrl+wheel to quickly scroll through the list (similar to scroll bars). Rotate the mouse

wheel to move through the lines.

2. To add a new GCP to the table click the g* button or use the Alt+Ins shortcut.

@ Editing mode of the table data %] is automatically on.

€ PHOTOMOD e e
Triangulation points [total: 1568 / visible: 10] ®
£ Tie poins

E# S X P un 1% R D AMABIeE

Code Name Type Km Y.m Zm Std. dev. X, m Std. dev. Y, m Std.dev.Z,m  Number of meas.

235 00330101 Ground Control 5803422065 5410576535 479331 01 01 01 2

236 01450007 Ground Control 5803036307 5410806160 475422 01 01 01 2

237 01640010  Greund Control 581368.7599 5410058165 513.552 01 01 01 1

238 01640032 Ground Control 580936.8092 5409090248 490705 01 01 01 2

239 01750031 Ground Control 5808363151 5410912538 520657 01 01 01 2

240 02410031  Ground Control 5804646451 5410072308 482411 01 01 01 2 OK

241 03850029  Ground Control 5808214027 541052741 488,609 01 01 01 2 Cancel

242 04980011  Ground Control 5809413262 5410131408 499344 01 01 01 4

glj 04980069  Ground Control 5814054051 5410505798 520888 01 01 01 1 I&I
([Mew point )2 Ground Control |0 0 0000 02 02 02 0 [ apoy |

\ J

Fig. 48. Adding the new point to the GCP list

Input to the table the following data:

Name — a name of GC point;
Type — point type: Ground control (by default), Check or Excluded;

Excluding a ground control point from the photogrammetric network may be jus-
tified in the following cases:

o For whatever reason, it is not possible to detect and identify this point in the
project images in order to measure the point in the images;

o There are reasonable grounds to assume that the geodetic coordinates of the
point provided to the user contain errors (or are of insufficient accuracy).

The entered geodetic coordinates of a check point are not taken into account in
the process of block adjustment (such a point is processed as a tie point) and
are used only to control the accuracy of the photogrammetric network (to compare
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the geodetic coordinates with those calculated in the adjustment process, see
the ground control and check points accuracy section in the processing report
and the chapter “Brief residuals report” of the “Block adjustment” User Manual).

@ In order to change a point’s type use the *a, *a, *. buttons of the toolbar of the GCP
list tab.

e X,Y,Z-X,Y, Z coordinates of GCP in meters.
@ During adding of new GCP, a default coordinates values are equal to 0 meters.

If some coordinates values are unavailable, and also for excluding of some co-
ordinates valuers there is a possibility to assign a point type: XYZ, Z or XY.

To assign a point XY type use the 8% button. To assign a point Z type use the _2
button. The 242 button is'used to consider all three coordinates of GC point.

% GC points coordinates are specified in coordinate system selected on a step of project
creation (see the “Project creation” User Manual).

The system allows to use Z coordinate taken from DEM. The 2 button is used
for this. In order to load a DEM from project resources, select single or multiple
points and click the .

% If a DEM is already loaded to a project, it will be used automatically.

+ Std.dev. X, Std.dev. Y, Std.dev. Z — values of RMS accuracy by X, Y, Z coordin-
ates (in meters);

* Number of measurements — number of block images where GC point coordinates
are measured (filled in automatically after measurement of GCP coordinates on
images).

On a step of GCP input the Number of measurements column displays 0O value.

§ The system also provides opportunity to performimport of GCP list from a text file.

@ Prior to adjustment it is recommended to measure coordinates of all input GCP or to assign
the Excluded type for points without measurements.

3. Complete input of GCP to the table and proceed to their coordinates measurement
on images (see the Section 4.2.2).
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Code Name Type Xm Y. m Zm Std. dev. X, m Std. dev. ¥, m Std.dev.Z,m  Number of meas.
235 00230101  Ground Control 5803422065 5410576535 479.331 01 01 01 2
236 01450007  Ground Control 580303.6307 5410896169 475422 01 01 01 2
237 01640010  Ground Control 5813687599 5410053165 513.552 01 01 01 1
238 01640032  Ground Control 5809368092 5409696.248 490.705 01 01 01 2
239 01750031 Ground Centrol 5808363151 5410912538 520657 01 01 01 2
240 02410031  Ground Control 5804646451 5410072308 482411 01 01 01 2 OK
241 03850029  Ground Control 5808214027 541052741  4838.608 01 01 01 2 Cancel
242 04980011  Ground Control 580941326 5410131408 499.344 01 01 01 4
243 04980069  Ground Control 5814054051 5410505798 520888 01 01 01 R &J
Mew point 2 Ground Control  580841.326 5410231408 479.344 02 0.2 0.2 ( > Apply

7

7

Fig. 49. A new GC point has been added but not yet measured

For successful adjustment of central projection images block the coordinates of projection
centers of the block images are used or at least three GC points, which coordinates should be
measured on at least two adjacent images of the block. Information about recommended amount
of GC points for blocks of scanner spaceborne images see in the Appendix A.

Editing of entered points coordinates is available in Point properties window.

4.2.2. Measurement of GCP points

After completing of GCP coordinates input (see the previous chapter) it is possible to
measure these GCP on block images in the Points measurement module.

In order to measure GC point coordinates perform the following actions:

1. Open the Triangulation points window on the GCP list tab.

2. Select GC point in the table to measure its coordinates on images and click the Ek
button or double click the point name in the table. The Points measurement
module is opened:
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Code Name Type Xom Yom Zm Std. dev. X. Std. dev. V. m Std.dev.Zm Number of meas.
00330101 Ground Control  580342.2065 5410576.535 479331 01 01 01 2
01450007 Ground Control 5803026307 5410896.169 475422 01 01 01 2
01640010 Ground Control 5813687599 5410059.165 513,552 01 01 01 1
01640032 Ground Control 5809368092 5409696.248 490705 01 01 01 2
01750031 Ground Control 5808363151 5410012538 520657 01 01 01 2
02410031 Ground Control 5804646451 5410072308 482411 01 01 01 2
03850020 Ground Control 5808214027 5410527.41 488.609 01 01 01 2
04980011 Ground Control 580941326 5410131408 499344 01 01 01 4
04980069 Ground Control  581405.4051 5410505.798 520888 01 01 01 1
2 Ground Control ~ 580841.326 5410231408 479344 02 02 02 6 )] [ ety |

Fig. 50. Measurement of GCP on the images in the Points measurement module

If at least three GCP were already measured on block images or there was executed
preliminary orientation in geodetic coordinate system (by projection centers, for in-
stance), the system performs automatic search for corresponding terrain point on
block images (according to XY coordinates) and places marker on this image point.

§ When the system performs a search for terrain point in mode of images automatic selection
(the & button of the Triangulation points window is clicked) it automatically opens all
images that contain the terrain point with measurements or without them, otherwise — only

images that contain measurements of selected point.

To use the improved algorithm for searching for corresponding terrain points, taking
into account GCP elevations, perform the following:

1. Click the [& button on the upper Points measurement module toolbar, to open
the Points measurement settings window;

2. Setthe Correct GCPs position while measurements checkbox.

é Proper functioning of the improved algorithm for GCP position refinement is feasible under
strict compliance with the following conditions:

» The adjustment is performed (see the “Block adjustment” User Manual);
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+ All three GCP coordinates are available see the Section 4.2);

+ At least two point measurements are available in project images.

If GCP measurements or preliminary orientation results are unavailable, click the
[+ button of the upper toolbar of the Points measurement module. Select and
open images and perform a search for terrain point manually.

3. Measure coordinates of GC point on a single or multiple images (the point lies in
the overlap area) using one of the following ways:

* GCP coordinates measurement without correlator is used if a point is located on
terrain and is clearly recognized on all images.

Show by marker the terrain point on images. Click the . button of the upper
toolbar of the module. After measurement of GCP coordinates an information

about the measurement appears in the GCP list (and the point is displayed in
the windows of opened images):

@ PHOTOMOD [
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fox Code Name Type X.m Yom Zm Std. dev. X, m Std.dev.V, m Std.dev.Z m Number of meas.
235 00330101 Ground Control 580342.2065 5410576.535 479331 01 01 01 2
236 01450007 Ground Control  580303.6307 5410896169 475422 01 01 01 2
237 01640010 Ground Control 581368.7599 5410059.165 513.552 01 01 01 1
238 01640032 Ground Control 580936.8092 5409696.248 450.705 01 01 01 2
29 01750031 Ground Control  580836.3151 5410012538 520657 01 01 01 2
240 02410031 Ground Control 580464.6451 5410072.308 482411 01 01 01 2
41 03850029 Ground Control 5508214027 541052741 488609 01 01 01 2
242 04980011 Ground Control 580941.326 5410131.408 499344 01 01 01 4
243 04380069 Ground Control 581405.4051 5410505.798 520388 01 01 01 1
New point 2 Ground Control 580841326 5410231408 479344 02 02 02 Q ) [ aemy |

Fig. 51. Measurements of GCP on the images

» GCP coordinates measurement and transfer with correlator is used if a point is
not clearly recognized on all images.
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1.

In this case measure the point on a single image using the .# button of the
upper toolbar of the image window or use the Ins hotkey.

Define the image as the left using the 'L button in the image window.
Then transfer the point from the left image to other images:

o [optional] use the § button to transfer the point on the image in the active
window;

o [optional] use the &% button to transfer the point on all images opened in
the module.

After the correlation operation the Edit point window opens, that allows to
analyse correlation coefficients and make a decision whether to add a new
GC point measurements (or there is a warning Bad point).

To add a point measurements select images in the list (set appropriate
checkboxes) and click OK, otherwise click the Cancel button.

é Recommended correlation coefficient during GCP transfer is 0.90 — 0.95.

(@ Edit point: 2 ) |

Code Mew point

Mame 2

Image Correlation
Aalen_05~0048_rgb 09006
Aalen_05~0049_rgb 09772
Aalen_04-0114_rgb 09844

QK ] [ Cancel

Fig. 52. The Edit point window

4. After measurement of GCP coordinates an information about the measure-

ment appears in the GCP list (and the point is displayed in the windows of
opened images).

* measurement of coordinates in stereomode is used when the point is located
on high-rised object and/or is not displayed on all images (see the separate
chapters below).
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4.2.3. Editing GC points
In order to find a GCP in the Triangulation points table perform the following actions:
1. Click the #4 button. The Find window opens.

2. Input GCP full name or its part into the Find field, specify a search direction and
click OK.

To move a GCP on images (to edit measurement of selected point) perform the following
actions:

1. Select measured GC point in the table of the Triangulation points module and
click the Ek button or double click the point name in the table to display the meas-
urements of selected point on block images.

2. Show by marker new position for selected GC point.

3. Click the .# of the module upper toolbar. After that the GC point on images is moved
to marker’s position, and measurements data is refreshed in the Triangulation
points table.

@ Editing of entered points coordinates is available in Point properties window.

To delete the ground control point measurements from the image, select the point in
the Triangulation points table and click the @ button of the image window in the
Points measurement module. Confirm deletion of the point measurement in the dialog
box that opens.

( . Question [iE-J-‘

.' g"' . Delete point 2 measurements on image Aalen_04-~0113_rgh?

Yes ] | Mo

Fig. 53. The point’'s measurement deletion on the separate image

To delete the ground control point measurements from all images, perform one of the
following actions:

« select a point in the Triangulation points table and click the 7 button on the upper
toolbar on the Points measurement module. Confirm deletion of point measurements
in the dialog box that opens.
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( . Question Iﬁ )

Delete point 2 measurements on all images?

Yes ] [ Mo

L5 A

Fig. 54. The point’s measurements deletion on all the images

« select a point in the Triangulation points table and click the {i§ button on the toolbar
of the Triangulation points window. The Delete points window opens. Click the
Delete point measurements only button.

i . Delete points ﬁﬁ

| Delete measurments only |

| Delete points from catalogue |

Close

Fig. 55. The Delete points window

The operation does not lead to deletion of GC point coordinates from the Triangulation
points table (see also Section 6.7).

To delete a ground control point completely (both the point measurements on the images
and the point with the coordinates from the table), select the point in the table and click
the i button of the toolbar of the Triangulation points window. The Delete points
window opens. Click the Delete points from catalogue button.
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-
. Delete points

S

Delete measurments anly l

I Delete points from catalogue l

hy

Close

Fig. 56. The Delete points window

To delete all measurements of ground control points, click the 3 button of the toolbar

of the Triangulation points window. The Delete points window opens. Click the Delete
measurements only button.

( . Delete points @w

[ Delete catalogue and measurments I

Close

L8

[ Delete measurments only I

Fig. 57. The Delete points window

To delete the entire ground control points catalogue along with the measurements,
press the ¥ button on the toolbar of the Triangulation points window. The Delete
points window opens. Click the Delete catalogue and measurements button.

( . Delete points @w

[ Delete measurments only I

[ Delete catalogue and measurments I

Close

A

Fig. 58. The Delete points window
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4.3. Automatic ground control points measurement

The system provides for automatic measuring GC points if supplement ground control
data are available, i.e. an orthoimage and DEM, coverage of those considerable coincide
with the terrain showed in the imagery of the project under processing.

Automatic GCP measuring allows to increase the position accuracy according to refer-
ence data and can be performed at various stages of project processing, supplementing
the list of imported (manually measured) GCPs, if available.

This operation is recommended in the following cases:

* In order to improve the accuracy of the results of processing the project, which has
already been subjected to preliminary adjustment, relative orientation of images and,
optionally, import of the GCP list;

@ For example, after automatic tie point measuring and preliminary project adjustment, in case
of central projection project processing.

» Before performing relative and exterior image orientation and project adjustment.
@ Automatic measurement of GCPs at this stage of processing requires significantly more time

(compared to measurements for the adjusted project).

The system also allows to delete adjustment results before searching for ground
control points (see below). In this case, the results of the project adjustment and relative
orientation of the images will be deleted and the GCP search will be performed “from
zero” (as in the second case described above.

@ Imported (measured manually) GCPs will not be removed.

4.3.1. Aerial survey

To measure ground control points coordinates in automatic mode perform the following
actions:

1. Choose Orientation » Automatic GCPs measurements. The GCPs searching
parameters window opens:
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i’ i
’ GCPs searching parameters ﬁ
EESA
DEM
L] &
Orthoimage
() &
GCPs searching parameters
Interpolation cell size 64 =
Standard deviations
Flane: 3.000000 = m
Elevation 5.000000 = m
Correlation treshald 0.750 =
Corresponding point search area 500 1 pix
Maximum vertical parallax: 5.000 1 pix

Saving parameters

Compress intermediate data
) No @ LZW () Deflate @) JPEG 100 |

Mumber of tasks per CPU core 3 =
Correlator configuration. ..
[ uas

7] Delete adjustment results before searching
Delete intermediate data

[ OK ][ Cancel ]

L8 4

Fig. 59. The GCPs searching parameters window

To download, save, and reset ground control points search parameters, the following
buttons are provided:

» = —allows to download the set of search parameters and paths to the input files
from the *.x-1ini file;

« [Py — allows to download only search parameters from the *.x-ini file;
* (% — allows to download only paths to the input files from the *.x-1ini file;

. — allows to save the whole set of parameters in the *.x-1in1i file in the Windows
file system.

2. Select the input Resources in an appropriate tab:
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DEM - click the .. | button to select DEM in active profile resources;
@ Click the [ button to open the Layer selection window and select the source DEM
from the list of DEMs uploaded to the project.

Orthoimage — click the _... | button to select a orthoimage file in Windows file
system.

@ Click the (=% button to open the Layer selection window and select the source image
from the list of ortho images uploaded to the project.

3. Set the following GCPs searching parameters:

Set the interpolation cell size in pixels.

The Standard deviation section allows to set RMS errors on the plane and in
elevation for the used ortho in the appropriate input fields.

% These values are entered by a user, taking into account the characteristics of the input
data.

Correlation threshold is the minimum value of the correlation coefficient to
measure point coordinates in images. Points with correlation threshold below the
specified value are not considered to be added;

The search area (pix) allows to define the area (in pixels of the downloaded ortho)
where a GCP corresponding to the orthophoto point is to be searched;

Maximum vertical parallax is the value of maximum error of GCP mapping in
project imagery and in the downloaded orthophoto (in downloaded orthophoto
pixels).

The Compress intermediate data section allows to set the method and degree of

compression for intermediate raster imagery (imagery in projects, orthophotomaps)
in order to save drive space:

No — files are created without compression;
LZW - the Lempel-Ziv-Welch universal algorithm of lossless compression;
Deflate — the universal algorithm of lossless compression;

JPEG - color image compression algorithm with losses. The quality of the com-
pressed image in percent is set.
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5. Set the number of tasks per CPU core to create several tasks of long processes
per one core. This reduces time required for process execution.

@ Maximum recommended number of tasks is 2 or 3 per core.

6. The additional options button allows to choose additional settings for GCP search:

i . Show,/hide additional settings I,is-,lw
| Autocorrealation control
Minimum number of points on stereopair:  [10 =
[ Ok, ] | Cancel
', 4

Fig. 60. Additional settings for GCP search

* The Autocorrelation control checkbox allows you to define the degree of
autocorrelation, i.e. maximum o value in the gaussoide that places an upper
limit on the mask correlation coefficient distribution in a small area in the same
image. The higher is the o value, the lesser is the probability of correct measure-
ment of points obtained through correlation with the given point as source.

» Approximate final minimum number of points on stereopair after rejection.

7. In case of UAS data processing, it may be necessary to perform additional meas-
urements of tie points in certain areas of the images under processing. For this, set
the appropriate checkbox and click Correlator configuration configure for further
configuring tie point search.

8. To delete adjustment results before searching set the appropriate checkbox;

9. To delete intermediate data when operation is completed, set the appropriate
checkbox.

10. Click OK.

4.3.2. Satellite scanner imagery

To measure ground control points coordinates in automatic mode perform the following
actions:

1. Choose Orientation » Automatic GCPs measurements. The GCPs searching
parameters window opens:
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( ’ GCPs searching parameters ﬁw
EBSE
DEM
| (-]
Orthoimage
=
GCPs searching parameters
Interpolation cell size 64 =
Standard deviations
Flane: 3.000000 = m
Elevation 5.000000 = m
Correlation treshold 0.750 =
Points per stereopair 100 =
Correlation mask halfsize 20 1 pix
Corresponding point search area 500 1 pix
Maximum vertical parallax: 5.000 1 pix
Saving parameters
[ 7] Distributed orthortectification for satellite images
MegaTIFF fragments per task: |1
Maximal fragment size, MB: 512
Compress intermediate data
@ No @ LZw @) Deflate @ IPEG [100 2
Number of tasks per CPU core 3 s
Correlator configuration...
[ Delete adjustment results before searching
Delete intermediate data
[ CK ] [ Cancel ]

Fig. 61. The GCPs searching parameters window

To download, save, and reset ground control points search parameters, the following
buttons are provided:

» L= — allows to download the set of search parameters and paths to the input files
from the *.x-1ini file;

« [By — allows to download only search parameters from the *.x-ini file;

* (Y- allows to download only paths to the input files from the *.x-ini file;

— allows to save the whole set of parameters in the *.x-1ini file in the Windows
file system.
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2. Select the input Resources in an appropriate tab:

DEM - click the .. | button to select DEM in active profile resources;
% Click the [ button to open the Layer selection window and select the source DEM
from the list of DEMs uploaded to the project.

Orthoimage — click the _... | button to select a orthoimage file in Windows file
system.

@ Click the (=¥ button to open the Layer selection window and select the source image
from the list of ortho images uploaded to the project.

3. Set the following GCPs searching parameters:

Set the interpolation cell size in pixels.

The Standard deviation section allows to set RMS errors on the plane and in
elevation for the used ortho in the appropriate input fields.

% These values are entered by a user, taking into account the characteristics of the input
data.

Correlation threshold is the minimum value of the correlation coefficient to
measure point coordinates in images. Points with correlation threshold below the
specified value are not considered to be added;

Points per stereopair input field allows to set the number of GCPs for measure-
ment;

The resulting number of measured GCPs may be both more than the set number due
to point transfer from neighboring pairs, and less due to further rejection.

Correlation matrix half-size (pix) input field allows to define the size of a correl-
ation matrix in downloaded orthophoto pixels by X and Y axes (input value multi-
plied by 2).

The search area (pix) allows to define the area (in pixels of the downloaded ortho)
where a GCP corresponding to the orthophoto point is to be searched;

Maximum vertical parallax is the value of maximum error of GCP mapping in
project imagery and in the downloaded orthophoto (in downloaded orthophoto
pixels).
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4. The Distributed orthorectification for satellite images checkbox allows to in-
crease the system performance in case of very large amount of source images
(more than 2 Gb). Otherwise, the use of this option is not expedient.

* The number of MegaTiff fragments per task and Maximal fragment size (Mb)
are also displayed here (obtained by the automatic calculation);

5. The Compress intermediate data section allows to set the method and degree of
compression for intermediate raster imagery (imagery in projects, orthophotomaps)
in order to save drive space:

* No —files are created without compression;
* LZW - the Lempel-Ziv-Welch universal algorithm of lossless compression;
» Deflate — the universal algorithm of lossless compression;

* JPEG - color image compression algorithm with losses. The quality of the com-
pressed image in percent is set.

6. Setthe number of tasks per CPU core to create several tasks of long processes
per one core. This reduces time required for process execution.

@ Maximum recommended number of tasks is 2 or 3 per core.

7. The additional options button allows to choose additional settings for GCP
search:

@ Show/hide additional settings [

| Check correlation by reverse stereopair

| Autocorrealation control
| Search contrast point

Tries per point: 100

Lld Ak

Minimum number of points on stereopair: 10

[ oK l | Cancel |

Fig. 62. Additional settings for GCP search

* The Check correlation by reverse stereopair checkbox allows to check the
results of point search on the reverse stereopair. If the results do not coincide,
the point is removed,;

* The Autocorrelation control checkbox allows to define the degree of autocor-
relation, i.e. maximum ¢ value in the gaussoide that places an upper limit on the
mask correlation coefficient distribution in a small area in the same image. The
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10.

44

higher is the o value, the lesser is the probability of correct measurement of points
obtained through correlation with the given point as the source;

* The Search contrast point checkbox is to search GCPs in the most contrast
areas (in the images with clear object contours);

» Tries per point is the number of attempts to search the appropriate point having
the correlation coefficient above a value specified in the search area;

» Approximate final minimum number of points on stereopair after rejection.
To delete adjustment results before searching set the appropriate checkbox;

To delete intermediate data when operation is completed, set the appropriate
checkbox;

Click OK.

. Transfer GCP from georeferenced external data

4.4.1. The “Map” window

Georeferenced external data (raster and vector maps, DEMs, and web-maps) for the
same terrain as project images, are used as a basis to obtain GCP coordinates and
measurement of the GCP on project images.

A\
ey

In order to use all features of the Map window it is recommended to work with georeferenced
block scheme, i.e. it is necessary to have already measured GCP available on project images
(two, at least) or block layout created using exterior orientation data (see the Section 2.2).

The system also allows to georeference raster data located in Windows file system (see the
“Raster data georeference” chapter in “Orthophotomaps creation” User Manual).

General workflow on GCP transfer includes the following steps:

1.

2.

Load of georeferenced data (see Section 4.4.2);

Selection of terrain point on the map and search for the point on project images
(see Section 4.4.3);

Transfer the point from the map — add/measure of point’s coordinates on project
images (see Section 4.4.4;

[optional] Editing of the GC point (see Section 4.4.5, and also Section 4.2.3, Sec-
tion 6 and Section 5.4.3).

Main purpose of the Map window — load of georeferenced data (raster and vector maps

and

DEMs) in order to use them for adding GC points and measurement their coordinates
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on project images. To open the Map window, open the Points measurement module
and click the = button of the main module toolbar.
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Fig. 63. The Map window
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Fig. 64. Expanded Map window with loaded data
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By default, all data opened in 2D-window is displayed in working area of the Map window.
Besides, if there is georeferenced block scheme the Triangulation points layer is created,
and work with it is synchronized with windows of images opened in the Points meas-
urement module.

In the right part of the Map window there is the Layer’s Manager used to manage these
data and navigation window for fast move to needed part of the map. There is a toolbar
in the top of the window.

In the status line of the Map window the marker’s position coordinates on the georefer-
enced map are shown.

Itis possible to move the whole image in the working area of the Map window in panning
mode by moving mouse with pressed left button along with holding pressed the Alt key.

In the bottom of the working area of the Map window there is the panel used to setup
brightness, contrast and gamma-correction of the image shown in the working area.

5 The Shift+F8 shortcut allows to hide the brightness setting panel.

@ In order to return to default settings of brightness and contrast, right click the settings panel and
select Reset.

@ Settings of brightness, contrast and gamma-correction are not restored after the module restart.

Table 6. The Map window toolbar

Button Functions
= to open a window used to select a raster map file located out from profile re-
sources, which have one of the raster formats supported by GDAL library
) to open a window used to select a vector map file located in active profile re-
sources
= to open a window used to select a file of DEM located in active profile re-

sources to obtain Z coordinates for measured GC points

to open a window used to select a source of geospatial data of WMS format
and to load web-maps, located on specified area

i [for georeferenced block scheme only] to find marker position in windows of
opened images of the Points measurement module (the button action is
duplicated by double mouse click) — allows to perform automatic search for a
placement of marker specified on the map on images opened in the module

m to perform a search of a terrain point specified on the map by marker on all
project images — after that windows of those project images where the point
was found are opened in the Points measurement module (the button action
is duplicated by Shift + mouse double click)

i to add a GC point on opened images of the module without correlation, i.e.

to transfer a point with coordinates from the map to a terrain point specified
by marker on selected images. The added point is displayed on images and
in the list of triangulation points of the Points measurement module
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Button Functions

i to open a window used to add and measure GCP coordinates with correlation
to search corresponding points on projectimages, and to use a DEM to acquire
Z-coordinate (see the Section 4.4.4)

am to move the view area in any direction

+ to use the marker=mouse (F4) mode of working area

T2 to use the Fixed marker mode (F6) — when marker is always at the center
of the screen and mouse moving results in the image moving

2] to center image in working area by marker (F7)

o to show/hide service windows, located to the right from the working area:
Layer manager and navigation window

o to show/hide navigation window only (navigation window is hidden by default)

= to show/hide scroll bars

AR

to manage a zoom of the whole image of the window working area. The

= field is used to display a current zoom, and allows to change
the zoom using the slider (see the “Image scaling in 2D-window” chapter of
the “General information” User Manual). The default scale is 1:1

4.4.2. Prepare and load georeferenced data (maps)

The system supports using of the following georeferenced data: raster maps, vector
maps, DEMs, and web-maps to acquire GCP data.

é Loaded external georeferenced data are restored during next module session, but removed
from memory during log off from the system.

Prior to use georeferenced maps and DEM (briefly: maps) perform the following actions:

1. Prepare the input data in the following way:

« for raster data specify a folder out of active profile resources to place a raster
format file supported by GDAL library and georeference file with the same name.

@ The need for a separate georeference file depends both on the raster file format on the
whole and characteristics of a particular file, due to its origin.

Thus, for example, GeoPDF and GeoTIFF images initially contain georeference data,
what, however, is not true by default for an arbitrary file with *. pdf or *. tiff extensions.

In turn, formats of some images (for example, *.bmp) do not provide for including geor-
eference data and require obligatory separate georeference files.

The system allows to georeference scanned cartographic raster material using points
with known geodetic coordinates (see the “Raster data georeference” chapter in “Ortho-
photomaps creation” User Manual).
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4.

5.

 for vector data and DEM perform their import to files of interior format of the
system (*.x-data and *.x-dem correspondingly) and save them to the folder in
active profile resources. See a description of the vector data and DEM import in
the “Vectorization” User Manual.

@ The system provides possibility to import vector objects from the GeoPDF georeferenced
raster file (if such data is available in current GeoPDF file, see more in “Import from
GeoPDF” chapter of “Vectorization” User Manual).

Open the Points measurement module.

Click the button of the top module toolbar. The Map window opens. In the
working area of the Map window the data loaded during work in 2D-window is dis-
played.

[optional] Click the [l button to display a list of layers and to manage them.

Load georeferenced map, using one of the methods listed below.

To load a raster map to a project perform the following actions:

1.

2.

Click the £ button. The Loading images window opens.

Select a raster map file and click the Open button. The Load georeferenced images
window opens.

[optional] Re-calculate coordinate system of the raster map to bring it in correspond-
ence with the project coordinate system. If there is a background color on the edges
of the map, specify the background color and define the color transparency.

Click OK. New georeferenced raster layer appears in the Layers manager and
loaded raster map is displayed in the Map window working area.

To load a DEM to a project perform the following actions:

1.
2.
3.

Click the (2 button. The Open window opens.
Select DEM file in active profile resources and click the Open button.

New DEM layer appears in the Layers manager and loaded DEM is displayed in
the Map window working area.

To load a vector map to a project perform the following actions:

1.

Click the (=" button. The Open window opens.
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Fig. 65. Parameters of vector map loading

2. Select vector map file in active profile resources.
3. [optional] Recalculate coordinate system if necessary.

4. Click the Open button. New vector layer appears in the Layers manager and loaded
vector map is displayed in the Map window working area.

Perform the following actions to load a web-map to a project:

ﬁ Web-map loading is possible for georeferenced block scheme only.

1. Click the &) button.

2. [optional] During the Load web-map window first launch, the Parameters window
opens at first:
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P
. Parameters

=

Map cache location

C:'\PHOTOMODS, VAR \MapCache

Cache expire time (hours), 0=store permanently 0
Timeout waiting for server reply (s) 30
Time till retry after server timeout (s)
[7] connect through proxy server

Address and port |http:ff127.0.0.1:8080

a00

... ]

|k

4|

4|

* Rosreestr — cadastral map of Russia produced by The Federal Service for State
Registration, Cadastre and Cartography (Rosreestr).

o Base Map — basic geography map;

o Cadastre Map.
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Fig. 66. Parameters of web-map loading
3. [optional] Setup parameters of the web-map loading.
4. Click OK. The Load web-map window opens.
. Load web-map @
Source Limits in working coordinate system
> Rosreestr N £5589108.09 +| m
! gpenStreetMap W 2583474.20 m E 2593570.45 m
> RosCosmos
> ESRI emagery basemap 5 6579114.57 Him
Reproject
@ Auto {reproject into project working coordinate system)
") Mone (use coordinate system of the web service)
) Reproject into coordinate system:
OK ] [ Cancel ]
Fig. 67. Parameters of web-map loading
5. Inthe Source list select a source of georeferenced data of WMS standard:




PHOTOMOD 8.1 Aerial triangulation (Windows x64)

* OpenStreetMap (OSM) — non-commercial free world map;
* RosCosmos;

* ESRI.

[optional] Define a working area to load a web-map.

In the Reproject section define a coordinate system of loaded web-map using the
following way:

* Auto — automatic transformation to coordinate system of a project;
* None — use coordinate system of the web-service;
* Reproject into coordinate system and specify necessary coordinate system.

Click OK. New vector layer appears in the Layers manager and loaded map is dis-
played in the Map window working area.

4.4.3. Search for GCPs from map on project images

To transfer GC points from a map to a project it is necessary to find these points on
project images. To do this perform the following actions:

1.

Prepare the georeferenced data, open the Points measurement module, open
the Map window, load the georeferenced data to the map window;

Select specific terrain point on a map in the Map window and place marker on this
point.

Specific terrain point — a terrain point which is clearly visible in comparison with other terrain
objects: it has good contrast, sharpness, is distinguished by color and shape.

Find this terrain point on project images in the Points measurement module.

§ Search for corresponding terrain point on images depends on availability of some project
data.

* [optional] If there no measured GCP and exterior orientation data available in the
project perform the following actions:

1. Inthe Points measurement module click the & button of the upper toolbar.

2. Select and open those project images that contain the terrain point specified
in the map.

3. Find this point manually and show it on project images using marker.
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* If the project contains at least 2 measured GCP and/or exterior orientation para-
meters are used for block layout creation, use the following synchronization tools
to perform search for the terrain point on project images:

o for automatic search for the point on project images opened in the Points
measurement module click the i} button in the Map window. Define the point
position more exactly using marker, if necessary;

o to perform automatic search for the point on all project images and to open in
the Points measurement module just those images where the point is found,
and also with marker positioning, click the button in the Map window. Define
the point position more exactly, if necessary.

§ The system also provides reverse synchronization, when it is searching on the map for
the terrain point specified on the image. To do this place marker on the image point in
the active window of the Points measurement module, and then click the &j Find on

map button of the main toolbar of the module.
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Fig. 68. Search for GCP from a map

4.4.4. Transfer GCP from map

To transfer selected GCP from map, i.e. to add/measure coordinates of found point on
project images, the system provides the following features:

» adding GCP without use of correlator;
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» adding GCP using correlator (in case a raster image is used as reference data).

§ To use correlator it is necessary to have already measured GCP in a project and/or exterior
orientation parameters along with created block layout using these parameters. Besides,
during adding a GCP using correlator there is a possibility to use DEM to obtain a value of

point’s Z-coordinate.

Adding GCP without use of correlator
To add GCP from a map of any type, without correlator perform the following actions:

1. Load raster or vector map (see the previous chapters);

§ The system allows to use multiple raster and/or vector maps at the same time.

2. Make the maps layer active in the Map window.

3. Use marker to match terrain points on the map in the Map window and on project
images in the Points measurement module (see the previous chapter).

4. Click the & Add point without correlation button in the Map window. The New
GCP window opens:
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Fig. 69. The Points measurement module, the Map and New GCP windows
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5. The New GCP window, in this case, is intended to view/edit coordinates of selected
terrain point on a map and to select the images of the project where a new GC point

will be added.
I N
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Fig. 70. The New GCP window (adding point without use of correlator)

To add a new GCP perform the following actions:

1.

2.

Input a name of a new point to the Name field.

Select coordinates to be transferred during point adding, using the appropriate
checkboxes (XY or XYZ).

% A correct value of Z coordinate is available when DEM is used.

To add/measure GCP coordinates on selected images click one of the buttons
located at the bottom of the window.

Buttons Functions

Add point with measurements to add new GCP with its coordinates to the tri-
angulation points list and to measure it on se-
lected images

Add point without measurements to add new GCP with its coordinates to triangu-
lation points list without its measurement on
selected images
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Adding GCP using correlator

To add GCP from raster map using correlator perform the following actions:

1.
2.

5.

Load raster map (see the previous chapters).

Make raster layer active in the Map window. If there is a DEM available, load in to
the Map window to obtain Z coordinate.

Specify a terrain point on the raster map using marker. Click the i Find on all
images button in the Map window (or in the Points measurement module) to open
all project images contains this terrain point in the Points measurement module.

Click the . Open tool panel for adding GCPs from map button in the Map window
or in the Points measurement module. The Add GCPs from map window opens.

7

When the Add GCPs from map window is opened it is possible to work both in the Map
window and in the Points measurement module.

& PHOTOMOD

F

QRO AE «=» ¢t $0 BRS-$BE &2 8 ¢ i Wi b SE)EE B !

IR ERE

QAQAGRE & A8 G [T

Balen_04-0114_igh!

(D 11 (5504.6872,11808.7638)-(21 0622 mm,58 7672 mm)

X

aaeaqE &~

Aalen_04~0115_1gb

@ Add GCPs from map

[ESEE TR

isize [V Auto/ |10

halfsize
(7] Contrast point search area

100

12

0.0

@ 12 (2572.3922,11770.3935)

R BAE | F DG

Adlen_05-0043_igb)

(0 11 (1676.4662,11800.3175)-(-25.9564 mm 58,6658 mm)

aqeam &~

#alen| @ PHOTOMOD

Triangulation points [total: 1567 / visible: 1210]

S0 B vYEY & @@ %

uuuuu

0 @ t w

MaxY-par  MaxExy MaxEz

——[= -@HJEIJ’B

- 1000 1155
- 1000 0215

580625822037 w; 5410269, 268430 w; 450.0000 | WGS B/UTMIZN

Fig. 71. Transfer of GCP from a map

In the Raster layer for correlation drop-down list select active layer of raster map.
In the DEM layer for obtaining Z drop-down list select a DEM layer (if any).
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Fig. 72. The Add GCPs from map window

§ To refresh a list of layers use the [£] button.

6. [optional] Click the ¥ button. Setup the following correlator parameters:

+ set the Auto checkbox to define the GSD automatically, or input pixel size value
manually;

+ specify the Search area of corresponding point on image in meters, the default
value is 100;

+ specify the Correlation mask halfsize by X and Y axes (pix), the default value
is 12;

+ set the Contrast point search area checkbox and specify a size of the area in
meters (the default value is 10), where the system will search for the point with
maximal contrast;

ﬁ Itis necessary to define more precisely this area size to process data with big monochro-
matic areas.

ﬁ When measuring points in low contrast areas it is recommended to set 0 value (for ex-
ample, when maximal contrast corresponds to forested areas, where there are good
chances of correlator errors).

+ specify the Correlation threshold — minimal value of correlation coefficient for
points coordinates measurement (0.8, by default). Points that have correlation
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threshold below specified value are not considered during adding (the Bad point
warning appears).

@ Correlation threshold is defined considering source data quality.

7. To add GCP using correlator it is possible to use the following buttons of the Add
GCPs from map window toolbar:

% Make sure, that the Raster layer for correlation is active in the Map window.

75 Correlate and move marker — allows to search for corresponding point on
opened images of the Points measurement module using correlator. In case of
successful correlation marker is moved to the found point, otherwise, the Bad
point warning appears;

B Add point with correlation on the active image — allows to add/measure
GCP coordinates on image in active window of the Points measurement mod-
ule —in other words, to search for corresponding point on image in active window
using correlator. In case of successful correlation marker is moved to the found
point and the New GCP window opens, otherwise, the Bad point warning appears;

F# Add point with correlation on all images — allows to add/measure GCP
coordinates on all images opened in the Points measurement module —in other
words, to search for corresponding point on all opened images. In case of suc-
cessful correlation marker is moved to the found point and the New GCP window
opens, otherwise, the Bad point warning appears;

# Add point without correlation — allows to “quickly” add a GCP without cor-
relation to a marker position on image in the Points measurement module (see
above the first part of the current chapter).

The New GCP window, in this case, is intended to view/edit coordinates of selected
terrain point on a map, and to analyse correlation coefficient and to select the images
of the project where a new GC point will be added.
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Fig. 73. The New GCP window (adding point using the correlator)

To add a new GCP perform the following actions:

1. Input a name of a new point to the Name field.

2.

checkboxes (XY or XYZ).
3.

to add GCP.
4.

Select coordinates to be transferred during point adding, using the appropriate

A correct value of Z coordinate is available when DEM is used.

Estimate correlation coefficient shown in the table and select images, where

To add/measure GCP coordinates on selected images click one of the buttons
located at the bottom of the window.

Buttons

Functions

Add point with measurements

to add new GCP with its coordinates to the tri-
angulation points list and to measure it on se-
lected images

Add point without measurements

to add new GCP with its coordinates to triangu-
lation points list without its measurement on
selected images

4.4.5. Editing transferred GCPs

7

See also Section 4.2.3, Section 6 and Section 5.4.3.
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To edit the already transferred GC, do the following:

1. Selectthe pointin GCP list tab, in Triangulation points window, in opened Points

measurement module;

2. Click the Hj button in the Map window. The Edit point window opens:
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| Close |

Fig. 74. The Edit point window

3. The Edit point window, in this case, is intended to view/edit coordinates of selected
terrain point on a map and to select the images of the project where a new GC point

measurements will be added.

To add/measure GCP coordinates on selected images click one of the buttons

located at the bottom of the window.

Buttons

Functions

Add point with measurements

to add new GCP with its coordinates to the trian-
gulation points list and to measure it on selected
images

Add point without measurements

to add new GCP with its coordinates to triangula-
tion points list without its measurement on selec-
ted images

Replace GCP with measurements

to replace coordinates of selected GCP in the
triangulation points list and to re-measure it on
images

Replace GCP coordinates

to replace only coordinates of selected GCP in
the triangulation points list without editing of
measurements on images

Replace measurements only

to re-measure selected GCP on images in the
triangulation points list without coordinates refresh
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4.5. GC point transfer from DEM considering adjustment data

? A description of GCP transfer from georeferenced map (raster or vector map, as well as DEM
of the same terrain, where project images are acquired) see in the Section 4.4.

GC points transfer from DEM considering adjustment data is performed only for the
projects of the Space scanner survey type, adjusted by metadata, when it is necessary
to improve a block scheme in case of discrepancy of nadir and off-nadir images. Namely,
to improve results of adjustment (to refine Z coordinate) by DEM using GCP coordinates
measurement.
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Fig. 75. DEM of the same terrain, where scanner project images are acquired

To transfer a GC point from DEM considering adjustment data perform the following
actions:

1. Open the Points measurement module.

2. Click the &1 button of the Triangulation points window toolbar to go to the GCP
list tab.

3. Click the (2 button to load DEM. Select a file containing DEM and click OK. The
status bar in the lower part of the Triangulation points window displays the path
to opened DEM and its name, and there is also the X button allowing to close the
DEM:
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Fig. 76. The status bar in the lower part of the Triangulation points window

ﬁ If a DEM is already loaded to the system, it will be used automatically.

% DEM loaded this way is not displayed in 2D-window, in Layer manager or in Map window.

4. [optional] Click the E& button of the upper toolbar of the module to open the needed
image to transfer a point from DEM.

5. Show the location of a new GCP on images by marker.
6. Perform one of the following actions:

« Click the £E button of the Triangulation points window toolbar to add a new GC
point, (which coordinates are calculated by DEM and adjustment data) on the
image opened in the active window;

« Click the £E button of the Triangulation points window toolbar, holding pressed
Alt key, to add a new GC point, (which coordinates are calculated by DEM and
adjustment data) on all images opened in the module.
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7. The New GCP window opens. In this case, is intended to view/edit coordinates of
selected terrain point and, optionally, to select the images of the project where a
new GC point will be added.
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Fig. 77. The New GCP window

To add a new GCP perform the following actions:
1. Input a name of a new point to the Name field.

2. Select coordinates to be transferred during point adding, using the appropriate
checkboxes (XY or XYZ).

3. To add/measure GCP coordinates on selected images click one of the buttons
located at the bottom of the window.

Buttons Functions

Add point with measurements to add new GCP with its coordinates to the tri-
angulation points list and to measure it on se-
lected images

Add point without measurements to add new GCP with its coordinates to triangu-
lation points list without its measurement on
selected images

8. A new GC point arrears in the list of the Triangulation points window.
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5. Relative orientation of images

5.1. Relative orientation workflow

One of the stages of building a triangulation network is images relative orientation, that
requires measured coordinates of tie points.

Tie points — the same points on the terrain on adjacent block images needed to build
single models from stereopairs and then to merge them into triangulation networks.

After measurement of tie point coordinates it is necessary to perform relative orientation
of block images, to input and measure GCP coordinates, to perform network adjustment
and to obtain exterior orientation parameters of a block.

Measuring of tie point coordinates — is stereoscopic measurement, i.e. measuring of
coordinates of the same point on both stereopair images at once (or on multiple over-
lapped adjacent images) in stereomode.

Measuring of tie point coordinates on two images of a stereopair in manual mode is
performed in the system using one of the following ways:

* manual measuring of point coordinates on each of stereopair images;

* manual measuring of point coordinates on a single image and transfer it to another
image using correlator;

* manual measuring of point coordinates on each image in stereomode;
 search of a point and measuring its coordinates on image using correlator.

The system also allows to measure tie points coordinates on block images in fully
automatic mode.

ﬁ During removing images from a project it is strongly recommended to synchronize data in the
project in order to remove unnecessary results of orientation. To do this choose Project > Syn-
chronize.

The following recommendations should be considered during tie points measurement:

 to perform relative orientation it is recommended to combine two methods — first ex-
ecute automatic measurement with “bad” points filtering and than manual mode for
editing of measurements acquired in automatic mode and adding of new tie points
(to accumulate measurements that allows to increase relative orientation accuracy);

» when using only manual procedures for tie points measurement, the optimal way is
measuring at least 2 tie points in 6 standard zones for each stereopair in a strip;
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Fig. 78. Recommended zones to measure tie points coordinates in strips

+ in order to consolidate images strips into a block it is recommended to measure tie
points coordinates in inter-strip overlap zones on both sides in relation to a midline

of inter-strip overlap area.

7

Fig. 79. Recommended location of tie points in inter-strip images overlap areas

If block adjustment is performed using independent models method, it is necessary to transfer
inter-strip tie points to at least one adjacent image in each strip. Otherwise they will be not
taken into account when using this type of block adjustment (see the “Block adjustment” User

Manual).
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5.2. The “Points measurement” module

5.2.1. General information about module

In order to measure coordinates of triangulation points (tie, check and GCP) in manual
mode and editing points coordinates with errors obtained after automatic measuring of
tie points coordinates, the system provides the Points measurement module.

@ The module allows to automatically calculate parameters of images interior orientation when
measuring tie points coordinates.

The Points measurement module is used on the following steps of data collecting for
aerial triangulation operation:

* input and measurement of GCP coordinates;

@ Automatic selection of images for non-measured GCP in the Points measurement module
is performed after measurement of coordinates of first two-three GCP on block images or
when preliminary exterior orientation is performed in geodetic coordinate system (by projection

centers, for instance).

* measurement of tie points coordinates on block images entirely in manual mode and
performing of images relative orientation;

+ editing of tie points position to fix errors obtained after automatic measurement of
points coordinates;

+ editing of triangulation points to fix errors obtained on step of block adjustment (see
the “Block adjustment” User Manual);

* measurement of tie points coordinates to estimate accuracy by Y-parallax after import
of exterior orientation data.

The following items of the Orientation menu and buttons of the AT additional toolbar
are used to start the Points measurement module:

« @8 Open selected images for measurement — allows to launch the Points meas-
urement module and automatically open block images selected in 2D-window in the
module;

« @8 Open images containing marker — allows to launch the Points measurement
module and automatically open in the module all images that contain marker position
in 2D-window;

« 00 Open in-strip stereopair — allows to launch the Points measurement module
and open two images of selected in-strip stereopair;
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? If just one image is selected in 2D-window, neighboring right image in a strip will be opened
by default. If the last image in a strip is selected, image to the left of the selected will be
opened.

« 5 Open inter-strip stereopair —allows to launch the Points measurement module
and open two images of selected inter-strip stereopair.

? If just one image is selected in 2D-window, neighboring lower image in a strip will be opened
by default. If selected image is in the outermost strip, the top image on the selected will be
opened.

The Points measurement module represents a set of two windows — the main Points
measurement window and the Triangulation points window. The main Points
measurement window displays selected images in separate windows and contain tools
used to perform triangulation points measurement. The Triangulation points window
is a catalogue of all triangulation points along with their measurements data and contains
tools for work with points catalogue.
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Fig. 80. The Points measurement module
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A work in the Points measurement and Triangulation points windows is synchronized
in the following way:

» when choosing a triangulation point on one of the images using mouse double click
the system automatically starts search for selected point on the opened images of
the module and search of appropriate point on the terrain, if the point is not measured
on the image. Besides, the point will be also automatically highlighted in the triangu-
lation points catalogue;

* when choosing a triangulation point in a catalogue using mouse click the point will
be shown on opened images of the module automatically, if the point is measured
on these images and/or a search of appropriate point on the terrain, if the point is not
measured on opened image;

« when choosing a triangulation point in a catalogue using mouse click and by the £k
button or by double mouse click the system allows two ways of displaying, depending
on the Automatically choose images containing pointiZ mode (see the Sec-
tion 5.2.2):

o all images where the point is measured are opened automatically, if the Automat-
ically choose images containing point & mode is turned off;

o allimages where the point is measured and/or could be measured (marker is located
to the place or probable measurement) are opened automatically, if the Automat-
ically choose images containing point i mode is turned on.

« filtering of display of different points types in catalogue and on opened images is also
synchronized.

5 When the module is launched marker is placed to estimated position of the point.
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Fig. 81. Search for a point on terrain with measured coordinates and without measured coordinates

After measurement of coordinates of each new tie point images relative orientation (Y-
parallax on measured points) is performed automatically.

For viewing results of relative orientation the system provides the following features:

» the button of the Triangulation points window toolbar is used to view relative
orientation report for the whole images block in the read-only mode. The report is
opened after defining of the report parameters;

» the [E button of the Points measurement upper toolbar allows to view relative ori-
entation report only forimages opened in the module. The report is opened considering
default or defined previously report parameters;

5.2.2. The “Points measurement” window

The main window of the Points measurement module is used to measure/edit triangu-
lation points on project images with or without correlator, in mono or stereo mode.

The Points measurement window contains the following interface elements:
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+ the main toolbar used to apply different operations to all opened images consists of
the following panels:

o the upper panel contains buttons used to manage images zoom, images selection
for measurements, measuring/editing of triangulation points coordinates, transfer
of GCP from georeferenced maps, setup of triangulation points symbols and
common parameters;

o the left toolbar contains buttons used to manage display of triangulation points and
residuals vectors in all images windows.

» windows of opened images, each of them display an image and its name, and contains
its own toolbar and status bar.

ﬁ Setting of the Points measurement and Triangulation points window size is preserved after
reboot of the module/system.

During triangulation points measurement in the Points measurement window the fol-
lowing concepts are used in the system:

* The active image — image displayed in the window selected by mouse click on image
window. The active image window is highlighted by blue frame;

* The “left” image — a status assigned to one of opened windows, that is considered
during stereopair opening and is used to correlate other images with this one during
measurement of tie points using correlator.

§ To define one of opened images as a “left” one, click the |L button located in the toolbar of
this image. To define an active image as a “left” one click the 'L button of the upper toolbar
of the Points measurement window.
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Fig. 82. The main window of the Points measurement module
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If in-strip or inter-strip stereopair is opened, a “square” in the middle of the Points
measurement window allows to setup relative location of main windows of images and
lens-windows.

§ Changed position of the Points measurement and Triangulation points windows is re-
membered by the system and restored at the module next launch.
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Fig. 83. Interstrip stereopair in the Points measurement module

The system provides opportunity to transform images during displaying in the opened
windows of the Points measurement module. The transformation influences on images
display and on measurement of points coordinates using correlator.

To choose a transformation type, click on the arrow to the right of the &3 button. Opened
menu contains the following items:

* No transform — allows to cancel images transformation (images are shown without
rotation);

* Rotation by block scheme 90° multiple — allows to rotate images by images rotation
angle, which occurs during block forming in 2D-window, rounded to the nearest angle
multiple of 90°;

* Rotation by block scheme, exact — allows to rotate images by images rotation
angle, which occurs during block forming in 2D-window;

» Block layout: rotation — allows to rotate images according to block scheme;

* Block layout: scale and rotation — scale and rotation are used during transformation
according to block scheme;
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» Block layout: projective transform — image projective transformation is used during
transformation exactly in the same way as on block scheme;

* Image scale — allows to change basic scale of images for correlator (the same scale
is used during images display 1:1).

Table 7. Upper toolbar of the Points measurement window

Buttons Functions

& EL 8 & E |standard buttons of images management in all opened windows with images at
once

== 4 4 to display the next image in a strip (to “flip” images in opened windows) to the left
or right by one image in a strip, up/down by one image in adjacent strips

KT to return to previous or to pass to next marker position during image change in the
Points measurement window

fehi to place image windows across the width of the Points measurement window, i.e.
to “fill out” a screen with windows if some of them were closed

B to open the Add images window used to select images and add them to new win-
dows of the Points measurement module

i) to choose images transformation mode during their display in the Points measure-
ment window

Sk to turn on automatic refresh mode of a block scheme as a points coordinates are
measured (the mode is turned off by default). Automatic refresh of a block scheme
applies only to images opened in the Points measurement module, i.e. The local
block scheme is refreshed

to open a new stereo window containing stereo image of selected images pair
where it is possible to measure points coordinates in stereo mode

i is used to display images as a color or black-and-white one
+
Ll

to add a tie point to marker position on all opened images without correlation
(marker is positioned manually on all images)

A to change position of selected in a list point on images and to add the point to
marker position on images where it was not measured

.Y to move a point along tie residual vector on all images. To display tie residuals
vectors on images the & button of the leftward toolbar is used

Fes to move a point along GCP residual vector on all images. To display GCP residuals
vectors on images the {5 button of the leftward toolbar is used

ir to remove coordinates measurement of selected point on all images

i to open the Delete point measurements window used to specify criteria of selection
points to be deleted

o to synchronize marker on all images (C), so the system tries to place marker on all
opened images to the terrain point shown by marker on active image (requires
creation of block layout). The more data is considered during block layout creation,
the more accurate is marker positioning

e to open a stereo pair consisting of the “left”image and active image as a rightward

)

to correlate the active image with the “left” one to add a new tie point using correl-
ator (see the Section 5.4)
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Buttons Functions
= to correlate all opened images with the “left” one to perform measurement of new
tie point coordinates using correlator
R to calculate correlation coefficient (Q) of all opened images with the “left” one and
to show a value of correlation coefficient in a status bar of each opened image (in
the “left”image status bar the auto-correlation coefficient value is shown)
to open the relative orientation report for opened images (the report will consider
default settings or previously set parameters)
el to open the Map window used to load georeferenced map (vector, raster map or
DEM) to transfer GCP from them on image opened in the Points measurement
module
& to find on georeferenced map opened in the Map window, terrain point pointed by
marker on the active image of the Points measurement window (see also Sec-
tion 4.4)
-4 to open the Add GCP window to transfer GCP from georeferenced map opened
in the Map window on image opened in the Points measurement module
£l to configure image metadata display in the windows of open images (for scanner
images only)
| to show/hide toolbar on all images windows
= to show/hide status bar on all images windows
T to open the Marker settings window used to setup shape, size and color of marker
P to open the Symbols window used to setup symbols used to display measured
triangulation points according to their type
to open the Points measurement settings window to specify correlator paramet-
ers and setup of automatic display of report on relative orientation after clicking OK
in the Points measurement module
L to specify the active image as the “left” one
Table 8. Leftward toolbar of the Points measurement window
Buttons Functions
> to show/hide all measured triangulation points in opened images
5 to display all triangulation points measured in opened images using symbols, spe-
cified according to their type in the Symbols window
a to display names labels of triangulation points measured in opened images
i to display models by ties in symbols display mode of triangulation points. An addi-
tional “angle” elements are added to a tie point symbol indicating a connection with
the adjacent images (to the right and/or left). For example, to triplet point symbol
the angle brackets will be added to the left and right
45 [only after Block adjustment] to display GCP residuals vectors
A [only after Block adjustment] to display tie residuals vectors
= to turn on/off a filter of triangulation points display on opened images according to
settings made in the Points filter window
T to open the Points filter window used to choose triangulation points type to by

shown in opened images and in catalogue of the Triangulation points window

bk

to display ground control points in windows of opened images
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Buttons Functions
i3] to display overlap areas of project images as frames in windows of opened images
& to display overlap areas of project images as filled polygons in windows of opened

images ([ mode should be enabled)

5o to display 6 standard zones, recommended to be used for measurement of tie
points coordinates (see the Section 4)

5.2.3. Windows of opened images

Each of project images opened in the Points measurement module is displayed in a
separate window.

One of the images windows is the “left”, another is active. The “left” window may be
also an active window at the same time. Images shown in the “left” and active windows
are used for correlation during tie points measurement, and also for selecting a stereopair
to be opened in a stereo window to perform measurements in stereo mode.

At launch of the Points measurement module images containing selected point are
opened in viewing windows automatically. It is also possible to perform automatic
choosing of images containing selected point in the triangulation points catalogue using
the Ek button of the Triangulation points window.

In order to open or add images in the Points measurement module, perform the follow-
ing actions:

1. Click the B button. The Add images window opens.

. Add images &J
Strips Images
1 Aalen_04-0116_rgh
b Aalen_04-0115 rgh
Aalen_04-0114 rgh

Aalen_04-0113_rgh
Aalen_04-0112 _rgb

El Selected 0 images

QK ] | Cancel

ke "y

Fig. 84. Manual selection of images to add or open them in the “Points measurement” module
é Strips and images containing highlighted tie point (in a list or on opened images) are shown

by light-green background color.

2. [optional] For automatic selecting of images containing a point highlighted in the
Triangulation points window, click the % button.
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3. Set checkboxes near images names to open them in the Points measurement
window.

4. Click OK. Marker in opened windows will be positioned to a supposed area of the
point position.

Each image window in the module contains the following interface elements:
 buttons of upper toolbox used to work with image:

&, &, @ &, [ - standard buttons for image management in the window;

(0]

o .* — allows to add point and measurement in marker position;

o A — allows to move and add selected point to marker’s position;

o

=8, — allows to move a point along tie residual vector;

J5 — allows to move a point along GCP residual vector;

(@]

o

i — allows to remove measurement results for point selected on image;

o

L — allows to select image as a “left” one, with which the rest images will be cor-
related, if tie points coordinates were measured using correlator (see the Sec-
tion 5.4).

» working area used to display image and its name in the upper left part;
+ the status bar with the following information:
o image zoom ratio, marker position coordinates (in pix and mm);

o coefficient of image correlation with the “left” image if tie points coordinates were
measured using correlator (auto-correlation coefficient is displayed in the status
bar of the “left” image);

o the [Zicon used to display additional information about image.

§ Move the mouse to the [Eicon, to view pop-up window with data about image size and
rotation angle, number of measured points and coordinates of marker position on image.

* right-click menu.

In the upper left corner of the image window the image name is shown for all images.
For scanner space images a sensor name and off-nadir angle (if any), obtained from
metadata are also shown in the upper right corner by default.
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The £4 button of the upper toolbar of the Points measurement window allows configure
displayed scanner imagery metadata (if available).

4 I [

B U o U 2 U (=== @0w (&

(D 11 (2964.1637,1472.1581)-(1.5860 mm,-40.7141 mm)

Fig. 85. Image window in the “Points measurement” module (the scrollbars and panel used to adjust the
image brightness, contrast and gamma-correction are displayed)

To display the panel used to adjust the image brightness, contrast and gamma-correction
for a single image or both images of a stereopair use the Shift+F8 shortcut.

§, Use left mouse button to select the image.
The &, €, _/ sliders are used to adjust a brightness, contrast and gamma-correction

of a stereoimage. Tools located in the right part allow to select the color channels, which
correction settings will be applied to.

It is possible to setup parameters for all channels at once if the & button is pressed
down, otherwise the system allows to setup individual channel.

o I o I Wi I jm efa|e|nae
Fig. 86. Panel used to adjust image brightness and contrast

To restore brightness and contrast settings to default values, right click the settings
panel and select the Reset item in drop-down menu.

é Brightness, contrast and gamma settings are not restored after the module restart.

The Ctrl+F8 shortcut allows to show/hide scroll bars in the active image window.
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To move an image in the window the system provides the panoramic mode — moving
an image using mouse move along with pressed Alt key.

The system also provides possibility to display a frame to make easy placing marker
to center of standard shape objects. To display the frame choose the Show frame for
centering on area objects item in the right-click menu.

To change frame size rotate the mouse wheel while holding the following keys pressed:
* H - horizontal size;

» V — vertical size;

* B — the same size on both axes.

In order to hide the frame choose the Show frame for centering on area objects item
in the right-click menu once more.

Table 9. right-click menu of image window

Buttons Functions
-t New tie point (Ctrl+=) to add a tie point to marker position on selected
image
Add point on all images to add a tie point to marker position on all selected

images without correlation (marker should be posi-
tioned manually on all images)

2 Move/add measurement into marker position |to change a position of a point selected in a list on
(Ins) images and to add it to marker position on images
where it was not measured

Add or move point measurements to marker [to move a point selected in a list on images and to
positions on all images add it to marker position on all images

:5 Move point along tie error vector to move a point along tie error vector on all images.
To display tie residuals vectors on images the .2
button of the leftward toolbar is used

45 Move point along GCP error vector to move a point along GCP error vector on all im-
ages. To display GCP residuals vectors on images
the 5 button of the leftward toolbar is used

it Delete measurement (Del) to remove measurement results for point selected
on image
L Left image (L) to specify selected image as the “left”image

Show frame for centering on area objects |to display a frame used to place marker to center
of standard shape objects

Move marker to the nearest point on this image |to move a marker to nearest measured point on

(S) selected image
Move marker to the nearest point on all images [to move a marker to nearest measured point on all
(Shift+S) images
Distance measuring mode (D) to turn on the distance measuring mode

Shift one image left to shift one image left in a strip
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Buttons

Functions

Shift one image right

to shift one image right in a strip

Shift one image up

to shift one image up on adjacent strip

Shift one image down

to shift one image down on adjacent strip

5.2.4. Selecting displayed fields from metadata for scanner imagery

In the upper right corner of an active image (for scanner imagery), the sensor name is
displayer by default, as well as off-nadir angle (where available) obtained from metadata.
The system allows you to configure displaying additional fields from scanner imagery

metadata (if available).

For this, perform the following:

1. Click the £§ button on the upper toolbar of the Points measurement window. The

Configure displayed filelds from metadata window opens:

. Configure displayed fields from metadata

(o |

Mame Abbreviation
G50 gsd
Earliest acquisition date  ead
Latest acquisition date lad
Cloud coverage cc
Satellite azirmuth sat. az.
Satellite elevation zat el
Sun azirmuth SUn az.
Sun elevation sun el,

Sat Info

A [~ [~ ¥

Mame

Off-nadir

Abbreviation

nadir

Fig. 87. The Configure displayed filelds from metadata window

Select the field with the required metadata in the list and click the = button to add

é’ The buttons == and == allows to add/remove all the selected fields, the < button removes

2.
them in the displayed list;
the selected field from the list.
3. Click Ok.
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5.2.5. Distance measuring

The Points measurement module provides features that allow to measure distances
on terrain (in pixels) in windows of opened images.

§ To calculate distance in meters use data about ground sample distance (GSD), that is specified
in the Ground sample distance (GSD) window opened using the Block > Set GSD menu item
(see the “Project creation” User Manual).

To measure distance between terrain points on images perform the following actions:

1. Place a marker in the first point on terrain on the image. Select the Distance
measuring mode item in the right-click menu or press the D key to turn on the
distance measuring mode.

2. Indicate the second point on terrain by left button mouse click. After that a measuring
line with indicated distance between points in pixels is displayed.

(D 1: (3012.1614,1249.5652)-(2.1619 mm,-42.1852 mm)

Fig. 88. Distance measuring in the “Points measurement” module

3. Press the D key once again to turn the distance measuring mode off.

Distance measuring mode allows to estimate conformity error of terrain points in images
overlap areas. This error is considered during tie points measurement in automatic
mode and is used to increase measurements accuracy (see the Section 5.6). In order
to specify conformity error, use the Search area parameter on the Search for points
tab of the Tie point measurement parameters window.
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To estimate conformity error of terrain points in images overlap areas after measuring
tie points in automatic mode perform the following actions:

1. Open a block stereopair in the Points measurement module (see the Section 5.5.2).

@ It is recommended to estimate the conformity error on multiple stereopairs: on in-strip ste-
reopairs in different strips of a block, and on inter-strip stereopairs.

2. Indicate some point on terrain by mouse double click on one of images in overlap
area. The system perform automatic search of the same terrain point on another
image of stereopair and place marker to probable location of corresponding point.

3. Measure a distance between indicated and found point on terrain in distance
measuring mode.

5.3. The “Triangulation points” window

The Triangulation points window contains a list of all triangulation points of a project
(ground control, check, and tie) and also tools for points view, search, edit, and import/ex-
port.

The Triangulation points window is opened independently or as a part of the Points
measurement module. In the independent Triangulation points window there is a
possibility to proceed to the Points measurement module that allows to display results
of namepeHun BoiGpaHHOM B KaTtanore TOYKN TpUaHrynauum on project images.

To open the Triangulation points window perform one of the following actions:

« choose Orientation > Tie points list or click the & button on the main toolbar or on
the AT additional toolbar. B okHe Triangulation points otobpaxaetcs the Tie points
tab is displayed;

- choose Orientation > GCP list or click the ¥ button on the main toolbar. In the Tri-
angulation points window the GCP list tab is displayed;

» open the Points measurement module. In the lower part of the Points measurement
module there is the Triangulation points window located on the Tie points tab.

The Triangulation points window contains the following two main tabs:

« #1GCP list - list of ground control points both with measured coordinates and without
them;

« £ Tie points — list of all tie points.

The title of the Triangulation points window displays a number of all triangulation
points/number of points shown in the list on selected tab.
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The GCP list tab contains a list of all measured and unmeasured GC points with their
coordinates and measurements accuracy data (RMS) on terrain.

Buttons of the toolbar allow to input, view, search, edit, import and export of GCP, and
for viewing of selected point measurements on project images in the Points measure-
ment module (see Section 4.2.1).

Triangulation points [total: 275 / visible: 9] x

E) 8@ & 0 X6 @ 0w 1[0 %0 B OO BS%E

A

* Code Mame Type X m ¥, m Zm Std. dew. X, m Std. dév. ¥.m  Std. dev. Z m  MNumber of meas.
15420 00330101 Ground Control 5803422065 5410576.536 479.331 0.2 0.2 0.2 2
15421 01450007 Ground Control 5803036307 5410895169 475422 0.2 0.2 0.2 2
15422 01640010 Ground Control 5813687509 5410059165 513.552 0.2 0.2 0.2 1
15423 01640032 Ground Control 5809368002 5400605.248 490,705 0.2 0.2 0.2 2
15424 01750031 Check 5808363151 5410912.538 520,657 0.2 0.2 0.2 2
15425 02410031 Ground Control 580464.645 5410072308 482411 0.2 0.2 0.2 2
15426 03830029 Ground Control 5808214026 541052741 488609 0.2 0.2 0.2 2
15427 04080011 Ground Control 5800413261 5410131.400 499.344 0.2 0.2 0.2 3
15428 04080069 Ground Control 581405405 5410505799 520.888 0.2 0.2 0.2 1 Apply

Fig. 89. GCP list (opened as a part of the Points measurement module)

On the Tie points tab displays full list of tie points. The toolbar allows to search, filter,
edit, import/export and display points on project images in the Points measurement
module.

@ Aalen_DMC_training_Brusnikin - PHOTOMOD = | B
Triangulation peints [total: 275 / visible: 266] *
[&lacrist | [ Tie points]

D# vy M- w0 B ¥E ([ B@E X
Code Name Type VR s = O m omn 2 R i
15491 ~1 Tie 2 1 P N E
15498 ~10 Tie 2 1 , 0.987
15583 ~101 Tie 2 1 , 0932
15584 ~102 Tie 2 1 , 0,982
15585 ~103 Tie + o+ 3 1 P
15586 ~104 Tie 2 1 , 0.906
15587 ~105 Tie + o+ 2 1 + 0.967
15588 ~106 Tie 2 1 , 0.989
Reset
15589 ~107 Tie 2 1 , 0.992 -
4 in 3 Apply
Fig. 90. Tie points list (opened independently)
Table 10. Toolbar of the Triangulation points window on the Tie points tab
Buttons Functions
to refresh the points list
] to open the Find window allowing to search a point by its name (Ctrl+F). Input full name
or its part, define the search direction and click the Find next button. Found point is
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Buttons

Functions

highlighted in the list. The Points measurement module shows all positions of found
point on images

=

to remove selected points from a list (Alt+Del). To select multiple points use Shift and
Ctrl keys

to use selected points as tie points («+»), if these points were excluded previously («-»)
(Ctrl+l). In this case previously excluded GC point, that is measured on multiple images,
is used only as tie. In order to use the point as a GCP, select the Ground Control type
on the GCP list tab in editing mode

to not use selected points as tie points, i.e. to exclude the points from calculation of rel-
ative orientation (Ctrl+E). Excluded point is marked by «-» sign, but is not removed.
When excluding GC point with measurements on multiple images, it will be excluded
both by GCP and by tie

to assign numeric names to highlighted points (to rename points)

¥ &

to perform import of triangulation points from PAT-B, X-Points, and from PHOTOMOD
4.x

to perform export of triangulation points to PAT-B and X-Points

@ | ¥

to open the Point properties window used to display name, type, code and coordinates
of selected point

to display point selected in a list on images (is duplicated by mouse double click on the
point in a list) (see the Section 5.2.3)

to setup accuracy control parameters and to open relative orientation report

to display all tie points in a list

<) E B2

to display all tie points on opened images in the Points measurement module. This filter
is applied both to records in the list, and to points display on images in the Points
measurement module. The title of the Triangulation points window displays number
of points selected after filtration

to display only common tie points on opened images. This filter is applied both to records
in the list, and to points display on images in the Points measurement module. The
title of the Triangulation points window displays number of points selected after filtration

pix

to display values of Y-parallax and triplet residuals for points in the list in pixels

mm

to display values of Y-parallax and triplet residuals for points in the list in millimeters

&

to enable automatic search for images containing the point’s position: if the mode is
enabled, the E} button or mouse double click on a row with the point in coordinates list
allows to open the images in the Points measurement module, on which selected point
coordinates are already measured, otherwise, to open all images that contain the point’s
coordinates

to create raster outline of triangulation points

X E

to remove all tie points from a list

@ In order to invert work of the % mode (change its state to the opposite) for a short time, click
the Alt key and select a point using mouse double click or click the Ek button.

@ When toggling between & and B¥ modes and some point is selected in the list and is not cor-
responding to chosen mode, it is displayed by grey color in the table.

The list of tie points is a table.
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7

Points sorting in columns of the list is performed by mouse click on the column header.

Table 11. Types of table columns — list of points on the “Tie points” tab

Buttons Functions
Code displays point’'s code
Name displays point’'s name
Type displays point’s type (tie, GCP, check, excluded)

% Tie point included

displays «+», if the point is used for calculating of
relative orientation, «-», if the point is excluded from
calculation. When a tie point is excluded all values
in columns are inactive. When a GCP is excluded,
it is excluded completely by ground control and by
tie, and in the Type field the Excluded value is
displayed

i5% Point measured automatically

displays «+», if the point is measured in automatic
mode (see the Section 5.6) or «-», if the point’s co-
ordinates are measured manually

“% Total measurements

displays number of images where point’s coordin-
ates were measured

Strips with point measurements

displays number of strips with the point’s coordinates
measurements

O Measured on a single image

displays «+», if the point’s coordinates are measured
on a single image (with no ties) only, otherwise «-»

[M Measured on stereopairs

displays «+», the point’s coordinates are measured
on stereopairs, otherwise «-»

Measured in triplets

displays «+», the point’s coordinates are measured
in triplet, otherwise «-»

omm Strips with measurements on isolated images

displays «+», if interstrip point is single within one
of the strips or «-», if it is not single within a strip
(i.e. is measured on stereopair or in triplet)

&8 Measurements on non-adjacent strips

displays «+», if the point’s coordinates are measured
on images of non-adjacent strips, otherwise «-»

R.« Minimum correlation coefficient

displays correlation coefficient, if the point’s coordin-
ates were measured using correlator

Max Y-par

displays Y-parallax (in pix or mm), if stereopairs are
opened in the Points measurement module and
relative orientation is done

Max Exy

displays ftriplet residual by XY for a point with
measurements in triple overlap area (in pix or mm),
if the triplets are opened in the Points measure-
ment module

Max Ez

displays triplet residual by Z for a point with meas-
urements in triple overlap area (in pix or mm), if the
triplets are opened in the Points measurement
module
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During executing of relative orientation it is recommended to set the following threshold
values:

 correlation coefficient threshold — 0.9-0.95;
* maximal Y-parallax — no more than the pixel size;

 values of threshold on maximal error in triplets are calculated using the following
formula:

Enex= 2 Eean, Where E,..., —average error threshold,;

+ average error by XY is calculated using the following formula:
Eprean = V2 0.5pix

average error by Z — is average error by XY, multiplied by ratio of the camera focal
length (f) to the survey basis (b):

z  _f v
Emean - Emean .

5.4. Manual measurement of tie points coordinates

% Manual measurement of ground control points in Points measurement module is described
the appropriate chapter above (see Section 4.2.2).

The Points measurement module provides tools used to measure tie points coordinates
manually without correlation or using correlator.

Measurement of tie points coordinates without correlation — adding tie point to marker
position on opened images.

Measurement of tie points coordinates using correlation — automatic search on
project images for a terrain point, that corresponds to a point specified by marker on
the “left”image, and further attempt of the system to calculate correlation coefficient to
make a decision about adding of tie point. A point search using correlator depends on
the correlator parameters settings.

For tie points measuring/editing without correlator the Points measurement module
provides the following features:

+ to measure tie point coordinates perform the following actions:
1. Choose and open image to measure tie points coordinates (see the Section 5.2.3).

2. Choose and show using marker the same terrain point on opened images.

138



PHOTOMOD 8.1 Aerial triangulation (Windows x64)

3.

Click the .* button of the upper toolbar of the Points measurement window. A
new tie point is added to the triangulation points list and is displayed on opened
images (see also Section 6.3).

» to transfer already measured tie point into specified marker position with adding
measurements of this point to another image perform the following actions:

1.

A\

Open images with measurements of selected tie point and (if needed) images,
containing the same terrain point, but without measurements (see Section 5.2.3).

Show by marker new position of tie point on all opened images.

Click the .7" button of the upper toolbar of the Points measurement window. Tie
point is transferred/added to specified marker position on images. Tie points
measurements are updated in the triangulation points list.

During adding of a point located out of image border, a point without coordinates values is created
in the table. At that after saving the points list data with blank record and the point on image will
be removed.

The Points measurement module provides the following opportunities for tie points
measurements using correlator:

+ to correlate active image with “/eft” and to add tie point, perform the following actions:

1.

Choose and open images to measure tie points coordinates (see the Sec-
tion 5.2.3).

Choose the “left”image and click the L button in the toolbar of this image window.
Show by marker a terrain point on the “leff’ image.

Show by marker a terrain point on the active image different from the “left’ one,
that approximately corresponds to this point.

§ The active image window is highlighted by blue frame.

[optional] In order to place marker on all opened images to marker position on
the active image, double click selected terrain point on the image.

% When place marker within a radius of 10 pixels around existing tie point, an existing

point will be edited during using the correlator, rather than a new point will be created.

Click the &’ button of the upper toolbar of the Points measurement window.
After correlation operation one of the following events will occur:
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o if the system failed to calculate correlation coefficient, the Bad point warning

will appear;

o if correlation coefficient is calculated successfully, the New tie point window
opens. The window displays point’s code and name (by default) (for its editing
it is possible to use any symbols), and calculated correlation coefficient.

-
’ Mew tie point

(o |

Code -
MName *3
Image Correlation
Aalen_04~0115_rgh ("Left” image)
Aalen__04~0114_rgh 0.9862
Ok, ] [ Cancel

Fig. 91. Correlation of the active image with the “left” image

Data display in the coefficients table depends on values of the Correlation
threshold for points measurement and Correlation threshold for marker
movement parameters, specified in the Points measurements settings

window.
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IF

Correlation coefficient

>or =
Correlation
threshold for
points
measurement

<

Correlation
threshold for
points
measurement
and

>0r=
Correlation
threshold for

marker
movement

<

Correlation
threshold for
marker
movement

Not calculated

VAR R

THEN

marker is moved to corresponding point of
active image;
new tie point is ADDED to active image
(the Image column is checked)

marker is moved to corresponding point of
active image;
new tie pointis NOT ADDED to active image
(the Image column is not checked)

marker is not moved on active image; new tie
point is NOT ADDED to active image
(the Image column is not checked)
Correlation coefficient is displayed in red color

The "Bad point" warning is displayed

Fig. 92. Adding a point depending on degree of images correlation

7. Make a decision about adding of new tie point. To add a point set checkboxes
next to selected images in the list and click OK, otherwise click the Cancel button.

+ to correlate all opened image with the “left”image in order to add a tie point, perform

the following actions:

1. Choose and open images to measure tie points coordinates.

2. Choose the “left”image and click the 'L button in the toolbar of this image window.

7

For correlation of all opened images with the active image, it is not necessary to choose
the “leff’ image.

3. Show by marker a terrain point on the “left’ image.
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4. Show by marker on other opened images a terrain point, that approximately
corresponds to this point.

5. Click the &% button on the upper toolbar of the Points measurement window or
use the Ctrl+Space shortcut. After the correlation operation the New tie point
window opens, that allows to analyse correlation coefficients and make a decision
whether to add a new tie point or there is a warning Bad point (see the description

above).
’ Mew tie point ﬁ
Code -
Mame *3
Image Correlation
Aalen_ 04~0115 rgh ("Left" image)
[] Aalen_05~0047_rgb 06343
[7] Aalen_05~0048_rgb 0.6168
[ Aalen_05~0043_rgb 0.6814
[] Aalen_04~0113_rgb 06572
Aalen_04~0114 _rgb 097582
0K ] [ Cancel

Fig. 93. Correlation of all opened images with the “left” image

6. To add a point select images in the list (set appropriate checkboxes) and click
OK, otherwise click the Cancel button.

@ The [E button on the upper toolbar of the Points measurement window is used to view
correlation coefficients of all images with the “left” image without adding of a tie point. In the
status bar of each image window, which is correlated to the “left” image, the correlation
coefficient is displayed. And in the status bar of the “left”image there is the auto-correlation
coefficient.

5.4.1. Parameters of points coordinates measurement

Semi-automatic search and measurement of tie points coordinates using correlation
algorithm includes matching of corresponding fragments of images considering maximal
relative coefficient of correlation. A point search using correlator depends on the correl-
ator parameters settings.

In order to open the Points measurement settings window click the [ button on the
upper toolbar of the Points measurement module.
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r '
. Points measurement settings I,&J

Show report after finished editing

| Correct GCPs paosition while measurements

Correlator

12 + pix

4|k
=

Correlation matrix halfsize 12

Ak

Contrast point search area 0 pix

Ak

Corresponding point search area 100 pix
Correlation threshold

for point measurements 0,800 |+

for marker movement 0,500 =

Ok ] ‘ Cancel

Fig. 94. Points measurement settings

When the Show report after finished editing checkbox is set, relative orientation report
is opened after clicking OK in the Points measurement module.

When the Correct GCPs position while measurements checkbox is set, an improved
algorithm for searching for corresponding terrain points in block images (with marker
positioning at these points) is used during manual measurement of GCP coordinates.

é Proper functioning of the improved algorithm for GCP position refinement is feasible under strict
compliance with the following conditions:

* The adjustment is performed (see the “Block adjustment” User Manual);
» All three GCP coordinates are available (see the Section 4.2);

+ At least two point measurements are available in project images (see the Section 4.2.2).

The Correlator section contains the following parameters used to setup correlator using
during tie points measurement or for analysis of correlation coefficients (using the g,
%, R, R4 buttons of the Points measurement module):

» Correlation matrix halfsize (in pixels) — allows to specify size of correlation matrix
by X and Y axes;

» Contrast point search area (in pixels) — allows to specify area where to perform a
search for a point of maximal contrast;

% It is recommended to use this parameter for images with big percent of one-colour areas.
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» Corresponding point search area (in pixels) — allows to specify area where to per-
form a search for a terrain point, that corresponds to a point of the “/eft”image (area

around marker);

» Correlation threshold — allows to define a value of correlation threshold for point
coordinates measurements and for marker movement. These values influence
on search and measurement of tie points coordinate in the following way:

IF

" ) >or=
Correlation
threshold for
points
measurement

<

Correlation
threshold for
points
measurement
and

>0or=
Correlation
threshald for

marker
movement

<

Correlation
threshald for
marker
movement

Correlation coefficient

Not calculated

d &4 4

THEN

marker is moved to corresponding point of
active image;
new tie point is ADDED to active image
(the Image column is checked)

marker is moved to corresponding point of
active image;
new tie point is NOT ADDED to active image
(the Image column is not checked)

marker is not moved on active image; new tie
point is NOT ADDED to active image
(the Image column is not checked)
Caorrelation coefficient is displayed in red color

The "Bad point" warning is displayed

Fig. 95. Adding a point depending on degree of images correlation

5.4.2. Editing of tie points

The system allows to edit tie points, and to change points type in a list.

To change point’s position highlight it using one of the following ways:
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choose Orientation » Tie points list or click the i button of the AT additional toolbar.
The Triangulation points window opens. Select a point to be edited in the table by
double mouse click;

in the image window of the Points measurement module double click a point’s area;

in the Triangulation points window of the Points measurement module select a
point to be edited by mouse double click;

during the adjustment step; perform the following actions:

1. Select a point on a block scheme or in a list, which error exceeds specified
threshold value.

2. Click the # button. The Information window opens.

3. Click the g&8 Measure button.

As aresult marker is placed to a position of selected point on all images/only on images
with point measurements.

To change point’s position perform one of the following actions:

change point’s position manually or using correlator in the same way as during
measurement of point’s coordinates;

click the =& button of image window toolbar, to move the point along vector of the tie
error on a single image, or click the =& button of the upper toolbar, to move the point
on all images;

click the 5 button of image window toolbar, to move the point along vector of the
GCP error on a single image, or click the 5 button of the upper toolbar, to move the
point on all images.

% To display vectors of tie and GCP errors the system provides the & and 5 buttons of the left

toolbar correspondingly.

é When using the &=, ==, ﬂ‘ , ‘Qv buttons to change over block images a marker is fixed to selected

point position. To fix a marker in relation to image border, it is possible to use the Alt+H shortcut.

Click the Apply button to confirm the changes or click OK to confirm the changes and
exit from the Points measurement module.

Change of the point type is provided in the following windows:

the Exterior orientation parameters window;

§ Excluded GCP are not considered during block adjustment. It is recommended to use the
Excluded type for non-measured GC points prior block adjustment operation.
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» the GCP list and Tie points tabs of the Triangulation points window;

» the Point properties window.

5.4.3. Point properties

In order to view selected point properties click the “g button of the Triangulation points
window. The Point properties window opens.

. Point properties

=x=)

Mame ~100417]

Code 1624
Type

Check @ Tie

Unused tie point
Targeted

| Measured automatically
Coordinates RMS
X 0,0000000

¥ 0.0000000

£ 0.0000000

Contraol Coordinates not used

Ok ] | Cancel

Fig. 96. Point properties

The window displays the following information about point:

» the Name field allows to change a name of selected point;

» the Code field shows a code assigned to selected point (not editable);

» the Type section allows to change a type of selected point and to make it Check,
Ground control, Tie or to exclude it from orientation;

» set the Unused tie point checkbox if a point is not used as tie point;

» the Targeted checkbox — allows to mark a point as targeted point, without changing

its type;

» the Measured automatically checkbox — is set if a point is obtained by automatic
measurement of tie points;
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é During editing of automatically measured point in the Points measurement module, the
Measured automatically checkbox is cleared and a point is considered as measured
manually.

 for GC points the geodetic Coordinates and RMS of selected point are also displayed.

5.5. Manual measurement of tie points coordinates in stereo mode

The system provides possibility to measure points coordinates in a stereomode.
Measurement of tie points coordinates in a stereomode are required when the points
are located on high objects, or at the bottom corner of the building (so that in the mono
mode a point is not visible on the second image of the stereopair).

There are the following two modes of points measurement in stereo mode on selected
stereopair in the Points measurement module:

» measurement of points coordinates in moving marker mode;

* measurement of points coordinates in fixed marker mode in stereocomparator (set
by default).

Stereocomparator mode — a mode with marker fixed in the center of the window. In
stereocomparator mode it is possible to move an image using pressed left mouse button.
At that marker remains fixed in the window center. The main advantage of this kind of
stereo measurements is that it is possible to position the marker with sub-pixel accuracy.
The pixel size depends on the current zoom and the marker moving step is defined by
the sensitivity slider located at the bottom of the stereo window. Stereocomparator
mode is used either to work with in-strip stereopairs for measuring of tie points coordin-
ates in images overlap area, or for measurement of tie points between strips in inter-
strip overlap area.

5.5.1. The stereoimage window

For points coordinates measurement in stereomode the sterecimage window is used.
To open it, perform the following:

1. Inthe Points measurement window select “left”and active images of a stereopair.

2. Specify approximately by marker the same terrain points on these images and click
the ] button of the main toolbar of the Points measurement module. By default
a single window with stereoimage instead of all opened windows of images will be
opened in the module:

147



PHOTOMOD 8.1 Aerial triangulation (Windows x64)

@ Aclen. Conveyor - PHOTOMOD ==

Q Qe EES .+ i [ (E) sen_otwoiss obaskn_os-otiared

‘ "
X . i

<\

g ] 5
e 0] o ] P 1 (=== @@
U w o
Vo O OB
s e & T s &
® ® . B o B ®

points [total: 1221 / visible: 1200]
i vvK®e-B-sQ VDY % m(@BE %
Name Type v $ 3% = 0 0t o 53 ke Max Y-par Max Exy MaxEz
. PR S S O O 1000 0007365 L
PR 1000 0007612
PO O P R P 1000
1 e e - - am 0001137

-100
-1008

FIEI

1030
1034
1038
1039
1044
1046
-1057
1075

..... 1000
O T N R ) 0002780
F O P PO PO Y 0002985
PO T 1000 0000784
O N O O A 1000 0010575
1 e - 1000 0008892

I

FIEICIEIE

Fig. 97. Sterecimage in stereocomparator mode (the scrollbars and panel used to adjust the image
brightness, contrast and gamma-correction are displayed)

Stereowindow toolbar contains the following information and buttons:

&, &, @ &, [ - standard buttons used to manage image in the window;

4& (Ctrl+F6) - allows to turn on/off stereocomparator mode;

== (F11) — allows to switch stereo phase (to swap “left” and “right” images);
« .* —is used to add new tie point;

+ .7 —is used to move and add a point to marker position;

if — is used to remove a point from stereoimage;

- &% — allows to create epipolar images by points, if at least five tie points coordinates
are measured;

5 Creating of epipolar images (images for which Y-parallax tends to zero) is available when
there are at least 5 measured tie points on stereopair.

& — allows to create epipolar images using adjustment results, if it is possible (if
there are adjustment results available);

Ed — allows to show/hide the control panel used to setup a stereo image (in lower
stereowindow corners);
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» a name of opened stereopair image;

» a value of Y-parallax Y-par (in pix) on selected tie point (available only for in-strip
stereopairs);

« X —allows to close a stereo window and to go back to opened windows of the Points
measurement module.

In the lower part of stereo window there are control panels used to adjust images and
manage their movements.

Left group of red arrows is used to move the left image of stereopair (Shift + arrow
keys).

Left group of grey arrows (duplicated by arrow keys of the keyboard) is used to move
left and right images at once.

Right group of grey arrows allows to move the right image (Ctrl + arrow keys).

The additional buttons on the right group of arrows allow to perform the following actions:
« & — zoom in the right image scale on 5% (along with pressed Shift key — on 1%);

« & — zoom out the right image scale on 5% (along with pressed Shift key — on 1%);
« @ _ reset the right image to 1:1 scale.

The Step slider is used for sensitivity adjustment of mouse move, mouse wheel rotation
and actions of keyboard arrows. Move step is changed from 0.1 to 20 of current screen
pixel size (which corresponds to current zoom level), and is also setup using the following
shortcuts: Ctrl+0, Ctrl+1... Ctri+9.

“Steering-wheels” are used for images rotation. The left “steering-wheel” is intended
for both images rotation at once (by clicking on the wheel field or entering rotation angle
value into numeric field). And the right wheel — for right image rotation.
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To display the panel used to adjust the image brightness, contrast and gamma-correction
for a single image or both images of a stereopair use the Shift+F8 shortcut.

@ Use left mouse button to make stereopair window active and let the shortcut work.
The %, &, _/ sliders are used to adjust a brightness, contrast and gamma-correction

of a stereocimage. Tools located in the right part allow to select left, right or both images,
and also color channels, which correction settings will be applied to.

It is possible to setup parameters for all channels at once if the & button is pressed
down, otherwise the system allows to setup individual channel.

%o 1 O 1 . J CROICIEA )
Fig. 98. Panel used to adjust image brightness and contrast

It is possible to setup parameters for both stereopair images at once if the & button is
pressed down, otherwise, separately for the right stereopair image Ol or for the left one
.

To restore brightness and contrast settings to default values, right click the settings
panel and select the Reset item.

§ Brightness, contrast and gamma settings are not restored after the module restart.

5.5.2. The stereoimage windows in “Points measurement” module

By default a stereo image in the Points measurement window is opened, instead of
all opened image windows (see the previous chapter).

If user click the [l button while holding down the Shift key, the opened stereo window
will be double size of image window, selected to be displayed in a stereo mode. Holding
the Ctrl key user can open window with one window size to the “left” image window
location:
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Fig. 99. The “left” and active images of a stereopair are selected in Points measurement module window
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Fig. 100. The stereopair, opened in Points measurement module window

The system allows to replace the images windows in Points measurement module by

stereopairs. To do this, perform the following:

1. In the Points measurement window select “eft” and neighbor active image of a

stereopair:
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Fig. 101. The “left” and active images of a stereopair are selected in Points measurement module
window

Specify approximately by marker the same terrain points on these images and click
the Il button of the main toolbar of the Points measurement module, holding the
Shift and Alt keys simultaneously. The single window with stereoimage will be
opened instead of two selected windows:
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Fig. 102. The stereopair in Points measurement module
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3. Repeat the actions described above for the other images pairs.

@ To select the image as the “left” image — click the L button in the toolbar of this image
window.
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Fig. 103. The stereopairs in Points measurement module

5.5.3. Points measurement in “stereocomparator” mode

To measure points coordinates in stereomode perform the following actions:

It is needed to enable the Anaglyph stereomode to measure points coordinates (the “Stereo
settings” chapter of the “General system’s parameters” User Manual).

In the Points measurement window select “left”and active images of a stereopair.

Specify approximately by marker the same terrain points on these images and click
the ] button of the main toolbar of the Points measurement module. By default
a single window with stereoimage instead of all opened windows of images will be
opened in the module.

Click the & button or use the Ctrl+F6 shortcut to turn on the stereocomparator
mode (which is on by default).

To measure points coordinates in stereocomparator mode perform the following
actions:

1. Place a marker at the terrain point.
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2. Remove a X-parallax, rotating mouse wheel or using horizontal arrows to move

left or right image.

3. To measure coordinates of a new tie point press the Space key. As a result of
correlation one of the following events occurs:

* The Bad point warning is displayed if the system failed to calculate correlation

coefficient;

* The New tie point window opens if correlation coefficient is calculated suc-
cessfully. The window shows the point code and name (by default), and also
calculated correlation coefficient. It is possible to use any symbols to edit the

point’'s name.

-
’ Mew tie point

(o |

Code -
MName *3
Image Correlation
Aalen_04-0115_rgb ("Left” image]
Aalen__04~0114_rgh 0.9862
Ok, J [ Cancel

Fig. 104. Correlation of the active image with the “left” one

Data display in coefficients table depends on values of parameters Correla-
tion threshold for points measurements and Correlation threshold for
marker movement specified in the Points measurement settings window

(see the Section 5.4.1).
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IF
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Correlation
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points
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and

>0r=
Correlation
threshold for

marker
movement

<

Correlation
threshold for
marker
movement

Correlation coefficient

Not calculated

VAR R

THEN

marker is moved to corresponding point of
active image;
new tie point is ADDED to active image
(the Image column is checked)

marker is moved to corresponding point of
active image;
new tie pointis NOT ADDED to active image
(the Image column is not checked)

marker is not moved on active image; new tie
point is NOT ADDED to active image
(the Image column is not checked)
Correlation coefficient is displayed in red color

The "Bad point" warning is displayed

Fig. 105. Adding a point depending on degree of images correlation

4. Make a decision on adding a new tie point. To add a point set checkboxes to
select images in the list and click OK, or click the Cancel button to cancel op-

eration.

5. [optional] To move current selected tie point to marker’s position click the .#

button.

6. |If calculated value of Y-parallax for this point is not satisfactory it is necessary
to re-measure the point. At that for better positioning of the image it is necessary
to rotate mouse wheel while holding pressed the Ctrl key or to rotate vertical
arrows of the left and right images to eliminate vertical parallax.

§ Maximal acceptable value of the vertical parallax is one pixel.
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5. [optional] To turn on the moving marker mode click the #& button once more (to
turn the stereocomparator mode off) or use the Ctrl+F6 shortcut. When measuring
tie points in the moving marker mode use the following tricks to remove parallaxes:

* mouse wheel+Ctrl — allows to change marker’s parallax;
* mouse wheel+Shift — allows to change X-parallax;
* mouse wheel+Ctrl+Shift — allows to change Y-parallax.

6. Close stereo window to return to the Points measurement window.

5.6. Automatic measurement of tie points coordinates (general
information)

The system provides possibility to measure tie points coordinates and perform relative
orientation in automatic mode. When working in automatic mode correlation algorithm
is used for search and measurement of tie points coordinates.

5.6.1. Source data

To perform automatic measurement of tie point coordinates the following data should
be available:

* interior orientation parameters of images, which will be considered in automatic
measurement of points coordinates;

c Itis highly recommended to perform interior orientation prior to automatic search of tie points,
since otherwise most of the filtering parameters are ignored, that considerably reduces relative
orientation quality.

* block layout;

@ Sufficient condition for launch the operation of automatic measurement of tie points coordinates
is availability of initial (“rough”) block layout, considering, for example, size of images overlap
and/or quick ties data. However, the more data is used for the block layout creation, the more
accurate is the block scheme and, hence, the better the results of measurement of tie points
coordinates in automatic mode.

If there are exterior orientation data received from the image provider, it is desirable to
import exterior orientation parameters before performing relative orientation of images,
although the availability of exterior orientation data is not a mandatory condition for
performing relative orientation of project images.
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5.6.2. Modes of automatic tie points measurement

The Automatic tie points measurement window have different configurations, provided
to process various data types:

When working with spaceborn scanner data the area correlator and feature based
correlator windows are used.

When working with airborne data the window allows to select manually optimal combin-
ation of basic and additional parameters of automatic ties search, measurement and
filtering, and also to save sets of this parameters as files with *.x-1ini extension for the
further usage.

When working with UAS and “oblique” aerial data the window allows to load parameters
sets for automatic ties search, measurement and filtering (so called “presets”).

Preset — parameters set of automatic tie points measurement, preliminary created by user or
setup in advance.

5.6.3. Order of automatic tie points measurement

To measure tie points using automatic mode (Ha npumepe airborne data) perform the
following:

1. Create a block layout considering available data.

2. Setup parameters of tie points automatic measurement, transfer, filtering and start
the operation of automatic measurement of tie points coordinates.

3. Perform accuracy estimation of relative orientation and detecting of tie points
measurement errors.

4. Manually eliminate errors of tie points measurement in the Points measurement
module or choose other filtering parameters (for example, specify more “strict” tol-
erances for measurement errors) and start the operation of automatic measurement
of tie points coordinates once more.

5. Update block layout considering tie points. Change settings of automatic tie point
measurement parameters if necessary and start once more operation of further
collecting of tie points measurements. Repeat steps 3-4 until obtain satisfactory
results.
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5.7

. Automatic measurement of tie points coordinates (scanner

imagery)

5.7.1. Area correlator

A

This function is not available for the central projection projects.

Automatic measurement of tie points coordinates

To measure tie points coordinates in automatic mode perform the following actions:

1.

Choose Orientation » Automatic tie point measurement > Satellite scanner
survey > Area correlator. The Automatic tie points measurements window
opens.

é For automatic measurements all images are selected by default. For tie points search just
on selected images clear the checkbox Select all images for automatic tie point meas-
urement on the Orientation tab of the Parameters window.

Use default presets of measurement parameters or set manually the main paramet-
ers for tie points search, measure and filter.

[optional] For more detailed tuning and refining of the main measurement parameters
set the additional parameters.

[optional] In order to use distributed processing during measurement of tie points
coordinates, perform the following actions:

1. Click the Distributed processing... button. The Distributed measurement
of tie points window opens.

The Maximum number of tasks for this project value is displayed in the
window. This parameter shows how many processing tasks is possible to divide
the current project to.

- '
. Distributed measurement of tie points [-Eh,l

Maximum number of tasks for this project 1

Mumber of tasks to create 1 =

QK ] | Cancel

LS =

Fig. 106. Parameters of distributed measurement of tie points in automatic mode
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3.

Specify the Number of tasks to create, which will be processed on one com-
puter. See the description of distributed processing setup in the General inform-

ation User Manual.

Click OK to go back to previous window.

5. Click the Start button in the Automatic tie points measurement window to start
operation of automatic measurement of points coordinates.

6. Open the relative orientation report to view results of relative orientation operation
and to fix measurement errors.

7

The report will open automatically after the operation completion, if the appropriate

checkbox is set (see below).

Main parameters of tie points measurement

The Automatic tie point measurement window allows to use parameters presets of
tie points measurement, or to manually choose the optimal combination of basic and
additional parameters for automatic tie points search, measurement and filtering.

Choose Orientation » Automatic tie point measurement » Satellite scanner survey»
Area correlator. The Automatic tie points measurement window opens.

’ Automatic Tie Point Measurement L&J
W E: T oo B SR EEEREER B ™ I E-H-~
MName Actions
« @ B B
/| fr0041 0102_21754 1 01874 06_G.. | MR h eI gt pltet e O
| fr 0041 _0102_21754 1 01874 06_G... o
v Transfer tie points
| fr0041_0102_21754 1 01874 06_G... Ei e
| fr_0041_0102_21754 1 01874 06_G... z
W Report on relative orientation on completion
Parameters
Gen
Points per stereopair 10 =1 10 =
Correlation threshold 0,920 = 0.920 =
Measure points by zones
Filter points by zones Mare...
DEM LD
Distributed processing | QK | | Cancel |

Fig. 107. The Automatic tie points measurement window

The Automatic tie points measurement window includes the following interface ele-

ments:
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» the images selection toolbar used to open auxiliary windows, to save and load sets
of parameters;

+ a list of project images allows to select images, scheduled to perform automatic
measuring of tie points coordinates;

» the Tasks section used to specify main actions (measurement, transfer, filtering, re-
porting) during operation of automatic measuring of tie points coordinates;

» the Parameters section used to specify main parameters of automatic measuring of
tie points coordinates;

» the More button used to setup additional parameters of measuring of tie points co-
ordinates;

+ the Start button used to launch an operation of tie points measurement and to perform
relative orientation in automatic mode;

+ the Distributed processing button is used for automatic tie points measurement in
distributed processing mode.

The system provides the following buttons in the toolbar to work with auxiliary windows:

» EE — allows to select stereopairs where there is no tie points coordinates measure-
ments, and their adjacent images;

» EE — allows to select triplets without tie points;

» EE — allows to select interstrip stereopairs where there is no tie points coordinates
measurements;

% When searching for stereopairs and triplets, excluded (%) points are also not taken into ac-
count. The Excluded status (in this case) is equivalent to no measurements. The user can
change the status of a point using the appropriate tools of the Triangulation points window.

. — allows (in case of already existing measured tie points) to deselect stereopairs,
triplets, and inter-strip stereopairs by setting the following:
o Minimum points for inter-strip pairs;
o Minimum points for in-strip pairs;
o Minimum points for triplets.

« - allows to open the Relative orientation report settings window used to specify
parameters and view a relative orientation report;
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« ©#%— allows to open the Triangulation points window used to view a list of triangu-
lation points;

« @8 _ allows to open the Points measurement module and open automatically open
images selected in the list, if more than 6 images are chosen. Otherwise, an in-strip
stereopair with image selected in the list will be opened.

To save and load sets of main and auxiliary parameters the system provides the following
buttons:

* = —is used to load a set of parameters from *.x-1ini file saved previously in active
profile resources or out of them.

The arrow located next to the = button allows to open a drop-down menu containing
the following items:

o Load settings from file allows to open the Load settings window used to load a
set of parameters from *.x-1ini file, located out of active profile resources;

o Reset settings to defaults allows to use default settings;

. — used to save setting of main and additional parameters to a file with *.x-ini
extension in active profile resources.

ﬁ To save setting to a file with *.x-1ni extension located out of active profile resources, open
drop-down list by clicking the arrow next to the [&| button and choose Save settings to file....

< Setting saving is used to create files with settings directed to work with certain type of block,
kind of images, or terrain, etc.

The Tasks section is used to specify the following actions during automatic tie points
measurement:

* Measure tie points in stereopairs allows to perform search and measurement of
tie points coordinates on in-strip and inter-strip stereopairs;

% A stereopair is called in-strip, if it is formed by two adjacent images in a strip, and inter-strip
is any other stereopair of a block.

» Transfer tie points allows to perform transfer of measured points to adjacent stereo-
pairs (transfer of points located in triple overlap area to adjacent models), and transfer
of tie points to adjacent strips;

* Filter tie points by relative orientation allows to perform points filtering that have
measurements, exceeding specified values of errors thresholds;
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7

7

During points check if to filter them or not, the system check out whether the point falls within
specified correlation threshold. Check for exceeding correlation threshold is applied only to
new points (if measured points are already available). In order to check all points whether
they exceed correlation threshold, set the additional Delete points with correlation below
threshold checkbox on the Rejection tab in the Tie point measurement parameters window
of additional parameters.

It is possible to perform actions with tie points inside strips, between strips, or not perform at

* Report on relative orientation on completion allows to open the Relative orient-
ation report window automatically to view and edit tie points measurements just
after completing of automatic relative orientation.

The Parameters section allows to make the following settings of automatic measurement
of tie points coordinates:

* Points per stereopair — allows to specify a number of points to be measured on in-
strip and inter-strip stereopairs;

<

7

Resulting amount of measured points may be either greater than a predetermined amount —
because of points transfer from adjacent stereopairs, or less due to further filtering. Default
amount of points is 30 per each images pair in forward overlap and 10 points in side overlap.
The minimum number of points to perform control by the vertical parallax residual — 6 points.

The Points per stereopair parameter depends on settings defined on the Miscellaneous
tab in the additional parameters window.

» Correlation threshold (%) — minimal acceptable value of correlation coefficient for
tie points, that will be selected during automatic search;

<

Recommended values lie in range from 90 to 95%. In contrast to all other filtering criteria,
this parameter directly influences on operation of points measurement and transfer. Check
for exceeding of correlation threshold is performed only for new points (if there are already
measured points). To check all measured points for exceeding of correlation threshold (usually,
at final stage of collecting measurements of tie points) set the additional Delete points with
correlation below threshold checkbox on the Rejection tab in the additional parameters
window.

* Measure points by zones — allows to apply a method of sequential measurement
by zones of overlap area. If the checkbox is cleared, points search is performed over
the whole area of images overlap. The system allows to select zones and define their
size in the Zones section on the Miscellaneous tab of the additional parameters
window;

* Filter points by zones — is used to filter points in stereopair zones sequentially;
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@ The operation provides filtering the worst (by parallax) points on stereopair, passing zone by
zone one after another. So the worst point on stereopair is found and deleted first, then the
worst one in the next zone and so on. Uniformity of point’s distribution on stereopair is also

verified in such a way.

* DEM - allows to choose a DEM (if any) to consider its data during automatic tie points
measurement. For this it is necessary to have saved adjustment results available.

@ This parameter allows to use DEM for calculation of the true position of the point. Thereby
the required search area of points reduces.

@ Click the [ button to clear a DEM.

Additional parameters of automatic measurement of tie points coordinates

For more detailed setup and adjustment and refinement of the basic parameters of tie
points coordinates measurement the Tie point measurement parameters window of
additional parameters is used. It is opened using the More button located in the main
Automatic tie point measurement window.

o 1
. Tie point measurement parameters @

Search for points Correlator Filter tie points Miscellaneous

Search area, pix: 500

Contrast point search area, pix: 10

Ll L1 4|k

Tries per point: 100
Multipass points search

Search the whole images area
On neighbar images in strips

0On other image pairs

[ CK ] | Cancel

Fig. 108. Points search parameters
The Tie point measurement parameters window contains four tabs with parameters.

ﬁ To reset to default parameters, delete the ProjCorrMatchOptions.x-ini file located in the project
root folder.

The Search for points tab allows to setup the following parameters:

» Search area (pix) — allows to specify a “halfsize” of area of matching point search;

163



PHOTOMOD 8.1 Aerial triangulation (Windows x64)

» Contrast point search area (pix) allows to search tie points in areas with maximal
contrast (on images with clear objects outlines);

@ In some cases it is reasonable to measure points in areas with low contrast, for example,
when forested areas have maximal contrast, and in these areas correlator’s errors are very
probable. In this case the Contrast point search area value should be set to 0.

» Tries per point — number of tries of matching point search with correlation coefficient
value that exceeds specified in the search area;

* Multipass points search allows to perform points search and filtering on stereopairs
in multiple passes with help of different algorithms. It is applied in case of insufficient
quality of the block layout, when real relative rotation of images relative to each other
is sufficiently big;

c For multipass points search it is recommended to set correlation threshold high enough, for
example, 95%.

§ It is recommended to use multipass points search for UAS images.

» Search the whole images area allows to specify images pairs to search points: ad-
jacent images in each strip and/or non-adjacent pairs of images in a strip and inter-
strip pairs of images.

£ N
& Tie point measurement parameters &J
Search for points Correlator Filter tie points Miscellaneous
Carrelation matrix half-size: Do not use image border area:
W12 | <X, %ofwidth: 0 =
¥ 12 1 | -¥, %ofheight: 0 5
V| Autocorrelation control Image blur
Maximum value: 30 = I_J
UUse correlation by absolute value
Mo Strong blur

[ Ok ] | Cancel

Fig. 109. Parameters of correlator

The Correlator tab is used to setup parameters of area correlator work and contains
the following parameters:

» Correlation matrix half size (pix) allows to specify size of correlation matrix by X
and Y axes;
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Autocorrelation control allows to specify level of auto-correlation — the Maximum
value of sigma in Gaussoid that is the top limit of distribution of the mask correlation
coefficient in a small area on the same image. The more the sigma value, the less
probability of correct points measurement, which were measured using correlation
with the given point as an initial one;

Do not use image border area is used to specify a size of area near the image
border, that is not used during correlation operation;

c Service area width (2% of image width and height by default) should not be less than on the

image; otherwise a big amount of “bad” points would be measured in image service areas.

the Image blur slider is used to consider image material quality, from No to Strong
blur.

é For images without blur or with negligible blur it is highly not recommended to place the slider
to position different from No.

§ In most cases the Image blur parameter is applied for processing of UAS images block.

r ™y
. Tie point measurement parameters &J

| Search for points Carrelator Filter tie points Miscellaneous

Preliminary filtering with detection of trust

Delete all tie point:

elete

measurements on no
| Delete single points
Delete points with correlation below threshold
Delete points surplus
Check correlation for measurements transferred from other stereopairs
Instrip  Between sirips
¥-parallax cipping, %: [0.00 | (0.00 :

Check correlation by reverse stereopair

[ OK ] | Cancel

Fig. 110. Filtering parameters

The Rejection tab is used to setup filtering parameters of points found and contains
the following options:

Preliminary filtering with detection of trusted points group is used to preliminary
filtering of blunders, that do not allow calculate correctly angular elements of relative
orientation (see the parameters of trusted points group on the Miscellaneous tab);

@ This function is not available for the scanner projects.
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* Delete all tie points, if after filtering number of them left is less then specified
number — allows to delete all tie points on a stereopair, acquired during operation of
automatic measurement of points coordinates, if after their filtering their number is
not sufficient to perform correct relative orientation;

@ This function is not available for the scanner projects.

* Delete measurements on non-adjacent images allows to filter potentially erroneous
points, measured on non-adjacent images inside a strip;

% To measure tie points for UAS images in two steps it is recommended to set the Delete
measurements on non-adjacent images checkbox on the first step and to not to use this
parameter on the second step.

@ This function is not available for the scanner projects.

* Delete single points allows to reject points measured on single images;

* Delete points with correlation below threshold allows to delete points previously
measured using correlator, if their correlation coefficient in below threshold value
specified in the Correlation threshold field of the Automatic tie point measurement
window;

% It is recommended to use the option for recurrent or final points filtration, since the filtering
covers all measured points, not only new ones, added during just another start of automatic
tie points measurement operation.

* Delete points surplus allows to delete points, if their number exceeds number spe-
cified in the Points per stereopair field of the Automatic tie point measurement
window, sorted by the Y-parallax in descending order;

% The parameter considers whether the Filter points by zones checkbox is marked, that allows
to delete points evenly. It is recommended to use the option after the initial tie points meas-
urement on UAS images.

é The points are deleted regardless of type and number of measurements per point (the system
may delete both GC point and the points in triple overlap).

» Check correlation of measurements transferred from other stereopairs is used
to check on each stereopair correlation coefficient of measurements, collected during
points transfer from other stereopairs, since the chain of such transfers may lead to
errors accumulation and bring unacceptable result;
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X-parallax clipping (%) allows to specify number of points with minimal and maximal
x-parallax (relatively to total amount of points) which will be deleted after filtering in
strip and between strips.

@ It is recommended to apply this rejection method if erroneous points are dispersed clearly
along stereopair basis (if, for example, a highway with bright marking goes in parallel to survey
basis and correlator puts points on marking line elements, which do not correspond with each

other.

@ This function is not available for the scanner projects.

Check by reverse stereopair —allows to check the search results on reverse stereo-
pair; if the results are not equal, point deletes;

-

-
. Tie point measurement parameters @

| Search for points Correlator Filter tie points | Miscellaneous |

Search for points i

Al

Murmnber automatically measured points starting with (0=auto): 0

Minimum distance between points, pix: 5 =
Minimumn dispersion: 3 =
Pyramid level for preliminary search: 4

m

|| Fixed search sequence

"Points per stereopair” means:
(7} Points to add per session

(@ Target number of points on a stereopair B

Ak

Minimum trusted points group size: 15

Ak

Maximum spread radius within trusted points group, pix: 100

Ak

Maximum points to use filtering by trusted group: 40

Stereopairs

Create stereopairs based on exterior orientation data,
from images, projection centers of which are within range of
.00 M

from different strips anly

oK ] [ Cancel

Fig. 111. Miscellaneous parameters

The Miscellaneous tab contains sections and options to setup the following additional
parameters:
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* Number automatically measured points starting with is used for automatic num-
bering of measured tie points starting with number, specified in the entry field, that
allows to distinguish these points from the ones already measured on the project
images;

Regardless of the set value, the system does not generate points with duplicate numbers. If
the point with some number already exists, then this number will be skipped when creating
new points.

* Minimum distance between points (pix) allows to specify minimal distance in pixels
between points measured on the image;

@ It is recommended to increase the value of this parameter, when the problems with block
adjustment occur. The parameter is considered only during measurement new points. Existing
tie points are not rejected.

* Minimal dispersion allows to specify minimal dispersion of mask to protect from
points search on the clouds and water bodies;

@ The option is used to exclude points in monotonous areas, for example, for satellite scanner
images, if there are black strips on images borders, and for overexposure due to cloudiness.

* Pyramid level for preliminary search (only for central projection images) — allows
to choose an image pyramid level used to preliminary search of points. If the checkbox
is set on, preliminary search is performed by source image;

» Fixed search sequence — allows to obtain the same results of automatic measure-
ment of tie points coordinates during multiple runs of the operation with the same
initial parameters;

* The “Points per stereopair” parameter influences on the Points per stereopair
parameters located in the Automatic tie point measurement window and allows to
select the following number of points:

o Points to add per session — values specified in the main window, that mean a
number of new points, which will be added to already measured ones;

o Target number of points on a stereopair — values specified in the main window,
that define total points number;

g The resulting number of measured points may be both greater than a predetermined amount —
due to points transfer from adjacent stereopairs, and less due to the subsequent rejection of
points. Default value is 30 points on each in-strip images pair, and 10 points — in inter-strip
overlap. The minimum number of points to control the vertical parallax residual is 6.
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» parameters which allow to specify trusted points group to be used as a master sample
for points rejection (see the Preliminary filtering with detection of trusted points
group parameter on the Rejection tab). A group of points is considered as trusted
if the following two conditions are met during the points search:

1. The distance between the point on one image and the corresponding point on
another image should not exceed the parameter specified in the Maximum
spread radius within trusted points group input field.

2. Number of points found, which satisfy to the first condition should not be less
than the parameter specified in the Minimum trusted points group size input
field.

If a trusted group has been found, it supposedly means that angles of relative orient-
ation have been computed correctly and the points rejection can be performed using
these data. Otherwise, the rejection of points will not be executed, even if the Prelim-
inary filtering with detection of trusted points group checkbox is set on the Re-
jection tab.

The Maximum points to use filtering by trusted group parameter is used to specify
the limitation on the number of points to reject.

@ It is recommended to set the Maximum points to use filtering by trusted group value from
40 to 60. It is not recommended to set more than 60 points.

The Stereopairs section contains the following parameters:

» Create stereopairs based on exterior orientation data, from images, projection
centers of which are within range of — if this option is checked, the stereopairs will
be composed from images, projection centers of which are located at the distance
no more than a specified value (in meters), otherwise, the stereopairs are composed
from nearest images in a strip.

* From different strips only — if this option is checked, the in-strip stereopairs will not
be considered. Otherwise, all in-strip stereopairs will be considered, including the
nonadjacent.
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p
. Tie point measurement parameters
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Fig. 112. Miscellaneous parameters

The Zones section allows to define a zone size on a stereopair, where the system
performs automatic search and measurement of tie points coordinates. Information

about recommended zones is located in the Section 5.1.

The Points transfer section contains the following parameters:

+ Strict limits for initial point position — if the checkbox is set, the system performs
search for a point only inside of image, otherwise, the search is possible out of the
image boundary, if the Search area parameter value on the Search for points tab

exceeds the image size.

+ Tie points, measured manually — allows to transfer and filter tie points, measured

manually.

é If checkboxes for filter are set on, but checkboxes for transfer are set off, filter does not per-
form, because there is no transfered points.

* GC points, measured manually — allows to transfer and filter GC points, measured

manually.
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@ If checkboxes for filter are set on, but checkboxes for transfer are set off, filter does not per-
form, because there is no transfered points.

* Points, measured automatically — allows to transfer and filter GC points, measured
automatically.

% If checkboxes for filter are set on, but checkboxes for transfer are set off, filter does not per-
form, because there is no transfered points.

The Rejection by angles section allows to specify parameters of measured points fil-
tering by single or multiple relative orientation parameters of the right or left image.

In some cases after automatic measurement of tie points coordinates due to erroneous
points the images are rotated in a block and their relative orientation parameters are
calculated incorrectly. To prevent images rotation the filtering of measured tie points
by the values of the rotation angle is used. To do this it is necessary to change angles
threshold value (in degrees) for each of stereopair elements. As a result, the points
which cause exceeding of angles thresholds will be rejected after relative orientation
recalculation.

c Itis not recommended to use this method of rejection for blocks, in which the images can actually

be rotated in relation to each other, since in this case the likelihood of removing properly placed
tie points increases.

5.7.2. Feature based correlator

c This function is not available for the central projection projects.

é The object-oriented correlator provides for correct automatic measurement of tie points in imagery
with missing exterior orientation elements (metadata). Further successful adjustment of similar
projects is possible if georeferenced data are available.

Automatic measurement of tie points coordinates
To measure tie points coordinates in automatic mode perform the following actions:

1. Choose Orientation > Automatic tie point measurement » Satellite scanner
survey > Feature based correlator. Automatic tie points measurement window
opens.

é For automatic measurements all images are selected by default. For tie points search just
on selected images clear the checkbox Select all images for automatic tie point meas-
urement on the Orientation tab of the Parameters window.

2. Set the main parameters for tie points search, measure and filter.
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3. [optional] In order to use distributed processing during measurement of tie points
coordinates, perform the following actions:

1. Change settings and run the distributed processing server/client (see the “Dis-
tributed processing” chapter in the “General information about system” User
Manual).

2. Click the Distributed processing... button. The Distributed processing set-
tings window opens.

Specify the Maximum number of parallel tasks value is displayed in the
window. This parameter shows how many processing tasks is possible to divide
the current project to.

é In case the workstation processor supports the hyperthreading technology, it is recom-
mended to reduce the maximum number of parallel tasks by half in order to ensure
system’s stability.

& Hyper-threading (hyper-threading technology) is simultaneous multithreading imple-
mentation used to improve parallelization of computations. With HTT, one physical
core appears as two processors to the operating system, allowing concurrent
scheduling of two processes per core.

’. Distributed processing settings @l—'ﬁ:—h}

Maximum number of parallel tasks

2

4|k

QK ] | Cancel

L5 "

Fig. 113. Parameters of distributed measurement of tie points in automatic mode

3. Click OK to go back to previous window.

% The Progress bar remains open during the entire operation running, allowing the user
to directly monitor the progress of data processing from the PHOTOMOD interface
without opening the Monitor for distributed processing (see “Progress bar for dis-

tributed processing” in the “General information” User Manual).

4. Click the OK button in the Automatic tie points measurement window to start
operation of automatic measurement of points coordinates.

5. Open the relative orientation report to view results of relative orientation operation
and to fix measurement errors.
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Main parameters of tie points measurement

The Automatic tie points measurement window allows to use parameters presets of
tie points measurement, or to manually choose the optimal combination of basic and
additional parameters for automatic tie points search, measurement and filtering.

Choose Orientation » Automatic tie point measurement » Satellite scanner survey»
Feature based correlator. Automatic tie points measurement window opens.

b ~
. Automatic Tie Point Measurement &J
HE: 3 =B oE SE(m = V| Automatic pyramid level detection
Name @E Starting pyramid level :
4 [J] SCENE5123-25406_09 2708 14 401 T BE Ending pyramid level 3 -
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4 [J] SCENE5125-254 0609 1608 26 091 T Mirimum intersection angle 01 ile
/] SCENE5125-254 06 09 1608 _26 091 T :
4 [7] SCENE5125-25506.09 1608 26 171 T e parameters
| SCENES5125-25506 091608 26 17171 Size: 3000 T pix.
4 || SCENES5125-25606_09 1608 26 251 T a -
verlap: 25.0 S %
/] SCENE5125-256 06 09 1608_26 251 T
4 [J] SCENE5126-25506 09 010814 3927 - —
7] SCENE 5126-25506_09_01 08_14 392 T dgzErl =I(R) HD Graphics 2500
4 [J] SCENE5126-25606_09 0108 14 4727 /| Filter before merging
] SCENE5126-25606 09 0108 14 4727
Search on total image area
| Filter after merging
V| Adjust
Adjustment parameters
/| Create stereopairs
Use DEM
nsupport/Rostov_SPOT [Rostov_Copy_Greg)
V| Delete intermediate data
|Dish’ibuted prcr_essing| [ O ] | Cancel

Fig. 114. The Automatic tie points measurement window

The Automatic tie points measurement window includes the following interface ele-
ments:

+ the images selection toolbar used to open auxiliary windows, to save and load sets
of parameters;

+ a list of project images allows to select images, scheduled to perform automatic
measuring of tie points coordinates;

 the parameters used to specify main parameters of automatic measuring of tie points
coordinates;

 the Ok button used to launch an operation of tie points measurement and to perform
relative orientation in automatic mode;
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+ the Distributed processing button is used for automatic tie points measurement in
distributed processing mode.

The system provides the following buttons in the toolbar to work with auxiliary windows:

» EE - allows to select stereopairs where there is no tie points coordinates measure-
ments, and their adjacent images;

* EE — allows to select triplets without tie points ;

» EE — allows to select interstrip stereopairs where there is no tie points coordinates
measurements;

% When searching for stereopairs and triplets, excluded (%) points are also not taken into ac-
count. The Excluded status (in this case) is equivalent to no measurements. The user can
change the status of a point using the appropriate tools of the Triangulation points window.

To configure automatic tie points measurement the following parameters are used:

» The system allows for manual setting the initial and final levels of the pyramid of im-
ages, which are used to search for points, if the Automatic pyramid level detection
led to unsatisfactory results.

% Start pyramid level —it is recommended to increase the value of starting pyramid level when
system performance is insufficient, and when there is no high requirements to processing
results accuracy. Recommended value of starting pyramid level is 2. When processing data
with small overlap, it is recommended to set the initial pyramid level equal to 1. The value of
the starting pyramid level that equals to zero provides maximum accuracy of the results, but

leads to increasing of data processing time;

End pyramid level — it is recommended to increase the value of ending pyramid level when
using data with different resolution (including cases of significant difference in spatial resolution
within one image).

+ Maximum vertical parallax (in pixels) — threshold value for rejection executed after
points measuring/transfer. On each step of rejection process, the program searches
for the point with maximal Y-parallax on the stereopair and rejects it. After that, it
makes relative orientation once more and the iteration is executed until maximal Y-
parallax exceeds the parameter specified here, or until 6 points or less remain on
stereopair. Recommended value is a pixel size;

* Points per stereopair — allows to specify a number of points to be measured on in-
strip and inter-strip stereopairs;

g Resulting amount of measured points may be either greater than a predetermined amount —
because of points transfer from adjacent stereopairs, or less due to further filtering. Default
amount of points is 30 per each images pair in forward overlap and 10 points in side overlap.
The minimum number of points to perform control by the vertical parallax residual — 6 points.
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* Minimum convergence angle for approximation (in degrees) — allows to filter
points on images with convergence angle of smaller or null value, using affine model
(considering these images as a mono images);

» Tile parameters — allows to set the Size (in pixels) and the Overlap (in percents) of
the tiles (the separate image fragments, where points measurement and filtering
should be performed);

» To increase the system performance through graphic processing unit resources, set
the Use GPU checkbox and select the desired device from the drop-down list;

@ The intensity of GPU usage can be monitored using various free software. Windows 10 users
can monitor GPU activity through the Windows Task Manager (Performance Tab).

@ Itis recommended to use modern graphics adapters with at least 4-6 GB of memory, especially
in the case of parallel execution of several tasks in distributed processing mode.

It should be considered that the performance of a video adapter as an extra device for com-
putations is not directly dependent on its memory amount but is influenced by the algorithms
used and features of the system architecture.If there is a choice, first of all, NVidia video ad-
apters are preferable.

A During distributed processing, video adapters are to be selected in the Monitor for Distributed
Processing window, individually for each computer used as a distributed processing client
(see “Computers” in the “General information” User Manual. However, video adapters’ re-
sources will be used for distributed computations only if the Use GPU checkbox is set in the

current window.

If the computer used to configure the operation options (server) is also used as one of the
clients, the selection of the video adapter used by it is also carried out through the Monitor
for Distributed Processing, regardless of which device was selected in the drop-down list
in the current window (this choice is taken into account only in the case of standard data
processing mode).

* [optional] Clear the Filter before merging checkbox to avoid rejecting the found
points at the stage of processing individual elements of the image block.

% This rejection method is less rigorous. It is recommended to disable point filter after merging
first.

 [optional] clear the Search on total image area checkbox, to exclude from tie point
search those areas of a block where there are no image overlap according to rough
block layout results. This will allow to increase the system speed and improve the
correlator accuracy.

é This checkbox is recommended only if primary block layout was performed correctly, after
visual estimation of image positions.
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* [optional] Clear the Filter after merging checkbox to avoid rejecting the found points
at the stage of analyzing final search results.

% This rejection method is more rigorous than filter before merging.

 [optional] clear the adjust checkbox if the preliminary adjustment operation is not
necessary at this stage of the project. Otherwise, set the adjustment parameters:

é The RPC-method is used during the preliminary adjustment. Corrections, which are applied
to RPC coefficients during adjustment are defined automatically by number of GCP and tie
points.

To achieve optimal results, repeated project adjustment with manual configuration of all ne-

cessary parameters may be required afterwards, see also the “Adjustment of scanner blocks”
chapter of the “Block adjustment” User Manual.

o [optional] set the Create stereopairs checkbox to perform adjustment with stereo-
pairs creation. The program will form stereopairs by the following parameters of
images overlap:

% See also the “Manual creation of stereopairs” chapter of the “Block adjustment” User
Manual.

m Overlapping area percentage — at least 1 percent;
m Convergence angle — from 10 to 91 degrees;
m The Sun azimuth difference does not exceed 15 degrees;
Q The'maximum difference-of Sun position angles at the moment of taking each of the
two images of a stereopair.
m The Sun elevation difference does not exceed 15 degrees.
The maximum difference of the Sun elevation over the horizon at the moment of taking

each of the two images of a stereopair.

o [optional] set the Use DEM checkbox to consider DEM in adjustment. Otherwise
the program will use constant elevation of relief instead of DEM (if it was specified
by user — see the “Project properties” chapter of the “Creating project” User
Manual).

é It is highly recommended to Use DEM whenever possible, especially if the decision not
to create stereopairs is made
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 [optional] clear the Delete intermediate data checkbox to not to delete processing
data after computation is complete. It is recommended to leave the checkbox set if
automatic re-measurement of tie points coordinates is not planned;

g The intermediate processing data may occupy a significant.

5.8. Automatic measurement of tie points coordinates (aerial
survey)

5.8.1. Area correlator

c This function is not available for the satellite scanner imagery or ADS projects.

Automatic measurement of tie points coordinates
To measure tie points coordinates in automatic mode perform the following actions:

1. Choose Orientation > Automatic tie point measurement » Aerial survey (Area
correlator). Automatic tie points measurement window opens.

ﬁ For automatic measurements all images are selected by default. For tie points search just
on selected images clear the checkbox Select all images for automatic tie point meas-
urement on the Orientation tab of the Parameters window.

2. Use default setting of measurement parameters or set manually the main parameters
for tie points search, measure and filter.

3. [optional] For more detailed tuning and refining of the main measurement parameters
set the additional parameters.

4. [optional] In order to use distributed processing during measurement of tie points
coordinates, perform the following actions:

1. Click the Distributed processing... button. The Distributed measurement
of tie points window opens.

The Maximum number of tasks for this project value is displayed in the
window. This parameter shows how many processing tasks is possible to divide
the current project to.
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Fig. 115. Parameters of distributed measurement of tie points in automatic mode

2. Specify the Number of tasks to create, which will be processed on one com-
puter. See the description of distributed processing setup in the General inform-
ation User Manual.

3. Click OK to go back to previous window.

5. Click the Start button in the Automatic tie points measurement window to start
operation of automatic measurement of points coordinates.

6. Open the relative orientation report to view results of relative orientation operation
and to fix measurement errors.

@ The report will open automatically after the operation completion, if the appropriate
checkbox is set (see below).

Main parameters of tie points measurement

The Automatic tie points measurement window allows to use presets of tie points
measurements, or manually choose optimal combination of basic and additional para-
meters for automatic search, measurement and filtering of tie points.

Choose Orientation » Automatic tie point measurement > Aerial survey (Area cor-
relator). The Automatic tie points measurement window opens.
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Fig. 116. The Automatic tie points measurement window

The Automatic tie points measurement window includes the following interface ele-
ments:

+ the images selection toolbar used to open auxiliary windows, to save and load sets
of parameters;

+ a list of project images allows to select images, scheduled to perform automatic
measuring of tie points coordinates;

+ the Tasks section used to specify main actions (measurement, transfer, filtering, re-
porting) during operation of automatic measuring of tie points coordinates;

» the Parameters section used to specify main parameters of automatic measuring of
tie points coordinates;

» the More button used to setup additional parameters of measuring of tie points co-
ordinates;
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the Start button used to launch an operation of tie points measurement and to perform
relative orientation in automatic mode;

the Distributed processing button is used for automatic tie points measurement in
distributed processing mode.

The system provides the following buttons in the toolbar to work with auxiliary windows:

®E — allows to select stereopairs where there is no tie points coordinates measure-
ments, and their adjacent images;

®E — allows to select triplets without tie points;

EE — allows to select interstrip stereopairs where there is no tie points coordinates
measurements;

@ When searching for stereopairs and triplets, excluded (%) points are also not taken into ac-
count. The Excluded status (in this case) is equivalent to no measurements. The user can
change the status of a point using the appropriate tools of the Triangulation points window.

— allows (in case of already existing measured tie points) to deselect stereopairs,
triplets, and inter-strip stereopairs by setting the following:

o Minimum points for inter-strip pairs;

o Minimum points for in-strip pairs;

o Minimum points for triplets.

{E — allows to open the Relative orientation report settings window used to specify
parameters and view a relative orientation report;

#= — allows to open the Triangulation points window used to view a list of triangu-
lation points;

00 _ allows to open the Points measurement module and open automatically open
images selected in the list, if more than 6 images are chosen. Otherwise, an in-strip
stereopair with image selected in the list will be opened.

To save and load sets of main and auxiliary parameters the system provides the following
buttons:

l= — is used to load a set of parameters from *.x-1ini file saved previously in active
profile resources or out of them.

The arrow located next to the = button allows to open a drop-down menu containing
the following items:
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o Load settings from file allows to open the Load settings window used to load a
set of parameters from *.x-1ini file, located out of active profile resources;

o Reset settings to defaults allows to use default settings;

. — used to save setting of main and additional parameters to a file with *.x-ini
extension in active profile resources.

§ To save setting to a file with *.x-1ni extension located out of active profile resources, open
drop-down list by clicking the arrow next to the [&| button and choose Save settings to file....

Setting saving is used to create files with settings directed to work with certain type of block,
kind of images, or terrain, etc.

The Tasks section is used to specify the following actions during automatic tie points
measurement:

* Measure tie points in stereopairs allows to perform search and measurement of
tie points coordinates on in-strip and inter-strip stereopairs;

§ A stereopair is called in-strip, if it is formed by two adjacent images in a strip, and inter-strip
is any other stereopair of a block.

» Transfer tie points allows to perform transfer of measured points to adjacent stereo-
pairs (transfer of points located in triple overlap area to adjacent models), and transfer
of tie points to adjacent strips;

* Filter tie points by relative orientation allows to perform points filtering that have
measurements, exceeding specified values of errors thresholds;

% Points check if to filter them or not, is performed sequentially by errors type — first check -
whether the point falls within specified correlation threshold, then whether it does not exceed
maximal vertical parallax value, and finally, search for triplet errors is performed, if the appro-

priate option is specified.

Check for exceeding correlation threshold is applied only to new points (if measured points
are already available). In order to check all points whether they exceed correlation threshold,
set the additional Delete points with correlation below threshold checkbox on the Rejection
tab in the Tie point measurement parameters window of additional parameters.

% It is possible to perform actions with tie points inside strips, between strips, or not perform at
all.

* Filter tie points by adjustment results allows to perform automatic block adjustment
using specified parameters and to filter measured tie points after that;
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Points filtering using adjustment results is applied if there are blunders on images between
strips. The filtering is performed using residuals tolerance specified in the Adjustment
parameters window, see the “Block adjustment” User Manual.

* Report on relative orientation on completion allows to open the Relative orient-
ation report window automatically to view and edit tie points measurements just
after completing of automatic relative orientation.

The Parameters section allows to make the following settings of automatic measurement
of tie points coordinates:

* Points per stereopair — allows to specify a number of points to be measured on in-
strip and inter-strip stereopairs;

g Resulting amount of measured points may be either greater than a predetermined amount —
because of points transfer from adjacent stereopairs, or less due to further filtering. Default
amount of points is 30 per each images pair in forward overlap and 10 points in side overlap.
The minimum number of points to perform control by the vertical parallax residual — 6 points.

@ The Points per stereopair parameter depends on settings defined on the Miscellaneous
tab in the Tie point measurement parameters window.

» Correlation threshold (%) — minimal acceptable value of correlation coefficient for
tie points, that will be selected during automatic search;

g Recommended values lie in range from 90 to 95%. In contrast to all other filtering criteria,
this parameter directly influences on operation of points measurement and transfer. Check
for exceeding of correlation threshold is performed only for new points (if there are already
measured points). To check all measured points for exceeding of correlation threshold (usually,
at final stage of collecting measurements of tie points) set the additional Delete points with
correlation below threshold checkbox on the Rejection tab in the additional parameters
window.

« Maximum vertical parallax (in pixels or mm) — threshold value for rejection executed
after points measuring/transfer. On each step of rejection process, the program
searches for the point with maximal Y-parallax on the stereopair and rejects it. After
that, it makes relative orientation once more and the iteration is executed until max-
imal Y-parallax exceeds the parameter specified here, or until 6 points or less remain
on stereopair. Recommended value is a pixel size;

* Maximum error in triplets in XY-plane and by Z (in pixels, meters or mm) — threshold
discrepancy of points measurements on adjacent stereopairs in triple overlapping
zone of adjacent images in a strip. Use the following formula to calculate values of
acceptable errors in triplets:

Epee = 2 Epean» Where E,.., — acceptable mean error (recommended acceptable
mean error value — 0.5 pix.).

182


solver.pdf

PHOTOMOD 8.1 Aerial triangulation (Windows x64)

Mean triplet errors in XY plane is calculated using the following formula:
RMS =~ V2 Epean

Mean error by Z equals the mean error value in XY plane multiplied by the ratio of
focal length (f) to survey basis (b):

z  _f v
Emean_g Emean'

* Measure points by zones — allows to apply a method of sequential measurement
by zones of overlap area. If the checkbox is cleared, points search is performed over
the whole area of images overlap. The system allows to select zones and define their
size in the Zones section on the Miscellaneous tab of the additional parameters
window;

* Filter points by zones — is used to filter points in stereopair zones sequentially;

§ The operation provides filtering the worst (by parallax) points on stereopair, passing zone by
zone one after another. So the worst point on stereopair is found and deleted first, then the
worst one in the next zone and so on. Uniformity of point’s distribution on stereopair is also

verified in such a way.

* DEM - allows to choose a DEM (if any) to consider its data during automatic tie points
measurement. For this it is necessary to have saved adjustment results available.

§ This parameter allows to use DEM for calculation of the true position of the point. Thereby
the required search area of points reduces.

% Click the [ button to clear a DEM.

Additional parameters of automatic measurement of tie points coordinates

For more detailed setup and adjustment and refinement of the basic parameters of tie
points coordinates measurement the Tie point measurement parameters window of
additional parameters is used. It is opened using the More button located in the main
Automatic tie point measurement window.
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Fig. 117. Points search parameters
The Tie point measurement parameters window contains four tabs with parameters.

ﬁ To reset to default parameters, delete the ProjCorrMatchOptions.x-ini file located in the project
root folder.

The Search for points tab allows to setup the following parameters:
+ Search area (pix) — allows to specify a “halfsize” of area of matching point search;

» Contrast point search area (pix) allows to search tie points in areas with maximal
contrast (on images with clear objects outlines);

@ In some cases it is reasonable to measure points in areas with low contrast, for example,
when forested areas have maximal contrast, and in these areas correlator’s errors are very
probable. In this case the Contrast point search area value should be set to 0.

» Tries per point — number of tries of matching point search with correlation coefficient
value that exceeds specified in the search area;

* Multipass points search allows to perform points search and filtering on stereopairs
in multiple passes with help of different algorithms. It is applied in case of insufficient
quality of the block layout, when real relative rotation of images relative to each other
is sufficiently big;

c For multipass points search it is recommended to set correlation threshold high enough, for
example, 95%.

é It is recommended to use multipass points search for UAS images.
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» Search the whole images area allows to specify images pairs to search points: ad-
jacent images in each strip and/or non-adjacent pairs of images in a strip and inter-
strip pairs of images.

N N
. Tie point measurement parameters @
Search for points Correlator Filter tie points Miscellaneous
Correlation matrix half-size: Do not use image border area:
X:o12 | -¥, %ofwidth: 0 =
¥ 12 = | -¥, % ofheight: 0 =
| Autocorrelation control Image blur
Maximum value: 30 = I_J
LUze correlation by absolute value
Mo Strong blur

Ok ] | Cancel

Fig. 118. Parameters of correlator

The Correlator tab is used to setup parameters of area correlator work and contains
the following parameters:

» Correlation matrix half size (pix) allows to specify size of correlation matrix by X
and Y axes;

» Autocorrelation control allows to specify level of auto-correlation — the Maximum
value of sigma in Gaussoid that is the top limit of distribution of the mask correlation
coefficient in a small area on the same image. The more the sigma value, the less
probability of correct points measurement, which were measured using correlation
with the given point as an initial one;

* Do not use image border area is used to specify a size of area near the image
border, that is not used during correlation operation;

ﬁ Service area width (2% of image width and height by default) should not be less than on the

image; otherwise a big amount of “bad” points would be measured in image service areas.

» the Image blur slider is used to consider image material quality, from No to Strong
blur.

é For images without blur or with negligible blur it is highly not recommended to place the slider
to position different from No.
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@ In most cases the Image blur parameter is applied for processing of UAS images block.
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Fig. 119. Filtering parameters

The Rejection tab is used to setup filtering parameters of points found and contains
the following options:

* Preliminary filtering with detection of trusted points group is used to preliminary
filtering of blunders, that do not allow calculate correctly angular elements of relative
orientation (see the parameters of trusted points group on the Miscellaneous tab);

* Delete all tie points, if after filtering number of them left is less then specified
number — allows to delete all tie points on a stereopair, acquired during operation of
automatic measurement of points coordinates, if after their filtering their number is
not sufficient to perform correct relative orientation;

* Delete measurements on non-adjacent images allows to filter potentially erroneous
points, measured on non-adjacent images inside a strip;

§ To measure tie points for UAS images in two steps it is recommended to set the Delete
measurements on non-adjacent images checkbox on the first step and to not to use this
parameter on the second step.

» Delete single points allows to reject points measured on single images;

* Delete points with correlation below threshold allows to delete points previously
measured using correlator, if their correlation coefficient in below threshold value
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specified in the Correlation threshold field of the Automatic tie point measurement
window;

% It is recommended to use the option for recurrent or final points filtration, since the filtering
covers all measured points, not only new ones, added during just another start of automatic
tie points measurement operation.

* Delete points surplus allows to delete points, if their number exceeds number spe-
cified in the Points per stereopair field of the Automatic tie point measurement
window, sorted by the Y-parallax in descending order;

@ The parameter considers whether the Filter points by zones checkbox is marked, that allows
to delete points evenly. It is recommended to use the option after the initial tie points meas-
urement on UAS images.

é The points are deleted regardless of type and number of measurements per point (the system
may delete both GC point and the points in triple overlap).

* Check correlation of measurements transferred from other stereopairs is used
to check on each stereopair correlation coefficient of measurements, collected during
points transfer from other stereopairs, since the chain of such transfers may lead to
errors accumulation and bring unacceptable result;

+ X-parallax clipping (%) allows to specify number of points with minimal and maximal
x-parallax (relatively to total amount of points) which will be deleted after filtering in
strip and between strips.

é It is recommended to apply this rejection method if erroneous points are dispersed clearly
along stereopair basis (if, for example, a highway with bright marking goes in parallel to survey
basis and correlator puts points on marking line elements, which do not correspond with each

other.

* Check by reverse stereopair —allows to check the search results on reverse stereo-
pair; if the results are not equal, point deletes;
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Fig. 120. Miscellaneous parameters

The Miscellaneous tab contains sections and options to setup the following additional
parameters:

* Number automatically measured points starting with is used for automatic num-
bering of measured tie points starting with number, specified in the entry field, that
allows to distinguish these points from the ones already measured on the project
images;

Regardless of the set value, the system does not generate points with duplicate numbers. If
the point with some number already exists, then this number will be skipped when creating
new points.

* Minimum distance between points (pix) allows to specify minimal distance in pixels
between points measured on the image;

é It is recommended to increase the value of this parameter, when the problems with block
adjustment occur. The parameter is considered only during measurement new points. Existing
tie points are not rejected.
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Minimal dispersion allows to specify minimal dispersion of mask to protect from
points search on the clouds and water bodies;

% The option is used to exclude points in monotonous areas, for example, for satellite scanner
images, if there are black strips on images borders, and for overexposure due to cloudiness.

Pyramid level for preliminary search (only for central projection images) — allows
to choose an image pyramid level used to preliminary search of points. If the checkbox
is set on, preliminary search is performed by source image;

Fixed search sequence — allows to obtain the same results of automatic measure-
ment of tie points coordinates during multiple runs of the operation with the same
initial parameters;

The “Points per stereopair” parameter influences on the Points per stereopair
parameters located in the Automatic tie point measurement window and allows to
select the following number of points:

o Points to add per session — values specified in the main window, that mean a
number of new points, which will be added to already measured ones;

o Target number of points on a stereopair — values specified in the main window,
that define total points number;

Q The resulting number of measured points may be both greater than a predetermined amount —
due to points transfer from adjacent stereopairs, and less due to the subsequent rejection of
points. Default value is 30 points on each in-strip images pair, and 10 points — in inter-strip
overlap. The minimum number of points to control the vertical parallax residual is 6.

parameters which allow to specify trusted points group to be used as a master sample
for points rejection (see the Preliminary filtering with detection of trusted points
group parameter on the Rejection tab). A group of points is considered as trusted
if the following two conditions are met during the points search:

1. The distance between the point on one image and the corresponding point on
another image should not exceed the parameter specified in the Maximum
spread radius within trusted points group input field.

2. Number of points found, which satisfy to the first condition should not be less
than the parameter specified in the Minimum trusted points group size input
field.

If a trusted group has been found, it supposedly means that angles of relative orient-
ation have been computed correctly and the points rejection can be performed using
these data. Otherwise, the rejection of points will not be executed, even if the Prelim-
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inary filtering with detection of trusted points group checkbox is set on the Re-
jection tab.

The Maximum points to use filtering by trusted group parameter is used to specify
the limitation on the number of points to reject.

@ It is recommended to set the Maximum points to use filtering by trusted group value from
40 to 60. It is not recommended to set more than 60 points.

The Stereopairs section contains the following parameters:

» Create stereopairs based on exterior orientation data, from images, projection
centers of which are within range of — if this option is checked, the stereopairs will
be composed from images, projection centers of which are located at the distance
no more than a specified value (in meters), otherwise, the stereopairs are composed
from nearest images in a strip.

» From different strips only — if this option is checked, the in-strip stereopairs will not
be considered. Otherwise, all in-strip stereopairs will be considered, including the
nonadjacent.

g N
€ Tie point measurement parameters &J

| Search for points | Correlator | Filter tie points | Miscellaneous

Zones -

Zone size, % 100 [

Paints transfer

|| Strict limits for initial point position
Tie points, measured manually:
Transfer

Filter

GC points, measured manually:

[ Transfer

Filter

GC Points, measured automaticaly:
[ Transfer

[ Filter

Rejection by angles

Maximum relative orientation angle values in strips
Left image Right image

m

Alpha, = (0,00

Kappa, *1 |0.00

[ oK ] I Cancel

Fig. 121. Miscellaneous parameters
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The Zones section allows to define a zone size on a stereopair, where the system
performs automatic search and measurement of tie points coordinates. Information
about recommended zones is located in the Section 5.1.

The Points transfer section contains the following parameters:

+ Strict limits for initial point position — if the checkbox is set, the system performs
search for a point only inside of image, otherwise, the search is possible out of the
image boundary, if the Search area parameter value on the Search for points tab
exceeds the image size.

» Tie points, measured manually — allows to transfer and filter tie points, measured
manually.

@ If checkboxes for filter are set on, but checkboxes for transfer are set off, filter does not per-
form, because there is no transfered points.

* GC points, measured manually — allows to transfer and filter GC points, measured
manually.

@ If checkboxes for filter are set on, but checkboxes for transfer are set off, filter does not per-
form, because there is no transfered points.

+ GC points, measured automatically - allows to transfer and filter GC points,
measured automatically.

@ If checkboxes for filter are set on, but checkboxes for transfer are set off, filter does not per-
form, because there is no transfered points.

The Rejection by angles section allows to specify parameters of measured points fil-
tering by single or multiple relative orientation parameters of the right or left image.

In some cases after automatic measurement of tie points coordinates due to erroneous
points the images are rotated in a block and their relative orientation parameters are
calculated incorrectly. To prevent images rotation the filtering of measured tie points
by the values of the rotation angle is used. To do this it is necessary to change angles
threshold value (in degrees) for each of stereopair elements. As a result, the points
which cause exceeding of angles thresholds will be rejected after relative orientation
recalculation.

c Itis not recommended to use this method of rejection for blocks, in which the images can actually
be rotated in relation to each other, since in this case the likelihood of removing properly placed
tie points increases.
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5.8.2. Feature-based correlator

é This function is not available for the satellite scanner imagery or ADS projects.

Automatic measurement of tie points coordinates
To measure tie points coordinates in automatic mode perform the following actions:

1. Choose Orientation » Automatic tie point measurement » Aerial survey (Feature-
based correlator). Automatic tie points measurement window opens.

é For automatic measurements all images are selected by default. For tie points search just
on selected images clear the checkbox Select all images for automatic tie point meas-
urement on the Orientation tab of the Parameters window.

2. Use default setting of measurement parameters (presets) or set manually the main
parameters for tie points search, measure and filter.

3. [optional] Specify the adjustment parameters, if it is necessary to perform the ad-
justment on the current project step, otherwise — clear the Make block adjustment
checkbox.

4. [optional] In order to use distributed processing during measurement of tie points
coordinates, perform the following actions:

1. Change settings and run the distributed processing server/client (see the “Dis-
tributed processing” chapter in the “General information about system” User
Manual).

2. Click the Distributed processing... button. The Distributed processing set-
tings window opens.

Specify the Maximum number of parallel tasks value is displayed in the
window. This parameter shows how many processing tasks is possible to divide
the current project to.

ﬁ In case the workstation processor supports the hyperthreading technology, it is recom-
mended to reduce the maximum number of parallel tasks by half in order to ensure
system’s stability.

Q Hyper-threading (hyper-threading technology) is simultaneous multithreading imple-
mentation used to improve parallelization of computations. With HTT, one physical
core appears as two processors to the operating system, allowing concurrent
scheduling of two processes per core.
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Maxirnum number of parallel tasks 2
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Fig. 122. Parameters of distributed measurement of tie points in automatic mode

3. The system allows to clear the task list step by step in the distributed pro-
cessing monitor (tasks are removed from the list as they are successfully
completed).

Clearing the task list makes it possible to limit the increasing size of the distrib-
uted processing database, what can significantly affect system performance.

It is strongly suggested to clear the task list when processing large amounts of
data on workstations with limited disk space.

Full display of the task list (for further analysis of their logs) may be feasible
when restarting calculations, if the previous data processing session failed.

4. Click OK to go back to previous window.

? The Progress bar remains open during the entire operation running, allowing the user
to directly monitor the progress of data processing from the PHOTOMOD interface
without opening the Monitor for distributed processing (see “Progress bar for dis-

tributed processing” in the “General information” User Manual).

5. Click the OK button in the Automatic tie points measurement window to start
operation of automatic measurement of points coordinates.

6. The block processing report opens automatically after the operation is completed,
if the adjustment was also carried out (see the Make block adjustment checkbox
below).

Main parameters of tie points measurement

The Automatic tie points measurement window allows to use parameters presets of
tie points measurement, or to manually choose the optimal combination of basic and
additional parameters for automatic tie points search, measurement and filtering.

Choose Orientation > Automatic tie point measurement > Aerial survey (Feature-
based correlator). Automatic tie points measurement window opens.
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Fig. 123. The Automatic tie points measurement window

The Automatic tie points measurement window includes the following interface ele-
ments:

+ the images selection toolbar used to open auxiliary windows, to save and load sets
of parameters;

 a list of project images allows to select images, scheduled to perform automatic
measuring of tie points coordinates;

» the Correlator configuration section is used to load, create and edit sets of para-
meters of automatic tie points measurement,

 the Ok button used to launch an operation of tie points measurement and to perform
relative orientation in automatic mode;

 the Distributed processing button is used for automatic tie points measurement in
distributed processing mode.
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The system provides the following buttons in the toolbar to work with auxiliary windows:

» EE — allows to select stereopairs where there is no tie points coordinates measure-
ments, and their adjacent images;

» EE — allows to select triplets without tie points;

» EE — allows to select interstrip stereopairs where there is no tie points coordinates
measurements;

% When searching for stereopairs and triplets, excluded (%) points are also not taken into ac-
count. The Excluded status (in this case) is equivalent to no measurements. The user can
change the status of a point using the appropriate tools of the Triangulation points window.

To configure automatic tie points measurement and (optionally) for further adjustment
procedure the following parameters are used:

 [optional] clear the Calibrate camera checkbox if camera calibration has already
done and is not needed,;

& It is recommended to clear the Calibrate camera checkbox only if there is reason to trust

the camera calibration. It is necessary to consider, that if the calibration was not carried out

in actual operating conditions, then significant discrepancies in the obtained calibration
parameters may occur.

? If polyplets (sets of several overlapped images located on different strips) are not found, one
of camera calibration stages (calibration by polyplets) will be skipped (an appropriate warning
message will appear). Other calibration stages will be carried out.

% In certain cases, since some coefficients can be dependent, it is impossible to calculate cor-
rections to them (during camera calibration, before performing adjustment). In such cases,
some of these coefficients can be automatically excluded from the calibration process (but
not from the adjustment process) i.e. during data processing, the initial coefficient value will
be used, without introducing corrections. An appropriate info message is to be displayed in
the progress bar (see the “Loading progress window” section in the “General information”

User Manual).

 [optional] set the Make block adjustment checkbox if the adjustment operation is
necessary at this stage of the project;

 [optional] clear the Search on total image area checkbox, to exclude from tie point
search those areas of a block where there are no image overlap according to rough
block layout results. This will allow to increase the system speed and improve the
correlator accuracy.

é This checkbox is recommended only if primary block layout was performed correctly, after
visual estimation of image positions.
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7

In case of aerial survey data processing, primary block layout is as usual quite accurate for
imagery provided with correct elements of exterior orientation and taken with off-nadir angle
no more than 15 degrees.

o In order not to use boundary regions of imagery while search, set the Offset from
image boundaries, % by clicking the _.. | button. The Image margin window
opens. Setimage margins in percent which are not to be involved in points search;

i ’ Offset from image boundaries &Jﬁ
Top, %
0.000 =
Left, % Right, %6
0.000 e 0.000 e
Bottom, %o
0.000 —~
oK ] | Cancel
k. 4

Fig. 124. The Image margin window

» To increase the system performance through graphic processing unit resources, set
the Use GPU checkbox and select the desired device from the drop-down list;

5
5

The intensity of GPU usage can be monitored using various free software. Windows 10 users
can monitor GPU activity through the Windows Task Manager (Performance Tab).

It is recommended to use modern graphics adapters with at least 4-6 GB of memory, especially
in the case of parallel execution of several tasks in distributed processing mode.

It should be considered that the performance of a video adapter as an extra device for com-
putations is not directly dependent on its memory amount but is influenced by the algorithms
used and features of the system architecture.|f there is a choice, first of all, NVidia video ad-
apters are preferable.

During distributed processing, video adapters are to be selected in the Monitor for Distributed
Processing window, individually for each computer used as a distributed processing client
(see “Computers” in the “General information” User Manual. However, video adapters’ re-
sources will be used for distributed computations only if the Use GPU checkbox is set in the
current window.

If the computer used to configure the operation options (server) is also used as one of the
clients, the selection of the video adapter used by it is also carried out through the Monitor
for Distributed Processing, regardless of which device was selected in the drop-down list
in the current window (this choice is taken into account only in the case of standard data
processing mode).
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The Correlator configuration section is used to load, create and edit presets — sets
of parameters of automatic tie points measurement;

+ the download button in the right part of the Correlator configuration section allows
to open the Correlator precision window, which contains a list of available (both
predefined and user-created) presets and the following buttons:

’. Correlator presets Iﬁ
*Cptimal | Create

*Exact
*PHOTOMOD 6.5 —
*Multitime survey

Copy
*Madir-cblique camera -
*Optimal 2 Rename

Fig. 125. The Correlator precision window

o Create — allows to create a custom preset — set of parameters of automatic tie
points measurement. Click the Create button to open the Enter entry window,
where user should enter a name for a preset to be created (default user preset).

. Enter preset name [ 7 |ﬁl

Enter entry

User preset

K ] [ Cancel

Fig. 126. The Enter entry window

@ It is not allowed to create presets with identical names. When you try to create presets
with identical names, the system opens a window with a corresponding error message.

Clicking the OK button opens the Edit parameters window, where you should
manually specify the following parameters:
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Fig. 127. The Edit parameters window

m Starting pyramid level - it is recommended to increase the value of starting
pyramid level when system performance is insufficient, and when there is no
high requirements to processing results accuracy. Recommended value of
starting pyramid level is 1. The value of the starting pyramid level that equals to
zero provides maximum accuracy of the results, but leads to increasing of data
processing time;

% In order to perform the automatic detection of pyramid levels — set the appropriate
checkbox.

m Ending pyramid level — it is recommended to increase the value of ending
pyramid level when using data with different resolution (including cases of signi-
ficant difference in spatial resolution within one image);

% For example, when using data which resolution varies 2 times, it is recommended to
increase the default value of the ending level of the pyramid on the one.

m Maximum vertical parallax (in pixels or mm) — threshold value for rejection
executed after points measuring/transfer. On each step of rejection process, the
program searches for the point with maximal Y-parallax on the stereopair and
rejects it. After that, it makes relative orientation once more and the iteration is
executed until maximal Y-parallax exceeds the parameter specified here, or until
6 points or less remain on stereopair. Recommended value is a pixel size;
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m Points per stereopair — allows to specify a number of points to be measured
on in-strip and inter-strip stereopairs;

g The resulting number of measured points may be both greater than a predetermined
amount — due to points transfer from adjacent stereopairs, and less due to the sub-
sequent rejection of points. Default value is 30 points on each in-strip images pair, and
10 points — in inter-strip overlap. The minimum number of points to control the vertical
parallax residual is 6.

m Minimal correct matching points in pair, in percent allows to exclude from the
processing “bad” stereopairs that do not match the given values. The increase
of this parameter can improve the system performance by excluding a portion
of data from the processing;

@ Default value of this parameter is 30%.

% When the default value increase, an approximate estimation of the system speed change
is displayed — faster than 30% in ... times.

% When the default value decrease, an approximate estimation of the system speed
change is displayed — slower than 30% in ... times.

m Set the Filter non-transferred points checkbox on to reject points located on
inter-strip stereopairs. A point will be filtered, if the system recognizes it on a
single image of some strip.

Set the image pair selection method:

m [optional] by block scheme;

% The Low block layout quality checkbox allows to divide the process of stereopair
search by block scheme into several iterations, thereby increasing the accuracy of final
results.

m [optional] by image centers — set the number of neighbour images and min-
imum distance between centers in stereopair.

% In case of the processing of quite high-quality data with satisfactory overlap, limiting
the number of adjacent images leads to a significant increase of data processing speed,
without affecting the accuracy of the final results.

Limiting the minimum distance between two centers in a stereopair allows to exclude
from processing stereopairs with projection centers that are too close to each other.

When you click OK, the system creates a new user preset — a set of parameters
used for automatic tie points measurement.
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o the Edit button allows to open the Edit parameters window to change settings of
the selected preset.

o the Copy button allows to copy a preset.

o the Rename button allows to rename a preset.

o the Delete button allows to delete a preset.

o the Close button allows to close the Correlator precision window.

» The arrow to the left of the button which opens the Correlator precision window al-
lows to open a drop-down list, used to select one of the following presets.

The system provides a set of predefined presets, allowing to vary the settings of
automatic tie point measurements. Predefined presets are marked by the asterisk
symbol “*” — Optimal, Optimal 2, Multitime survey, Nadir-oblique camera, Exact
and PHOTOMOD 6.5 correlator settings.

@ The system does not allow the user to edit the predefined presets. A copy of the predefined
preset is available for editing, as well as a custom preset.

5.8.3. UAS

c This function is not available for the satellite scanner imagery or ADS projects.

Automatic measurement of tie points coordinates
To measure tie points coordinates in automatic mode perform the following actions:

1. Choose Orientation > Automatic tie point measurement » UAS. The Automatic
tie points measurement window opens.

é For automatic measurements all images are selected by default. For tie points search just
on selected images clear the checkbox Select all images for automatic tie point meas-
urement on the Orientation tab of the Parameters window.

2. Use default settings of measurement parameters (presets) or set manually the main
parameters for tie points search, measure and filter.

3. [optional] Specify the adjustment parameters, if it is necessary to perform the ad-
justment on the current project step, otherwise — clear the Make block adjustment
checkbox.

4. [optional] In order to use distributed processing during measurement of tie points
coordinates, perform the following actions:
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1.

Change settings and run the distributed processing server/client (see the “Dis-
tributed processing” chapter in the “General information about system” User
Manual).

Click the Distributed processing... button. The Distributed processing set-
tings window opens.

Specify the Maximum number of parallel tasks value is displayed in the
window. This parameter shows how many processing tasks is possible to divide
the current project to.

é In case the workstation processor supports the hyperthreading technology, it is recom-
mended to reduce the maximum number of parallel tasks by half in order to ensure
system’s stability.

& Hyper-threading (hyper-threading technology) is simultaneous multithreading imple-
mentation used to improve parallelization of computations. With HTT, one physical
core appears as two processors to the operating system, allowing concurrent
scheduling of two processes per core.

. Distributed processing settings [&J

Property Value

Maximum number of parallel tasks 2
Clear the task list step by step. | Yes

[ OK. l | Cancel |

“ ~

Fig. 128. Parameters of distributed measurement of tie points in automatic mode

The system allows to clear the task list step by step in the distributed pro-
cessing monitor (tasks are removed from the list as they are successfully
completed).

Clearing the task list makes it possible to limit the increasing size of the distrib-
uted processing database, what can significantly affect system performance.

It is strongly suggested to clear the task list when processing large amounts of
data on workstations with limited disk space.

Full display of the task list (for further analysis of their logs) may be feasible
when restarting calculations, if the previous data processing session failed.

4. Click OK to go back to previous window.

@ The Progress bar remains open during the entire operation running, allowing the user
to directly monitor the progress of data processing from the PHOTOMOD interface
without opening the Monitor for distributed processing (see “Progress bar for dis-

tributed processing” in the “General information” User Manual).
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5. Click the OK button in the Automatic tie points measurement window to start
operation of automatic measurement of points coordinates.

6. The block processing report opens automatically after the operation is completed,
if the adjustment was also carried out (see the Make block adjustment checkbox
below).

Main parameters of automatic tie points measurement

The Automatic tie point measurement window allows to use parameters presets of
tie points measurement, or to manually choose the optimal combination of basic and
additional parameters for automatic tie points search, measurement and filtering.

Choose Orientation » Automatic tie point measurement » UAS. The Automatic tie
points measurement window opens.

. Automatic Tie Point Measurement Iéj

Correlator configuration
|’O|:utirna| v| =
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MName ~ | @E
4 [J]1 =
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V) 4 1

7] 3 3
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J] 10
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V18 i

/| Calibrate camera
/| Make block adjustment
| Tie-points rejection by adjustment results

| Search on total image area

Offset from image boundaries, % (0.0, 0.0), (0.0, 0.0)
Use GPU | Intel(R) HD Graphics 2500
Distributed processing | Ok | | Cancel |

L 4

Fig. 129. The Automatic tie points measurement window

The Automatic tie points measurement window includes the following interface ele-
ments:

» the images selection toolbar used to open auxiliary windows, to save and load sets
of parameters;
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a list of project images allows to select images, scheduled to perform automatic
measuring of tie points coordinates;

the Correlator configuration section is used to load, create and edit sets of para-
meters of automatic tie points measurement;

the OK button used to launch an operation of tie points measurement and to perform
relative orientation in automatic mode;

the Distributed processing button is used for automatic tie points measurement in
distributed processing mode.

The system provides the following buttons in the toolbar to work with auxiliary windows:

EE — allows to select stereopairs where there is no tie points coordinates measure-
ments, and their adjacent images;

EE — allows to select triplets without tie points;

EE — allows to select interstrip stereopairs where there is no tie points coordinates
measurements;

§ When searching for stereopairs and triplets, excluded (%) points are also not taken into ac-
count. The Excluded status (in this case) is equivalent to no measurements. The user can
change the status of a point using the appropriate tools of the Triangulation points window.

To configure automatic tie points measurement and (optionally) for further adjustment
procedure the following parameters are used:

[optional] clear the Calibrate camera checkbox if camera calibration has already
done and is not needed;

A It is recommended to clear the Calibrate camera checkbox only if there is reason to trust

the camera calibration. It is necessary to consider, that if the calibration was not carried out

in actual operating conditions, then significant discrepancies in the obtained calibration
parameters may occur.

§ If polyplets (sets of several overlapped images located on different strips) are not found, one
of camera calibration stages (calibration by polyplets) will be skipped (an appropriate warning
message will appear). Other calibration stages will be carried out.

@ In certain cases, since some coefficients can be dependent, it is impossible to calculate cor-
rections to them (during camera calibration, before performing adjustment). In such cases,
some of these coefficients can be automatically excluded from the calibration process (but
not from the adjustment process) i.e. during data processing, the initial coefficient value will
be used, without introducing corrections. An appropriate info message is to be displayed in
the progress bar (see the “Loading progress window” section in the “General information”

User Manual).
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* [optional] clear the Make block adjustment checkbox if the adjustment operation is
not necessary at this stage of the project;

* [optional] clear the Search on total image area checkbox, to exclude from tie point
search those areas of a block where there are no image overlap according to rough
block layout results. This will allow to increase the system speed and improve the
correlator accuracy.

c This checkbox is recommended only if primary block layout was performed correctly, after
visual estimation of image positions.

§ In case of aerial survey data processing, primary block layout is as usual quite accurate for
imagery provided with correct elements of exterior orientation and taken with off-nadir angle
no more than 15 degrees.

o In order not to use boundary regions of imagery while search, set the Offset from
image boundaries, % by clicking the _.. | button. The Image margin window
opens. Set image margins in percent which are not to be involved in points search;

( ‘ Offset from image boundaries Lih,l1

Top, %
0.000 (%

Left, % Right, &

0.000 = 0.000 =
Bottom, %o
0.000 (%
[ OK l | Cancel

Fig. 130. The Image margin window

+ To increase the system performance through graphic processing unit resources, set
the Use GPU checkbox and select the desired device from the drop-down list;

é The intensity of GPU usage can be monitored using various free software. Windows 10 users
can monitor GPU activity through the Windows Task Manager (Performance Tab).

é Itis recommended to use modern graphics adapters with at least 4-6 GB of memory, especially
in the case of parallel execution of several tasks in distributed processing mode.

It should be considered that the performance of a video adapter as an extra device for com-
putations is not directly dependent on its memory amount but is influenced by the algorithms
used and features of the system architecture.If there is a choice, first of all, NVidia video ad-
apters are preferable.

é During distributed processing, video adapters are to be selected in the Monitor for Distributed
Processing window, individually for each computer used as a distributed processing client
(see “Computers” in the “General information” User Manual. However, video adapters’ re-

204


general.pdf

PHOTOMOD 8.1 Aerial triangulation (Windows x64)

sources will be used for distributed computations only if the Use GPU checkbox is set in the
current window.

If the computer used to configure the operation options (server) is also used as one of the
clients, the selection of the video adapter used by it is also carried out through the Monitor
for Distributed Processing, regardless of which device was selected in the drop-down list
in the current window (this choice is taken into account only in the case of standard data
processing mode).

The Correlator configuration section is used to load, create and edit presets — set of
parameters of automatic tie points measurement;

» the download button in the right part of the Correlator configuration section allows
to open the Correlator precision window, which contains a list of available (both
predefined and user-created) presets and the following buttons:

. Correlator presets [ﬁ
*Optimal Create
*Exact -
*PHOTOMOD 6.5 Ed
*Multitime survey -

Copy
*Madir-oblique camera -
*Optimal 2 Paame
| Close |

Fig. 131. The Correlator precision window

o Create — allows to create a custom preset — set of parameters of automatic tie
points measurement. Click the Create button to open the Enter entry window,
where user should enter a name for a preset to be created (default user preset).

. Enter preset name l 2 ﬁ]

Enter entry

User preset

Ok ] | Cancel

Fig. 132. The Enter entry window

é It is not allowed to create presets with identical names. When you try to create presets
with identical names, the system opens a window with a corresponding error message.

Clicking the OK button opens the Edit parameters window, where you should
manually specify the following parameters:
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.
' Edit parameters: User preset L&J

Tie points measurements

| Automatic detection of pyramid levels

Ak

Maximum vertical parallax 3.00

Ak

Mumber of points per stereopair 70

Ak

Min number of correct tie points on pair %  EE
faster than 30% in 2.14 times
Selecting pair of images method
By block scheme

@ By image centers

4k

Mumber of neighbour images 8

Minimum distance between centers in stereopair 0,300 =] m

| Filter not transfered points

[ OK ] | Cancel

Fig. 133. The Edit parameters window

m Starting pyramid level — it is recommended to increase the value of starting
pyramid level when system performance is insufficient, and when there is no
high requirements to processing results accuracy. Recommended value of
starting pyramid level is 1. The value of the starting pyramid level that equals to
zero provides maximum accuracy of the results, but leads to increasing of data
processing time;

Ending pyramid level — it is recommended to increase the value of ending
pyramid level when using data with different resolution (including cases of signi-
ficant difference in spatial resolution within one image);

? For example, when using data which resolution varies 2 times, it is recommended to
increase the default value of the ending level of the pyramid on the one.

Maximum vertical parallax (in pixels or mm) — threshold value for rejection
executed after points measuring/transfer. On each step of rejection process, the
program searches for the point with maximal Y-parallax on the stereopair and
rejects it. After that, it makes relative orientation once more and the iteration is
executed until maximal Y-parallax exceeds the parameter specified here, or until
6 points or less remain on stereopair. Recommended value is a pixel size;

Points per stereopair — allows to specify a number of points to be measured
on in-strip and inter-strip stereopairs;

The resulting number of measured points may be both greater than a predetermined
amount — due to points transfer from adjacent stereopairs, and less due to the sub-
sequent rejection of points. Default value is 30 points on each in-strip images pair, and
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10 points — in inter-strip overlap. The minimum number of points to control the vertical
parallax residual is 6.

m Minimal correct matching points in pair, in percent allows to exclude from the
processing “bad” stereopairs that do not match the given values. The increase
of this parameter can improve the system performance by excluding a portion
of data from the processing;

@ Default value of this parameter is 30%.

§ When the default value increase, an approximate estimation of the system speed change
is displayed — faster than 30% in ... times.

§ When the default value decrease, an approximate estimation of the system speed
change is displayed — slower than 30% in ... times.

m Set the Filter non-transferred points checkbox on to reject points located on
inter-strip stereopairs. A point will be filtered, if the system recognizes it on a
single image of some strip.

Set the image pair selection method:

m [optional] by block scheme;

% The Low block layout quality checkbox allows to divide the process of stereopair
search by block scheme into several iterations, thereby increasing the accuracy of final
results.

m [optional] by image centers — set the number of neighbour images and min-
imum distance between centers in stereopair.

% In case of the processing of quite high-quality data with satisfactory overlap, limiting
the number of adjacent images leads to a significant increase of data processing speed,
without affecting the accuracy of the final results.

Limiting the minimum distance between two centers in a stereopair allows to exclude
from processing stereopairs with projection centers that are too close to each other.

When you click OK, the system creates a new user preset — a set of parameters
used for automatic tie points measurement.

o the Edit button allows to open the Edit parameters window to change settings of
the selected preset.

o the Copy button allows to copy a preset.
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o the Rename button allows to rename a preset.
o the Delete button allows to delete a preset.
o the Close button allows to close the Correlator precision window.

» The arrow to the left of the button which opens the Correlator precision window al-
lows to open a drop-down list, used to select one of the following presets.

The system provides a set of predefined presets, allowing to vary the settings of
automatic tie point measurements. Predefined presets are marked by the asterisk
symbol “*” — Optimal, Optimal 2, Multitime survey, Nadir-oblique camera, Exact
and PHOTOMOD 6.5 correlator settings.

@ The system does not allow the user to edit the predefined presets. A copy of the predefined
preset is available for editing, as well as a custom preset.

5.9. Relative orientation report

5.9.1. Report parameters and output

The system allows to view the results of relative orientation operation after measurement
of tie points coordinates. To view and analyze the data, and control accuracy of relative
orientation the system allows to generate a report, that is formed considering specified
parameters of accuracy control, residuals threshold and data output format.

Relative orientation and accuracy control includes the following steps:
 accuracy control for measurements on stereopairs using residual vertical parallaxes;

» accuracy control for measurements in triple overlap zones using discrepancies in tie
points measurements taken on two adjacent stereopairs (models);

+ control of tie points number and uniformity of their distribution on stereopairs and in
triplets;

« control of difference between kappa angle and a block scheme.

It is possible to view the relative orientation report in the Automatic tie point meas-
urement , Triangulation points windows, and in the Points measurement module
after clicking the i button. Prior to the report appearing the Relative orientation report
settings window opens.

When the report is opened from the Points measurement module, the Relative orient-
ation report settings window is not opened, and the report is shown only for images
opened in the module considering previously set or default parameters. To view and
edit the parameters it is possible to use the link in the report window [Report parameters].
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In order to open the relative orientation report perform the following actions:

1.

Choose Orientation » Relative orientation report or click the {E button in the
toolbar of the Triangulation window. The Relative orientation report settings
window opens. It is used to specify parameters of accuracy control and format of
output results of relative orientation in report.

r N
. Relative orientation report settings @
Main parameters Additional

Show report

@ For all images
) For selected images

[ Add adjacent images

Stereopairs Triplets
Check vertical parallax Check residuals in triplets
Vertical parallax threshaold: Triplet residuals threshold:
DY 0.500000 = XY 1.000000 %1 Z 2.000000 =
@ @ pi 5]
@ pix. 9 RM5 @) pix. 8 RMS
) Mean abs. value ) mm ) Mean abs. value
~ mm
) max m ) max
[ check discrepancy of kappa angle from blodk layout Check number of tie points
Angle discrepancy threshold, degrees: |30.000000 : Minimum number: 2 =

Check number of tie points

Y

Minimum number: & =

[ chedk paint distribution uniformity
[ Chedk errors in interstrip stereopairs

Take into account unadjusted points
[ Use adjustment results for relative orientation

[ OK l [ Cancel

Fig. 134. Parameters of relative orientation report

Select the Main parameters tab (it is selected by default).

In the Show report section specify block images to be included to relative orientation
report:

» to view a general report for the whole images block select the for all images
option;

» to view a report for selected images select the for selected images option;

+ to view a report for selected and their adjacent images select the for selected
images option and set the add adjacent images checkbox.
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4. Inthe Stereopairs section specify the following parameters of accuracy control for
points measurements on block stereopairs:

to check measurements for vertical parallax error select the Check vertical
parallax checkbox and input acceptable threshold value (in pixels or mm) for
selected error type (RMS, mean or maximal error);

@ It is recommended to set the threshold value of maximal error equal to the pixel size.

to check discrepancy of kappa angle from block layout set the Check discrepancy
of kappa angle from block layout checkbox and specify a threshold value of
angles discrepancy in degrees;

% It is recommended to specify Angle discrepancy threshold values from 30 to 45 de-
grees.

to check stereopairs for sufficient measurements number set the Check number
of tie points checkbox and specify minimal number of tie points per stereopair;

% It is recommended to specify Minimal number value not less than 12 point per in-strip
stereopair (2 points per each of 6 standard zones) and at least 2 points per inter-strip
stereopair.

to check distribution uniformity of tie points on stereopairs set the Check point
distribution uniformity checkbox;

% There is non-uniform points distribution on a stereopair, if in each of 6 standard zones

a number of points differs more than 2 times from average amount of points in zone.

to check number of tie points and their distribution uniformity on inter-strip stereo-
pairs set the Check errors in inter-strip stereopairs checkbox.

§ The checkbox is cleared by default, since an analysis of points in 6 standard zones for
inter-strip stereopair is not necessary in many cases.

5. In the Triplets section specify the following parameters of accuracy control for
points measurements in triplets:

to check measurement errors in triplets set the Check residuals in triplets
checkbox and input threshold value by XY and by Z (in pix, mm or meters) for
selected residual type (RMS, mean or maximal error);

QA A threshold value for maximal error in triplets is calculated using the following formula:
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Epnax = 2 Epean » Where E.., —mean error threshold.

Mean triplet errors in XY plane is calculated using the following formula:
RMS = V2 E pean

Mean error by Z equals the mean triplet errors value in XY plane multiplied by the ratio
of focal length (f) to survey basis (b):

z _f X
Emean ~p En{ean'
» to check triplets for sufficient number of measured tie points set the Check

number of tie points checkbox and specify minimal number of points.

@ It is recommended to specify a Minimal number at least 3 points per each triplet.

6. To exclude points without adjustment from the report (see the “Setup of points
symbols” chapter of the “Block adjustment” User Manual), clear the Take into ac-
count unadjusted points checkbox;

7. To use adjustment results for relative orientation control — set the appropriate
checkbox;

8. Open the Additional tab, that includes sections used to setup data view parameters
in the report.

The Residuals format section is used to setup format of errors numeric values in
the report:

 fixed point — is used to set format of errors numeric values accurate within 3
decimal places;

+ exponential — is used to set format of errors numeric values in exponential
notation, where a part of number is replaced with symbols E+n, where E (expo-
nent) means multiplying the preceding number by 10 to the power n.

The Precision section is used to setup output data accuracy, select: normal, high
or maximal.

The Angles section is used to setup angles format in the report:

» Alpha, omega, kappa — angular elements of image exterior orientation (are used
in Russian coordinate systems);
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* omega, phi, kappa — angular elements of image exterior orientation (are used
in International coordinate systems (see the “Block adjustment” User Manual)).

The Angle units section is used to setup format of angles measurements units:
* radians;
* degrees;

+ gons — plane angle measure that equals to 1/100 of a right angle measure,
measurement of full rotation is 400 gons.

.
. Relative orientation report settings 24
Main parameters Additional
Residuals format Angles
@ Fixed point @ Alpha, Omega, Kappa
Exponential Omega, Phi, Kappa
Predision Angle units
@ Mormal @ Radians
High Degrees
Maximal Gons
oK l | Cancel

Fig. 135. Additional report parameters

9. Click OK. The report on relative orientation results is opened. It considers all spe-
cified main and additional parameters (see the Section 5.9.2).

5.9.2. Report view and analysis

Report on relative orientation includes results of relative orientation operation, displays
statistics of tie points measurement, and allows to reveal and eliminate errors of points
measurement. The report is generated for all or for selected project images considering
parameters specified in the Relative orientation report settings window.

é A feature of relative orientation report is the ability to pass to the Points measurement module
directly from the report that allows to eliminate detected measurement errors.

é It is possible to view relative orientation report from different windows of the system using the
iE button. The Relative orientation report settings window opens before the report displaying.

When the report is opened in the Points measurement module, the Relative orientation report
settings window in not opened, and the report is opened only forimages opened in the module
considering preset or default parameters. To view and edit the parameters it is possible to use
the link in the report window [Report parameters].
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= Report [[=1x]
19 BEB &R

Relative Orientation Report E

Jurrp to:

o In-strip measurements;

+ inter-strip measurements

See also

« interior grientation report.
[Back] [Refresh] [Report parameters
Unselect all

Block Statistics

Praoject: Infabap_copy

Mumber of strips: 2, selected for the report 2
MNumber of images: &, selected for the report B
Report date: 17 mapra 2014 r. 13:27:14
[Top]

In-Strip Measurements

Statistics

Stereopairs Triplets
Strips Images

Total Complete Residuals Mot complete Total Complete Residuals Mot complete

2 R10_S05—R10_S07 2 2 0 0 1 1 ] 1}
1

RO8_S87—R09_585 2 2 o o 1 1 1} o

Fig. 136. Relative orientation report
Relative orientation report contains the following main elements and sections:
+ the toolbar with buttons used to perform the following operations:
o 4] — allows to return to previous view of the report;

o — allows to refresh relative orientation results in the report after editing of tie
points in the Points measurement module;

o i#h — allows to perform a search for information in the report;

o [Hl — allows to save report data to files with *.htm, *.html extensions out of active
profile resources;

o — allows to save report data to files with *.htm, *.html extensions in active
profile resources;

o &§ — allows to print a report.
* the links in upper part of a report:

o jump to [in-strip measurements] — allows to view the points measurements inside
strips;
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o jump to [inter-strip measurements] — allows to view the points measurements
between strips;

o see also the [interior orientation report] — allows to open report on interior orientation;
o [Back] — allows to go back to previous report view;

o [Refresh] — allows to refresh relative orientation results in the report after tie points
editing in the Points measurement module;

o [Report parameters] — allows to change the parameters and refresh the report;
o [Unselect all] — allows to cancel data selection in the report;
o [Top] — allows to go to the report top.

» the Block statistics section of a report used to view general statistics, contains the
following information:

o a project name;

o a total number of project strips/images;
o a number of selected strips/images;

o report generating date.

* the In-strip measurements section of a report used to view and analyse points
measurements inside strips, contains the following tables:

o statistics table on in-strip measurements (strips table);
o table of stereopairs of each strip;

o table of triplets of each strip.
§ In inter-strip stereopairs and triplets tables there is a possibility to go to the Points measure-

ment module and open images of selected stereopair/triplet automatically, that allows to edit
points measurements there.

* the Inter-strip measurements section of a report used to view and analyse points
measurements between strips, contains the following tables:
o statistics table on inter-strip measurements;

o table of inter-strip stereopairs.

§ In inter-strip stereopairs tables there is a possibility to open selected stereopair in the Points
measurement module that allows to edit points measurements there.

214



PHOTOMOD 8.1 Aerial triangulation (Windows x64)

5.9.3. The in-strip measurements section

The In-strip measurements section of report is used to view points measurements
results inside a strip and contains the following data:

* Report [C1o[=]
A2 | s B ak
In-Strip Measurements
Statistics
Stereopairs Triplets
Strips Images
Total Complete Residuals et Total Complete Residuals DY
complete complete
2 R10_S05—R10_S07 2 2 i} i} 1 1 i} 0
1 RO9_S87—R09_S85 2 2 0 0 1 1 0 0
[Toa]
Strip: 2
Wertical parallax, pix
Stareopair Mumber of Digcrepancy of kappa Distribution -
P points RMS Mean Max angle, rad uniformity
abs
R10_S05—R10_S06 B6 0.276 0.206 0912 0.00652882 Unifarr t=
R10_S0E—R10_SO7 56 0335 0.256 0.363 0.03222952 Unifarm =
Tie residuals, pix
Triplet Number of points EMS hean abs ax
=9 = =9 E:z (=% E-
R10_S05—R10 SOE—R10_S07 2 0.362 0.7653 0.282 0.629 0.921 1.478
Top -
Cloze

Fig. 137. The “In-strip measurements” section

» Table of strips(Statistics) contains measurements data inside each strip and includes
the following columns:

o the Strips column is used to display a strip name in block;

o the Images column is used to display names of the first and the last images in a
strip;

o the Total column is used to display a number of stereopairs/triplets in each strip;

o the Complete column is used to display a number of stereopairs/triplets with per-
formed relative orientation with errors within specified thresholds;

o the Residuals column is used to display a number of stereopairs/triplets with errors
exceeding specified thresholds;

o the Not complete column is used to display a number of stereopairs/triplets for
which relative orientation is not performed.
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Yellow color highlight is used if relative orientation inside a strip is performed with
errors.

Strips where there is no relative orientation results are highlighted by red color.

» Table of stereopairs contains points measurements data on stereopairs for each strip
and includes the following columns:

o the first column is used for points measurements editing and allows to open the
Points measurement module with images of stereopair selected in the table;

% When editing is completed and the Points measurement module is closed, click the
[Refresh] link in the report to re-calculate relative orientation and refresh the report.

o the Stereopair column is used to display names of images of each stereopair of
a strip;

5 Click the stereopair link to open detailed report on measurements of selected stereopair
(see the Section 5.9.5).

o the Number of points column is used to display a number of points measured on
a stereopair;

o the Vertical parallax column is used to display a value of vertical parallax for all
measurements on a stereopair (RMS, mean abs. and maximal error) considering
threshold parameters, error type and measurement units specified in the Relative
orientation report settings window;

@ A row of stereopair with points which coordinates failed to be calculated, is highlighted by
red color, and in the Vertical parallax column the warning message “Coordinates calcu-
lation failed” is displayed with specifying Y-parallax value in brackets.

o the Discrepancy of kappa angle column is used to display a value of kappa angles
difference (calculated using block scheme) between images.

o the Distribution uniformity column is used to display data about uniform or non-
uniform distribution of points on a stereopair;

ﬁ A distribution of points on a stereopair is considered as non-uniform, when in any of 6
standard zones, on which images overlap area is conventionally divided, a number of
points differs more than twice from average number of points in zone.

o the +/- buttons in the last column allow to highlight/cancel highlight of stereopair
on a block scheme in 2D-window for visual estimation of stereopair location in im-
ages block.

216



PHOTOMOD 8.1 Aerial triangulation (Windows x64)

@ A stereopair is highlighted along with adding it to already highlighted ones in 2D-window.
Cancelling of a stereopair highlighting is performed along with “subtraction” from highlighted
stereopairs.

Stereopairs with measurements errors are highlighted by yellow color, stereopairs
with unavailable relative orientation by red color.

The following errors are shown by red color (they are depending on parameters
specified in the Relative orientation report settings window):

o number of points measured on a stereopair, below specified threshold;
o values of vertical parallax, exceeding specified threshold;
o non-uniformity of points distribution;

@ If there each standard zone contains measurements of coordinates of at least one point,
then a stereopair with measurements errors is highlighted by yellow color.

o difference of kappa angles, that exceeds specified value.

» Table of triplets displays data on measurements in each triplet of a strip and contains
the following columns:

o The first column is used for measurements editing and allows to open the Points
measurement module and to open automatically images of selected triplet at the
same time;

@ After the editing is completed and the Points measurement is closed click the [Refresh]
hyperlink in the report to re-calculate relative orientation and refresh the report.

o the Triplet column is used to display names of images of each triplet in a strip;
§ After clicking the triplet link the detailed report on selected triplet measurements is opened

(see the Section 5.9.6).

o the Number of points column is used to display number of points measured on
triplet;

o the Tie residuals column is used to display values of tie residuals in triplet by XY
and Z (RMS, mean abs. and max error) considering parameters of threshold, error
type and measurement units specified in the Relative orientation report settings
window.

Triplet errors by ties, exceeding specified thresholds, are highlight by red color.
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5.9.4. The inter-strip measurements section

The Inter-strip measurements section of report is used to view points measurements

results inside a strip and contains the following data:

_ Report |_ (O] x|
40 s BE (S
Inter-Strip Measurements
Statistics
Stereopairs
Strips
Total Comnplete Residuals Mot cormplete
2—1 3 — — —
[Top]
strips: 2—1
Wertical parallax, pix
Stereonair Mumber of Discrepancy of kappa Distribution
P points BMS Mean Max angle, rad unifarmity
abs.
E10_S05—R09_587 24 0.318 0.263 0.543 -0.02176829 Mon-unifarm -
R10_S0E—R09_S86 35 0.318 0.239 0.935 -0.03199809 Uniform +=
R10_S07—R0O9_S85 16 0.260 0.219 0.532 -0.05611179 Maon-uniform +=
[Top] ||
Close |

» The inter-strip ties table (Statistics) displays a number of inter-strip stereopairs for
each pair of adjacent strips and presence of measurement errors during relative ori-
entation operation.

» The inter-strip stereopairs table contains the following columns:

o the first column is used to edit points measurements and allows to open the Points
measurement module and to open automatically at the same time images of inter-

Fig. 138. The “Inter-strip measurements” section

strip stereopair selected in the table;

7

o the Stereopair column is used to display names of images of each inter-strip ste-

After the editing is completed and the Points measurement is closed click the [Refresh]

hyperlink in the report to re-calculate relative orientation and refresh the report.

reopair;

7

After clicking the inter-strip stereopair link the detailed report on selected stereopair

measurements is opened (see the Section 5.9.4).
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o the Number of points column is used to display a number of points measured on
inter-strip stereopair;

o the Vertical parallax column is used to display a value of vertical parallax for all
measurements on a inter-strip stereopair (RMS, mean abs. and maximal error)
considering threshold parameters, error type and measurement units specified in
the threshold parameters;

o the Discrepancy of kappa angle column is used to display a value of kappa angles
difference (calculated using block scheme) between images.

o the Distribution uniformity column is used to display data about uniform or non-
uniform distribution of points on a inter-strip stereopair.

o the last columns allows to highlight a stereopair (+) or cancel the highlighting of a
stereopair (-) in 2D-window that allows to estimate visually whether the stereopair
is located within images block.

@ A stereopair is highlighted with adding it to already highlighted ones in 2D-window. Can-
celling of a stereopair highlighting is performed along with “subtraction” from highlighted
stereopairs.

If in the Relative orientation report settings window the Check errors in interstrip
stereopairs checkbox is set, then the errors in the report are highlighted in the following
way: yellow color shows strips and stereopairs that contain points measurements ex-
ceeding threshold, and the errors values are shown by red color.

5.9.5. The stereopair measurements section

Relative orientation report provides possibility to view a detailed report on any selected
stereopair that contains data on tie points measurements, calculated relative orientation
parameters, information about kappa angles difference and uniformity of tie points dis-
tribution on a stereopair.

A detailed report allows to perform control of measurement accuracy of common points
of a stereopair images by values of vertical parallax residuals. To view detailed report
for selected stereopair click the stereopair hyperlink in the tables of in-strip and inter-
strip stereopairs.
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Fig. 139. Detailed report for selected stereopair

Detailed report on selected stereopair includes the following data:

 hyperlinks of detailed report:

o [Relative orientation report] — the link is used to return to the first page of the
common report on in-strip and inter-strip measurements;

o [Back] — the link is used to return to previous view of detailed report on stereopair

measurements;

o [Refresh] — the link is used to refresh relative orientation results in the report after
editing of tie points in the Points measurement module;

o [Report parameters] — the link is used to change the report parameters and to re-

fresh the report;

o [Edif] — the link is used to view and edit measurements on a stereopair in the
Points measurement module;

o [Select stereopairs] — allows to select a stereopair on a block scheme in 2D-window;

220



PHOTOMOD 8.1 Aerial triangulation (Windows x64)

o [Unselect stereopairs] — allows to unselect a stereopair on a block scheme in 2D-
window;

o [Unselect all] — allows to unselect all previously selected stereopairs.
+ information about number of measured tie points on a stereopair;
+ the Vertical parallax table contains the following columns:

o the first column is used to edit selected tie point and allows to open the Points
measurement module and to open at the same time images of the stereopair
automatically and place marker on selected point;

§ After the point editing is completed and the Points measurement module is closed click
the [Refresh] hyperlink in the report to re-calculate relative orientation and refresh the report.

o the Point column displays names of tie points;

o the Number of points column is used to display a number of points measured on
inter-strip stereopair;

o the Image ... (left) column displays a value of vertical parallax residual on the left
image of stereopair (in mm and pix);

o the Image ... (right) column displays a value of vertical parallax residual on the
right image of stereopair (in mm and pix).

In the threshold row the threshold for vertical parallax residual is displayed in accord-
ance with specified value, measurements units and residual type (RMS, Mean abs.
and max error) of the Vertical parallax threshold parameter in the Relative orient-
ation report settings window.

At the bottom of the table there are final values of vertical parallax residual on all
measurements of the stereopair (RMS, Mean abs. and max error). The system per-
forms control of threshold exceeding only for error type specified in the Relative
orientation report settings window.

Values of vertical parallax residuals exceeding specified threshold, are highlight by
red color.

 the Relative orientation parameters table contains values of calculated relative orient-
ation angles for the left and right images according to selected angular system and
measured units on the Additional tab in the Relative orientation report settings
window;

+ the Orientation 2D (by block scheme) and Discrepancy of kappa angles tables contain
values of kappa angles;
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@ Accuracy control of kappa angles discrepancy between images is performed if in the Relative
orientation report settings window the appropriate checkbox is set and a threshold value
for kappa angles discrepancy is specified.

« the Distribution uniformity tables contain information about uniformity of points distri-
bution over standard zones. To estimate the parameter the system analyses a differ-
ence of points number in each of 6 standard zones.

@ Control of points number and uniformity of their distribution on stereopair’s zones is performed
if corresponding parameters are specified in the Relative orientation report settings window.

5.9.6. The triplet measurements section

Relative orientation report provides possibility to view a detailed report on selected
triplet. A detailed report for a triplet is used to view and perform accuracy control of
measurements in triplet by tie points errors. In order to view a detailed report on selected
triplet click the triplet link in the friplets table of the Inter-strip measurements section
of the report (see the Section 5.9.3).

= Report M[=] E3
4 | BB 8k
Triplet R10_S05—R10_S06—R10_S07
See also: relative orientation report
[Back] [Refresh] [Report parameters]
MNumber of triplet points: 22
Tie Residuals
Paint Ex, pix. Ey, pix. Ez, pix. Exy, pix.
Lirmit (rmax) 1.414 1.414 2.828 1.414
51 0.178 -0.834 -1.238 0.853
72 0.140 -0.170 1.478 0.220
~162 0.030 -0.921 0.927 0.921
*45 -0.202 0231 -1.239 0.307
B8 0126 0157 -1.223 0.234
~161 0.161 0.487 -1.016 0.513
~142 -0.156 0.067 -1.105 0.170
~157 -0.067 -0.255 0.985 0.265
~137 -0.012 0.280 0.770 0.280
~140 -0.005 0.066 0.618 0.066
~114 -0.045 0.289 0.479 0.293
El
Cloze |

Fig. 140. Detailed report for selected triplet
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Detailed report on selected triplet includes the following data:
* hyperlinks of detailed report:

o [Relative orientation report] — the link is used to return to the first page of common
report on relative orientation;

o [Back] — the link is used to return to previous view of detailed report on measure-
ments in triplet;

o [Refresh] — the link is used to refresh relative orientation results in the report after
tie points editing in the Points measurement module;

o [Report parameters] — the link is used to change the report parameters and to re-
fresh the report;

o [Edif] — the link is used to view and edit a triplet measurements in the Points
measurement module;

o [Stereopairs] — two links used to proceed to detailed measurements report of points
on stereopairs, that form the triplet (see the Section 5.9.5).

 information about number of measured tie points in a triplet;
+ the Tie residuals table contain the following columns:

o the first column is used to edit selected tie point and allows to open the Points
measurement module and to open automatically at the same time triplet images
and to place marker on selected point;

é’ After the point editing is completed and the Points measurement module is closed click
the [Refresh] hyperlink in the report to re-calculate relative orientation and refresh the report.

o the Point column is used to display a tie point name;

o the Ex, Ey, Ez, Exy columns — tie residuals by X, Y, Z axes and tie residual by
(XY) in measurement units specified for residuals control in triplet in the Relative
orientation report settings window.

In the threshold row there is a triplet residual threshold according to specified value,
measurement units and error type (RMS, Mean abs. and max error) of the Triplet
residuals threshold parameter in the Relative orientation report settings window.

At the bottom of the table final values of tie residuals on all triplet measurements are
shown (RMS, Mean abs. and max error). Accuracy control is performed only for the
residual type that is specified for the Triplet residuals threshold parameter in the
Relative orientation report settings window.
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Values of tie errors that exceed specified threshold are highlighted by red color.
5.10. Relative orientation control

5.10.1. Control of points recognition correctness

In order to perform aerial triangulation it is necessary to measure on stereopairs tie
points coordinates, that are needed for building models by stereopairs formed by adjacent
images of a strip, and for joining images into strips and blocks networks.

If tie points were measured automatically, some of interstrip points, measured in shadows
or on trees may be a source of errors.

Time between shooting of two adjacent images is usually small enough and object
shadow does not shift on significant distance.

When surveying two different strips the time difference often allows the shadow to move
on distance that is close to required accuracy of adjustment. It causes systematic shift
of strips relatively to each other. At that it will result in systematic error on projection
centers, and a random error on GCP.

Trees shadows and heads position may be changed due to wind. In this case, the error
is random or systematic within small area. During automatic filtering it is impossible to
detect error of points measurements.

In the case when tie points are measured automatically, some of points measured on
borders of extended objects also may be reason of errors. In this case there is possib-
ility of big correlation coefficient on such points, however, measurement accuracy of
points located along extended objects borders is small enough due to homogeneity of
this object. At the same time accuracy of points measurements in direction perpendic-
ular to to the object border is high. During automatic filtering it is impossible to detect
error of points measurements.

c After points filtering it is necessary to perform control of points recognition correctness on ste-
reopairs and triplets.

5.10.2. Control of uniform distribution of points measurements on
stereopairs

For relative orientation it is necessary to measure not less than 5 tie points on each
stereopair, each 3 of them should not be on the same line.

In order to increase adjustment accuracy it is recommended to measure more than 6
points on each stereopair.

It is also recommended to avoid situations when there are many points in some small
part relatively to the rest area of stereopair. It is better to either thin out these points or
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add more points on the rest of stereopair area to distribute the points over stereopair
uniformly.

A When measuring points along man-made extended objects: roads, power lines, etc., group of
points measured along straight line, is equal to only two points on this line during relative orient-
ation calculation.

5.10.3. Control of vertical parallax residuals on stereopairs

To perform aerial triangulation beside to measure of tie points coordinates it is also
necessary to calculate differences of tie points coordinates on both images of a stereo-
pair.

g Difference of points coordinates on two images is called parallax. Vertical parallax is difference
of Y-coordinates, horizontal parallax is difference of X-coordinates of points on images that
compose a stereopair.

In some cases, errors of points’ recognition may not result in big vertical parallax resid-
uals, but cause wrong angles of relative orientation (for example, when kappa angle is
more than 45 degrees).

5.11. Adjustment control in triplets

5.11.1. Control of uniform distribution of points measurements in
triplets

For correct triplets creation it is necessary to measure not less than 2 points with distance
between not less than 1/3 of image width.

It is recommended to measure not less than 1 point in each of 3 zones: central and 2
outermost.

If it is impossible to measure more than 1 point in each of 3 zones (for example, if water
body covers more than a half of strip width) use bundle adjustment. During this operation
it is necessary to measure more tie points during relative orientation and in interstrip
ties. In areas where there is no images overlap but it is necessary to provide high ac-
curacy it is recommended to use “not-transferred” points as well.

“Not-transferred” point — points which coordinates are measured only on a single image in one
strip (it is not measured in overlap of adjacent images in a strip).

5.11.2. Errors control in triplets

During errors control you should consider that height errors in triplets are bigger on
average than plane errors. A coefficient is equal to survey height/basis ratio.

Too big height errors in triplets are usually caused by the following reasons:
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* wrong points measurement;
* interior orientation errors;

* blunders in focus length;

* blunders in distortion input.

If it is impossible to reduce height errors by control of wrong points measurement, it is
recommended to check accuracy of images relative orientation.

If the strip is drifted too much in height, it is recommended to check camera parameters
(distortion).

The system does not provide errors control in triplets, for this strip adjustment is used
(one of a block strips) by independent strips method in free model. In this case each
strip is adjusted individually with subblock selection.

5.12. Subblock analysis

The system provides for checking blocks of images within central projection projects
for subblocks, i.e. groups of images isolated for some reason. The analysis takes into
account the coverage of block images by triangulation points, and, optionally, the results
of adjustment. Subblocks may indicate, for example, insufficient georeferenced data or
insufficient coverage of block images with triangulation points.

Such situations can arise not only due to operator’s errors, but also due to objective
reasons, in particular, due to the presence of water surfaces in the area covered by the
images of the project under processing.

A subblock analysis can be useful both during the preparation to adjustment and after
it when analyzing and correcting errors, i.e. additional measuring tie and ground control
points, excluding some subblocks from the adjustment, ore excluding some images
from the project under processing.

To check subblocks, choose Orientation > Subblock analysis. When this operation
is complete, the Subblock analysis window opens:
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& Subblock analysis ﬁ
W E: :F =EOE G e

Mame

» [7] Subblock after adjustment 1 (Images: 1)
» [7] Subblock after adjustment 2 (Images: 1)
» [7] Subblock after adjustment 3 (Images: 1)
» [7] Subblock after adjustment 4 (Images: 1)
» [7] Subblock after adjustment 5 (Images: 1)
» [7] Subblock after adjustment & (Images: 1)
» [7] Subblock after adjustment 7 (Images: 1)
» [7] Subblock after adjustment 8 (Images: 1)
» [7] Subblock after adjustment 9 (Images: 1)
» [7] Subblock after adjustment 10 (Images: 1)

Use bundle adjustment results

Cancel

Fig. 141. The Subblock analysis window
The window contains the following instruments for image selection:
3@ — allows to select all images in the list;
+ EE — allows to deselect all images in the list;
« 3i — allows to inverts images selection;
- = — allows to select highlighted images;
- OE — allows to unselect highlighted images;
- B2 — allows to select the images that are highlighted on block scheme in 2D window;

- I8 — allows to highlight on block scheme in 2D window the images selected in the
list.

By default, the window displays the results of analysis by triangulation points. In order
to display the results of subblock analysis taking into account the adjustment results,
set the Use bundle adjustment results checkbox. The difference in the analysis results
before and after adjustment may indicate the presence of errors.
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6. Editing of triangulation points

6.1. General information about triangulation points display
The system provides displaying of triangulation points in the following windows:

* in windows of opened images of the Points measurement module (see the Sec-
tion 6.3);

* on a block scheme or on a stereopair in 2D-window (see the Section 6.4);

* on a conventional scheme in the Delete point measurements window for pictorial
view of points to be deleted (see the Section 6.7).

6.2. List of triangulation points

The system provides possibility to view, search and edit of triangulation points. The
Triangulation points window is used to do this.

Choose Window » Triangulation points coordinates to open the Triangulation points
window.

. Triangulation points @
Fhm B EE »E

Code Na)me Type X m ¥, m Zm K'om ¥, m Zm |*
Tie - - - 2586486.4162 6582113.0180 30.2242 |=
100 *100 Tie - - - 2587729.5700 65805100704 29383
101 101 Tie - - - 25870186373 65825215539 4.2632
102 102 Tie - - - 25870259408 65824276867 24252
103 103 Tie - - - 25876704774 65818808624 69121
104 104 Tie - - - 2587812,7981 65818884577 41298
105 *105 Tie - - - 2587587.2487 65819081701 35511
106 *106 Tie - - - 25884656830 65815615482 35.2245
107 107 Tie - - - 25882924595 6581484.8828 36.1407
108 108 Tie - - - 2588474 4981 65813915019 19.8303
109 109 Tie - - - 2587649.9780 65833293326 22279
1 11 Tie - - - 2585007 4642 65800406785 18.2579
110 110 Tie - - - 25875828861 65831320033 19717
11 111 Tie - - - 25875804532 65832371655 21748
112 112 Tie - - - 25881439228 65826287700 9.5959
113 113 Tie - - - 25882252370 65827336028 28773
114 114 Tie - - - 25882354416 65823882452 22.5295
115 115 Tie - - - 25880410776 6582073.2474 85252 -

Refresh Close

Fig. 142. The Triangulation points window

The Triangulation points window contains the toolbar with buttons used to perform
the following operations:

« .Z — allows to set on/off the filter of triangulation points display;
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« %1 — allows to setup the filter of triangulation points display;
» it — allows to display all/selected on a block scheme points in the table;
- @4 — is used to search for an image by name (part of name);

- 21— allows to display GC/check points initial coordinates (X, Y, Z— see the 'Aerial
triangulation” User Manual);

- & — allows to display triangulation points coordinates obtained after adjustment (X',
Y', Z');

® —allows to display errors on points:

o dX, dY, dZ- error values on point;

o Ex(adj.), Ey(adj.), Exy(adj.) —average residuals of points on images.

. — is used export the table content to text file with *.csv extension;

. — allows to set the errors (Ex(adj.), Ey(adj.) n Exy(adj.)) displaying for the
central projection projects — in pixels or in mm:

Error settings [ﬁj
Units
@ Pixels
Millimeters
QK | | Cancel

L8 L

Fig. 143. The Error settings window

ﬁ For satellite scanner imaging and ADS 40/80/100 projects, error data are displayed only in
pixels.

For refreshing data about project state after changes the Refresh button is used.
The list of triangulation points is a table with the following columns:

» Code — an object code;

* Name — image name;

* Type — displays point’s type (tie, GCP, check, excluded);

« X, Y, Z- GCltie point initial coordinates (:£);
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« X', Y', Z' —adjusted coordinates of triangulation points (&i);
« dX, dY, dZ- error values on point (* );
 Ex(adj.), Ey(adj.), Exy(adj.) —average residuals of points on images (¥ ).

The Triangulation points window is synchronized with 2D-window: when point selecting
in 2D-window it is also selects in the table. Double-click by row with point allows to open
the Points measurements module to edit point’s position.

6.3. Points display in the “Points measurement” module

In order to display triangulation points on images, opened in the Points measurement
module, it is possible to use the following buttons of the left toolbar of the Points
measurement window:

« ¥ _ allows to show/hide triangulation points;
« 2% — allows to display triangulation points by symbols;
« & — allows to show/hide triangulation points names;

« = — allows to show/hide models by ties in a mode of triangulation points display by
symbols;

ﬁ This mode allows to show in addition to tie point symbol “arrows”, indicting its connection
with adjacent images (left and/or right). For example, a triplet point symbol receives additional
right and left angle brackets.

Fig. 144. The left image shows triplet point, located in the center of triple overlap area, the
right one — triplet point from the right image

« 5 — allows to show/hide GCP error vectors:
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ﬁ This function becomes available after block adjustment (see the “Block adjustment” User

Manual).

« .8 _ allows to show/hide tie error vectors;

c This function becomes available after block adjustment (see the “Block adjustment” User

Manual).

« .Z — allows to apply/cancel a filter used to show triangulation points of certain types,
selected using the % button;

ﬁ The filtering is also applicable to points displaying in the points catalogue shown in the Trian-

gulation points window.

- %1 — allows to select triangulation points types in order to apply a filter when displaying
them on images and in the points list of the Points measurement module (see
Section 6.6).

p N
@ Aalen_DMC_training_Brusnikin - PHOTOMOD =N

aqeqQE e« ERRN-Z0@E FF2E ¥ B X FEER Suzx OB w6 L

WMEB e = eE]Ek)

QAR AFE &85 i (L) X @ Qaq#H o+o'+<>§.3.'r,ﬁ‘ L X @Qae@E * 85 L hd

Aalen_04~0115_rgh

Aalen__04~0114_rgh .

(D 4:5 (6707.0202,11692.0774)

L X @A @@E FAEEw L X

Aalen__057D049_rgh

@ 2:3 (3764.9626,12051.0540) (@D 2.3 (578.7248,12113.8476)

X

Triangulation points [total: 275 / visible: 266]

B DR v v M e-B el 7 (7% pin ([BE %

Code Name Type v $ 5z | oom o 2R Max Y-par Max Exy Max E2 -
15401 1 Tie L 2 1 . 0938
15408 10 Tie L 2 1 . 0987
15583 101 Tie L 2 1 . 0932
15584 ~102 Tie s e 2 1 + - - - pes2 E
15585 103 Tie . .2 1 e e - - oo
15586 104 Tie . . 2 1 . 0906
15587 105 Tie < . 2 1 . 0967
15588 106 Tie . . 2 1 . 0989 | [r——
)

Fig. 145. The “Points measurement” module
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6.4. Triangulation points display in 2D-window

To display triangulation points in 2D-window or on a block scheme or on a stereopair
perform the following actions:

1. Choose Orientation > Load triangulation points or click the & button.

The Triangulation points layer appears in the Layer manager. Triangulation points
are shown in 2D-window and the Display options window opens.

1:1:14 Bleck scheme
@ e e@@IaaLa@ |-
@ Symbols —

4 By coordinates

Excluded point

@ Display options
Mode: geore ferenced block scheme

fo %%

Measurements S X
Source coordinates @_-_ I
Adjusted coordinates [

Block scheme position [EIEE ]

!

5
0 [w][=]=] @foa &

(&
=
E

_\

[ | 2584993.30636 1 m; 6587395.954896 m; 0.000000 m GSD = 14.000000m (R=127 G=127 B=127) [GD49 / NZ Map Grid

Fig. 146. Triangulation points displayed in 2D-window, the Display options and Symbols windows

2. Setup parameters and modes of triangulation points display in 2D-window. All
changes in window settings are automatically displaying in 2D-window.

? In order to open the Display options after their loading once more, choose Window >
Triangulation points view control.

The Display options window allows to setup display of the following triangulation points:
* Measurements — all triangulation points measured on block images;

» Source coordinates — only GC/check points with source coordinates, input to the
list of GCP coordinates (see the Section 4.2.1);
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» Adjusted coordinates — all triangulation points with coordinates, acquired after ad-
justment (see the “Block adjustment” User Manual);

» Block scheme position — all triangulation points with averaged coordinates of block
scheme (the option is used in mode of block scheme without reference, for instance).

@ The Block scheme position points type is unavailable for display of triangulation points in

the stereopair window.

The ability to display a particular type of points depends on the current mode in 2D-
window. It is possible to select one of the following modes in upper part of the Display
options window:

» georeferenced block scheme — the system displays any types of points;

» block scheme without georeference — the system displays only results of measure-
ments on block images and points positions in averaged coordinates;

» stereopair — the system displays only results of measurements on left and right im-
ages of a stereopair, as well as points positions in source and adjusted coordinates
of points, located in stereopair area.

To setup symbols and filter usage for points display the system provides the following
buttons:

« B — allows to choose symbols for triangulation points of different types;

« .Z and % — allow to apply (the first button) and setup (the second one) filter used to
display points of selected types only (see the Section 6.6).

c The filter settings are not saved for next module sessions.

. Display options

Mode: georeferenced block scheme
fo v Yo

Measurements

@MY !
&

Source coordinates A BL\' g

x .
[x] =

Adjusted coordinates [E] :
[x] =

Block scheme position

| Error vectors

Point size 5 1 pix

Fig. 147. Settings of points display in 2D-window
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The system provides the following modes to setup display of each type of points position:
« & — do not display points;

* -~ — points are displayed as small squares, which size is specified by the Point size
parameter;

« = — points are displayed using symbols, which are setup using the &z button.
@ In the stereopair mode “small arrows” are added in addition to the main symbol to indicate

connection with adjacent images.

Besides, for each points type the system allows the following modes of additional in-
formation display:

+ & —allows to hide/show points names;
« ¥ _ gllows to hide/show XY-coordinates;

+ £ — allows to hide/show Z-coordinates (this mode is unavailable for the Measure-
ments and Block scheme position points display modes).

Moreover, the system allows to display error vectors between point measurements on
block images and position of this point in source, adjusted or averaged coordinates. To
do this, set the Error vectors checkbox.

@ Error vectors between measured and source point’s position are shown using crimson color,
between measured and adjusted point’s position — by blue color, between measured and aver-
aged point’s position — by yellow color.

The system provides possibility to save triangulation points as point vector objects in
vector layer, that can be used along with other base vector layers for TIN creation (see
the “DEM” User Manual).

To save triangulation points as vector layer perform the following actions:

1. Choose Vectors > Create layer from triangulation points. The Load triangulation
points window opens.

. Load triangulation points @

Select point coordinate sources:

| Ground control point catalogue
| Block scheme

| Adjustment results

[ QK H Cancel |

Fig. 148. Saving triangulation points on vector layer
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2. Choose one or multiple points types according to coordinates to save them to a
vector layer:

* Ground control point catalogue — to save triangulation points in source coordin-
ates;

* Block scheme — to save triangulation points in averaged coordinates;
+ Adjustment results — to save triangulation points in adjusted coordinates.

3. Click OK. After that the system opens information window which contains information
about number of points of each selected type, saved on a vector layer. The Trian-
gulation points (Vectors) appears in the Layer manager. Vector point objects — tri-
angulation points are displayed in 2D-window on a block scheme or stereopair.

6.5. Symbols of triangulation points

To setup symbols for triangulation points the Symbols window is used. It could be
opened using one of the following ways:

« the fa button of the upper toolbar of the Points measurement module used to setup
points display on opened images (see the Section 5.2);

« the Hg button of the Display options window toolbar to setup points display on a
block scheme/on stereopair in 2D-window (see the Section 6.4);

» the Symbols button of the Delete point measurements window used to configure
display of points selected for deletion on graphical scheme (see the Section 6.7).

é No matter at what stage and in which system module the symbols are configured, the symbols
settings are stored and are valid for the entire system until the next their change.
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A

-

.S}fmhuls I

4 By coordinates

4 Symbol shape
[] X¥ point
C} £ point
I ¥YZ point

4 Symbol color
i GCP
S Check point

Excluded point

4 By ties
4 Strip points
 Single point
Point measured on ocne sterecpair
<+ Point measured in triple or higher overlap
» Point measured on non-adjacent images
¢ Point measured on a sterecpair and nen-adjacent images
4 Interstrip points
<+ Point measured on isclated images in strips
Point measured on sterecpairs
Point measured on sterecpairs and triplets
<+ Point measured on stereopairs and isclated images
» Point measured on stereopairs and non-adjacent images
* Point measured on non-adjacent images
4 (Other
Excluded point
[ ] Point without adjustment
%/ Targeted points
<> Projection center

Symbal: ] L O Color:

0K ” Reset ” Cancel l

Fig. 149. Setup of points symbols

The window contains the list of all triangulation points. In the left column the symbols
selected (or configured by default) for each point type are displayed. There is also
possibility to change symbol shape and color for tie points (both in-strip and inter-strip).
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To change a symbol perform the following actions:
1. In the By ties list select a point type which symbol needed to be changed.

2. Select Symbol option to define a point’s shape — circle <, rhombus <= or square
m

3. Click the Color field and select necessary color from standard Windowscolor palette.

4. [optional] To go back to symbols configured by default, click the Cancel button
while holding the Alt key.

5. Click OK to confirm changes.
6.6. Points filter

Points filter is intended for displaying of triangulation points of selected types. For ex-
ample, it is possible to show only triplet tie points or just GCP and check points.

For points filtering there are two buttons of the left toolbar of the Points measurement
module:

« % — for filter setup — choosing points types to be shown;
« .Z —to apply/cancel a filter.

Triangulation points filtering is available for images opened in the Points measurement
module (see the Section 6.3), for a block scheme or stereopair in 2D-window (see the
Section 6.4) and for window with parameters of points and error display on a block
scheme (see the “Block adjustment” User Manual).

It is possible to use special symbols to display points in the system (see the Section 6.5).
For points filtering setup perform the following actions:

1. Click the % button. The Point filter window opens.
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Fig. 150. Selecting points to be displayed

2. In the following sections choose points types to be shown:

+ the By coordinates section allows to select points to be displayed depending
on their coordinates:

o ground control — GC points (ground and projection centers);

o check — check points (ground and projection centers);

o excluded — points with known coordinates, excluded from adjustment;
o XYZ points — points with known coordinates (X, Y, Z);

o XY points — points with known coordinates (X, Y);

o Z points — points with known coordinates (Z);

o No coordinates — points with unknown coordinates (ties and projection centers,
if their coordinates are not available);
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o All — allows to select/unselect all points mentioned in the section.

» the By ties section allows to select points to be displayed depending on number
of their coordinates measurements on images:

o Single — points which are not measured on any stereopair;

o Stereopair — points measured on one stereopair, at least;

o Triplet — points measured on one triplet, at least;

o Strip tie — points measured in inter-strip overlap area;

o Non-transferred — tie points, which are not measured on adjacent images;
o Used — tie points used as ties during adjustment;

o Excluded — tie points excluded from adjustment;

o All — allows to select/unselect all points mentioned in the section.

» the Auxiliary section allows to select points to be displayed depending on their
type:

o Geodetic — tie points which are not targeted and projection centers;

o Targeted — targeted points;

o Projection centers — projection centers;

o With changed type — points which type was changed during adjustment.

 the By residual value section allows to select points depending on residual value
on the point:

@ The By residual value section is available on block adjustment step only (see the “Block
adjustment” User Manual).

o Worst points — points with maximal residuals (number of points to be displayed
is specified in the appropriate field);

o Over acceptable residuals — points with residuals, exceeding threshold. Points
selection by residuals value is performed using additional checkboxes Ground
XY, Ground Z, Tie in stereopairs XY, Tie in stereopairs Z, Tie on images.

ﬁ Residual thresholds are specified on block adjustment step (see the “Block adjustment”
User Manual).
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* In selected models — used to select points located in selection area of stereo-
pair/strip or multiple steropairs/strips:

o At least one — points measured on one selection area;
o All — points measured on all selection areas simultaneously.
3. Click OK.

c The Apply button is available only when working with the Display options window (see
the “Block adjustment” User Manual).

4. Click the :% button to apply the filter.

6.7. Triangulation points deletion
For points deletion the system provides the following possibilities:

+ tools in the Points measurement module (see the Section 5.2.2) and in the triangu-
lation points catalogue;

* menu item Orientation » Clear point catalogue is used for deleting all points with
measurement results at once (GCP, check and tie);

* menu item Orientation > Delete point measurements for selective deleting of trian-
gulation points;

* menu item Orientation > Delete points outside useful areas allows to delete points
out of useful areas (with specified background color) (used mainly during automatic
points measurements on scaner images);

* menu item Orientation > Delete border points allows to delete points of selected
types from near-boundary areas of project images marked in the list.

6.7.1. Selective deleting of triangulation points

Selective points deleting allows to delete points of selected types from project images
marked in the list.

For selective points deleting perform the following actions:

1. Choose Orientation > Delete point measurements or click the fi§ button of the
AT panel toolbar of on the main toolbar of the Points measurement module. The
Delete points measurements window opens.
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Fig. 151. Choosing of points types to be deleted

2. Inthe Selected images with point measurements section select project images
with measured points coordinates, that should be deleted. The section contains list
of project image and the toolbar used for images selection.

7

For selective points deleting it is necessary to choose at least one image. An exception is
the removal of All without measurements on images points type, i.e. GC points located

on none images of the block. It is possible to obtain such points, for example, after triangu-
lation points import or after deleting images from the block.

3. Set checkboxes next to point types to be deleted as well as deletion modes in the
Select points and Delete mode sections accordingly.

The section contains a list and graphical scheme of point types. The list of point
types and the scheme are synchronized, i.e. points of type selected in the list are
automatically marked (by check mark) on the graphical scheme. And vice versa,
selected point types on the graphical scheme leads to automatic selecting of cor-
responding checkboxes in the point types list.
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@ To select multiple point types on a scheme use the Shift key.

The Symbols button allows to change points symbols on the scheme.

The system provides the following tools to manage image zoom and BCG paramet-
ers on the scheme:

* «*» — allows to zoom in the image;

* «I» — allows to zoom out the image;

Alt — allows to turn on panning mode;

Shift+F8 — allows to setup brightness, contrast and gamma.

% For selective points deletion it is necessary to select at least one type of triangulation points
in each of three subsections: By measurement type, By coordinate type and By meas-
urement mode.

In the Select points section select triangulation point types to be deleted from the
following list:

* By measurement type:

o All — all points of all measurement types on selected images according to co-
ordinates type, measurements method and deletion mode.

@ Points type is determined by the whole block, rather than by selected images.

o Strip points:

m ties on selected images — in-strip tie points on selected images, i.e. points
that contain two or more coordinates measurements on images selected in-
side a strip;

m isolated — points with a single measurement on selected images;

m on stereopairs — stereopair tie points, including those that have non-adjacent
measurement in strip;

m on triplets — all measurements of triplet points, including measurements on
non-adjacent images inside a strip;

m with non-adjacent measurements — in-strip tie points, with one at least
non-adjacent measurement.

o Interstrip points:
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m All interstrip ties — all interstrip tie points, if at least one coordinates
measurement of each point falls into selected images;

m Interstrip ties for selected strips — interstrip tie points, if all coordinates
measurement of each point falls into selected images (strictly inside the im-

age);

m Ties on selected images — interstrip tie points, that have two or more
measurements on selected images;

m With non-adjacent and isolated measurements — interstrip tie points,
without stereopair measurements;

m On stereopair — interstrip tie points, that have measurements on a stereopair,
but without triplet, isolated or non-adjacent measurements;

m On triplet — interstrip tie points, that have measurements on a triplet, but
without isolated or non-adjacent measurements;

m On stereopair, isolated, non-adjacent — interstrip tie points, that have
stereopair and isolated measurements; interstrip tie points, that have stereo-
pair and non-adjacent measurements.

o Additionally:

m Excluded as tie — all tie points on selected images, excluded by tie in the
Triangulation points window.

* Also:

o All without measurements on images — coordinates measurements of GC
points, located on none of block images of the project (for example, measure-
ments left after deletion images from the block).

* By coordinate type:

o Tie;

o Ground control;

o Check;

o Excluded as control.
+ By measurement mode:

o Manual - to delete manually measured points;
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o Automatical — to delete automatically measured tie points.
In the Delete mode section select points deletion mode:
* Delete measurements of selected points:

o All—to delete all measurements of selected points, if at least one measurement
of selected point coordinates is located on selected images;

In this case all measurements of selected points coordinates will be marked
by red color on the graphic scheme.

o On selected images — to delete measurements of selected points only on
selected images;

% If tie point have only one measurement (out of selected images), it will be also deleted.
Such single measurements are marked by yellow cross on the graphic scheme.

o only non-adjacent and isolated — to delete measurements of selected points
on non-adjacent images, as well as isolated measurements, including inter-
strip ones, that have no “ties” inside strip.

* Delete measurements for points with coordinates:

o measurements only — used to delete only coordinates measurements of se-
lected points;

o points completely — used to delete selected points completely along with their
measurements and records shown in the catalogue of the Triangulation points
window (for GCP, check, excluded GC points).

4. Click OK. The system shows warning with request for deletion, and with information
about number of points to be deleted. Click the Yes button to delete selected points,
and the No button to go back to the Delete points measurements window or the
Cancel button, to close the window and cancel points deleting. After operation
completion the system shows detailed information about deleted points.

6.7.2. Deleting points at image boundaries

Selective point deleting allows to delete points of selected types from near-boundary
areas of project images marked in the list.

For selective point deleting from near-boundary areas of images, perform the following
actions:

1. [optional] select the images on the near-boundary areas of which it is needed to
delete triangulation points;
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2. Choose Orientation > Delete border points. The Delete border points window
opens:

. Delete border paints @

Top, %

Ak

10,000

Left, % Right, &

Ak
Ak

10,000 10,000

Bottom, %%

Ak

[0, 000
Delete points with type
Manual
Automatical

Ground control

Check

On selected images

QK ] | Cancel

Fig. 152. Setting triangulation point deletion at the near-boundary areas of the selected images

3. Setthe sizes of areas at the image boundaries where triangulation points are to be

deleted, in percent;
4. Set an appropriate checkboxes to delete points of followed types:

* Manual — to delete manually measured points;

« Automatical — to delete automatically measured tie points;

* Ground control;

* Check.

5. [optional] set the on selected images checkbox to delete points only within the
near-boundary areas of the selected images, otherwise points would be deleted
within the near-boundary areas of every project image.

6. Click OK. The system shows the warning with request for deletion, and with inform-
ation about the number of points to be deleted. Click the Yes button to delete selec-
ted points, and the No button to go back to the Delete border points window.
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. Question @
.' g_' ) 0 measurements and 0 points will be deleted. Continue?

es ] | Mo

Fig. 153. The window showing the number of points to be deleted

6.7.3. Removing point duplicates

The system provides for merging tie points having the same coordinates (user-specified
accuracy).

g Tie point having the same coordinates (and different names) can appear during project processing
due to operator’s errors, for example, in the case of repeated import of triangulation points.

To check for tie point duplicated and further merge of duplicates, perform the following:

1. Choose Orientation > Delete duplicated points. The Delete tie-points duplicates
window window opens:

.Delete tie-points duplicates @

Enter the predsion with which the identity of the points will be determined
Precdision 0.001 1 pix.

How to combine:

@) Merge points with the same measurements in same-name images

Merge points having at least one coindding measurement

QK l | Cancel

Fig. 154. The Delete tie-points duplicates window
2. In the pixel precision field, enter the accuracy that the identity of points will be
determined with;
3. Choose the method to merge points:
* Merge points with the same measurements in same-name images;
* Merge points having at least one coinciding measurement.

4. Click OK. When the operation is complete, an appropriate info message appears.

246



PHOTOMOD 8.1 Aerial triangulation (Windows x64)

7. Data import and export
7.1. Import of triangulation points

7.1.1. Import of triangulation points from PAT-B

The system provides possibility to import triangulation points coordinates (and meas-
urements) from files of PAT-B format.

Perform the following actions to import measurements:

1. Choose Orientation > Import » Import tie points from PAT-B... or click the arrow
to the right from the button of the Tie points tab toolbar in the Triangulation
points window and choose Import from PAT-B. The Import measurements from
PAT-B window opens.

.Impu:urt rneasurernents frorm PAT-B format @

File with point coordinates

File with measurements

| Refined camera coordinates

File with list of correspondent PAT-E and PHOTOMOD image names

When name already exists

@ Replace Skip Fename

oK ] | Cancel

Fig. 155. Import measurements from PAT-B

2. Set the File with point coordinates checkbox to import geodetic coordinates of
GC points. Click the _... | button to select file to be imported with *.xyz, *.txt, *.csv
extension (see format description in Section C.1.1).

é Description of the files with *.pat extension (created in Trimble Inpho software) see in
Section 7.1.2.

? If there is a coordinate system different from source one (left/right), set the Swap X Y
checkbox to swap X and Y coordinates.
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@ If the Swap X Y checkbox is cleared, GC and tie points coordinates are imported in the
right coordinate system. Otherwise, in the left one.

3. Set the File with measurements checkbox to import point coordinates measure-
ments. Click the _..| button to select a file with *.mea, *.txt, *.csv extension (see
format description in Section C.1.2). Specify measurement units of points coordin-
ates, that used in image coordinate system — pix, mm or mem. If the measurements
consider distortion correction and principal point shift, set the Refined camera co-
ordinates checkbox.

@ The file can contain measurements of both GCP and tie points.

@ Description of the files with *.pat extension (created in Trimble Inpho software) see in
Section 7.1.2.

4. [optional] In order to select file, which contains images names (numbers) from se-
lected files with geodetic coordinates and point coordinates measurements set the
File with list of correspondent PAT-B and PHOTOMOD image names checkbox
and click the _... | button.

A A filename of images names correspondence should be set in the form of
Name_in_PAT_B,Name_in_PHOTOMOD. At that both comma and space could be used
as a delimiter between PAT-B and PHOTOMOD names, but space between images names

should not be used.

&I Lister - [F:,PatBiE =10 x|
File Edit Options Help 100 %%
286 sc?86 -
285 sc985
984 scoOh
283 sc?283
879 sc879
888 scB8A
881 ScB81
882 sci82 =
o a1y

Fig. 156. Example of file of images names correspondence

5. Select actions to be performed in case of coincidence of images/points names in
file with existing images/points names in a project: Replace, Skip, Rename.

6. Click OK. Imported points are added to triangulation points list.
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7.1.2. Import of triangulation points from PAT-B (Trimble Inpho)

The system provides possibility to import triangulation points coordinates (and meas-
urements) from files of PAT-B format with *.pat extension (created in Trimble Inpho
software).

Perform the following actions to import measurements:

1. Choose Orientation > Import > Import tie points from PAT-B... or click the arrow
to the right from the button of the Tie points tab toolbar in the Triangulation
points window and choose Import from PAT-B. The Import measurements from
PAT-B window opens.

.Impu:urt rneasurements from PAT-B format @

File with point coordinates

File with measurements

| Refined camera coordinates

File with list of correspondent PAT-B and PHOTOMOD image names

When name already exists

@ Replace Skip Rename

K ] | Cancel

Fig. 157. Import measurements from PAT-B

2. Set the File with point coordinates checkbox to import geodetic coordinates of
GC points. Click the _... | button to select the cont.pat file (see format description
in Section C.2.1).

@ If there is a coordinate system different from source one (left/right), set the Swap X Y
checkbox to swap X and Y coordinates.

@ If the Swap X Y checkbox is cleared, GC and tie points coordinates are imported in the

right coordinate system. Otherwise, in the left one.

3. Set the File with measurements checkbox to import point coordinates measure-
ments. Click the _... | button to select the images. pat file (see format description in
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Section C.2.2). Specify measurement units of points coordinates, that used in image
coordinate system — pix, mm or mcm. If the measurements consider distortion
correction and principal point shift, set the Refined camera coordinates checkbox.

@ The file can contain measurements of both GCP and tie points.

[optional] In order to select file, which contains images names (numbers) from se-
lected files with geodetic coordinates and point coordinates measurements set the
File with list of correspondent PAT-B and PHOTOMOD image names checkbox
and click the _... | button.

A A filename of images names correspondence should be set in the form of
Name_in_PAT_B,Name_in_PHOTOMOD. At that both comma and space could be used
as a delimiter between PAT-B and PHOTOMOD names, but space between images names

should not be used.

& Lister - [F:\PatBit =10] x|
File Edit Cptions Help 100 %
286 sc286 -
085 sc9a5
284 sco0y
283 sc?83
870 Sc870
880 ScB8a
881 scB81
882 scig2 =
A M

Fig. 158. Example of file of images names correspondence

5. Select actions to be performed in case of coincidence of images/points names in

file with existing images/points names in a project: Replace, Skip, Rename.

6. Click OK. Imported points are added to triangulation points list.

7.1.3. Import of triangulation points from X-Points

The system provides possibility of import of tie and GC points coordinates from X-Points
files.

To perform measurements import perform the following actions:

1.

Choose Orientation » Import > Import tie points from X-Points... click the drop-
down arrow next to the % button of the Triangulation points window toolbar (in
any of the both tabs) and select Import from X-Points.... The Input file window
opens.
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2. Choose triangulation points file *.x-points and click the Open button. The Import
measurements from X-Points format window opens.

5.

. Irmport measurernents from X-Points format
Match images from file to images in project
@ By name By code

(") import roll and pitch angle values

When name already exists

@ Replace Skip Rename

=

Ok

l | Cancel

Fig. 159. Import measurements from X-Points format

When using points import from another project specify the way of matching images
names in the X-Points file and images names in the project:

* By name;
* By code;

* Use correspondence file.

7

In order to use correspondence file click the _... | button and select file with filenames.

Select actions to be performed in case of coincidence of images/points names in
file with existing images/points names in a project: Replace, Skip, Rename.

Click OK. Imported points are added to triangulation points list.

7.1.4. Import of tie points from PHOTOMOD 4.x XPT

The system provides possibility of import tie points catalogue from projects, created in
earlier versions the system likePHOTOMOD 4.x.

To perform import of triangulation points catalogue perform the following actions:

1.

Choose Orientation > Import > Import tie points from PHOTOMOD 4.x XPT... or
click the drop-down arrow next to the " button of the Tie points tab toolbar in the
Triangulation points window and choose Import from PHOTOMOD 4.x XPT....

The Input file window opens.
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2. Choose triangulation points file *.xpt and click the Open button. The Import
measurements from XPT format window opens.

.Impnrt reasurernents from X-Foints format @
Match images from file to images in project

@ By name By code

(") import roll and pitch angle values

When name already exists

@ Replace Skip Rename

QK l | Cancel

Fig. 160. Import measurements from XPT

Choose points file and click OK. Imported points will be added to triangulation points
list.

3. Specify the way of matching images names in the *.xpt file and images names in
the project:

* By name;
* By code;
* Use correspondence file.

% In order to use correspondence file click the _... | button and select file with filenames.

4. Select actions to be performed in case of coincidence of images/points names in
file with existing images/points names in a project: Replace, Skip, Rename.

5. Click OK. Imported points are added to triangulation points list.
7.1.5. Import of GCP catalogue

The system provides import of GC points coordinates list from file with *.csv or *. txt
extension.

To perform import of GC points coordinates list from file perform the following actions:

1. Choose Orientation » GCP list or click the & button of the main toolbar. The Tri-
angulation points window opens.
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2. Click the " button on the GCP list tab and choose Import from CSV. The Input
file window opens.

3. Select a file containing GCP catalogue and click OK. The Import GCP catalogue
window opens.

( . Import GCP catalogue Iﬁw

C:/Users/guk/Desktop/Mpumepel dalinos ana PHOTOMOD fcatalog. csv

Line template Mame X ¥ Z v

Start import from line 1 +1 Preview maximum 10 = lines
Automatically validate template

Field separators Decimal separator Misc

Comma || Tabulation Space @ Paoint only [ utFs

[7] semicolon [ Others ) Pointor comma [ Parse ®'™

Available fields

Mame Z StdDeviy
X StdDev StdDevZ
¥ StdDevy StdDev

| Preview file: C:YUsers\guk\Desktop\MpuMepsl dalinos ana PHOTOMOD \catalog. csv ]
Mame X Y z * * i

1 MNAME X Y il CODE TYPE |

2 00330101 580342206484 5410576.535619  479.331000 1 control 3

3 01450007 580302630684 5410896169489  475.422000 2 control N

4 01640010 581368759914 5410059165289  513.552000 3 control

5 01640032 580936.809204 5409695.248339  490.705000 4 control

6 01750031 580836.315094 5410912538169  520.657000 5 check -

4| mn 3

Points with existing names
@ Replace () Skip

[ skip empty text attributes

Convert coordinate system
Input coordinate system

WGES 84 UTM zone 32M (6deg East to 12deq East; northern hemisphere. Algeria. Austria. Cameroon. Denmark. Eq

Crientation: right, geo-referencng: global coordinate system

Qutput coordinate system
WGES 84/ UTM zone 32M (6deg East to 12deq East; northern hemisphere. Algeria. Austria. Cameroon. Denmark. Eq

Crientation: right, geo-referencng: global coordinate system

0K ” Cancel l

Fig. 161. Import of GCP catalogue

4. Make sure that the Line template was configured correctly.
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The Line template field displays a list of main and additional fields, which must be
located in each line of the import file:

* Name — object’s name;
ﬁ If imported file does not contain a column with GCP names (numbers), then after import

operation the names like Point0001 are assigned to the points automatically.

* X, Y, Z—values of GC point coordinates by X, Y, Z axes;

* [optional] STDDEVX, STDDEVY, STDDEVZ — accuracy of coordinates measurements
by X, Y, Z axes (RMS;

* [optional] * — marks columns with data which is not imported.

The Preview file table contains data of imported file. Fields type according to the
template, located in the Line template field, are automatically assigned to the table
columns.

All objects are saved using the same template. Each line of a file contains the same
number of fields, that equals to number of fields in template. Lines which does not
correspond to the template, are skipped. To all vertexes two (for 2D objects import)
or three coordinates are specified.

In order to begin the active template setup, perform the following:

* [optional] In order to display necessary number of lines in the Preview file table,
set the Preview maximum parameter. 10 lines are displayed by default.

* [optional] In order to define a line from which to start data import, input the line
number to the Start import from line field.

% In many cases, the imported file may have a first row containing headers describing the
contents of the columns in the file. Accordingly, this row should not be included in the
imported data, but its display in the Preview file table may be useful when setting up

the row template. It is recommended to set this parameter at the very end.

* Inthe Field separators section set single or multiple checkboxes to specify field
separators in the file: comma, space, tab, semicolon or other. The comma and
space are set by default.

* In the Decimal separator section set the following parameters:
o Point only — to use only a point as a decimal separator in coordinates;

o Point or comma — to use both a point and a comma as a decimal separator
in coordinates.
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é If the Field separator is selected as a comma, it is not recommended to specify the
Decimal separator as a comma, since objects with incorrect coordinates will be
created after import operation.

* [optional] In the Misc section set the following checkboxes:
o UTF-8 — is used to recognize text in Unicode coding;

o Parse degrees minutes seconds — is used to recognize records from the list
of projection centers or GCP.

When using this parameter it is highly recommended to check recognizing correctness
after import operation.

In order to finish the active template setup, perform one of the following actions:

+ drag a field name from the Available fields list to the Preview file table column
header. After that the template in the Line template field is changed. To cancel
a field selection, double click the Preview file table column;

» change a template manually in the Line template field. After that column types
in the Preview file table will be changed automatically.

% The i} button is used to return to default template Name, X, Y, Z.

@ The %] button is used to compare the Line template field with data shown in the Preview
file table.

@ The & button is used to replace specified fields names with fields names from the first line
of the Preview file table. It is possible to specify any names for vectors import.

@ For import of laser scanning data the field names from the list of available names are
specified.
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C:/Users fquk/DesktopMpumepe dainos ana PHOTOMOD fcatalog. csv

Line template Mame,X,¥,Z,*,*,5tdDevy, StdDevY, StdDevz] - ﬂ @ _ﬁ.
Start import from line 1 1 Preview maximum 10 = lines

V| Automatically validate template

Field separators Decimal separator Misc
| Comma Tabulation [¥| Space @ Paoint only LUTF-8
Semicolon Others Point or comma Parse &' ™

Available fields

MName £ StdDeviy
X StdDevi StdDevZ
¥ StdDevy StdDev

| Preview file: C:Wsers\guk\Desktop\Mpumepe: dafinos ans PHOTOMOD \catalog. csy =
Mame X ¥ i * * it

1 MNAME X ¥ Z CODE TYPE |

2 00330101 580342.206484 5410576535619  479.331000 1 control 1

3 01450007 580303630684 5410896.169489 475422000 2 control

4 01640010 581368.759914 5410059165289  513.552000 3 control

5 01640032 580935809204 5409696.248339  490.705000 4 control

6 01750021 580836.315004 5410912538169  520.657000 5 check -

Fl 1 4

Fig. 162. Setup of a template sample

For automatic selection of current template the Automatically validate template
checkbox is set by default. In order to setup a template for a file that contains lines
with different number of columns, clear the Automatically validate template
checkbox and setup the template manually in the Line template field.

5. Inthe Points with existing names section specify actions to perform when names
of imported GC points coincide with points names already existing on the GCP list
tab:

* Replace - allows to replace a point with the same name in the list, i.e. the point
data will be updated;

» SKkip - allows to cancel import of GCP with the same name.

6. [optional] To prevent creating text attributes without value during import, set the Do
not create empty text attributes checkbox on.

When the Do not create empty text attributes checkbox is on, in some cases a data loss

may OcCcur.

7. [optional] To convert coordinate system set the Convert coordinate system
checkbox and specify source and output coordinate systems.
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8. Click OK. The Import ground control points window opens, which contains the
GCP table to be added. Points which names are the same as names of existing
GCP in the GCP list of the Triangulation points window are shown by red color,
new GCP — by black color.

. Import Ground Control Points lé]
B E:3f =EoE
X om ¥. m Zm Std. dev. X, m Std. dev. X, m Std. dev. X, m
I 580342.2065 5410576.536 479.331 0.2 0.2 0.2
| 01450007 580303.6307 5410896.169 475422 0.2 0.2 0.2
| 01640010 581368.7599 5410059.165 513.552 0.2 0.2 0.2
| 01640032 580936.8092 5400595.248 480.705 0.2 0.2 0.2
| 01750031 580836.3151 5410912.538 520857 0.2 0.2 0.2
| 02410031 580464645 5410072.308 482411 0.2 0.2 0.2
| 03850029 5808214026 541052741 438,609 0.2 0.2 0.2
| 04930011 5809413261 5410131.409 499.344 0.2 0.2 0.2
| 04930069 581405405 5410505.799 520.888 0.2 0.2 0.2
CK ] | Cancel

Fig. 163. Selecting GCP to be added to the list

9. Select points to be imported using checkboxes and/or standard selection tools.
Click OK. After that coordinates of GC points with set checkboxes will be loaded in

the end of the GCP list.

ﬁ If in the Points with existing names section the Skip parameter is selected, then only
new GCP are selected for adding by default, if the Replace parameter is selected, all GCP
checkboxes are selected to be added.

ﬁ If RMS of X, Y, Z coordinates was not imported or is absent in GCP file, then default value
of RMS for all coordinates is 0.2 meters.

7.2. Export of triangulation points

7.2.1. Export of tie points to PAT-B

The system provides possibility to export tie points from current project to a file of PAT-

B format.

é If a project contains points with name in text format (the Name column contain letters), select
these points and click the & button of the Triangulation points window toolbox. After that nu-

meric names will be assigned to selected points.

To export coordinates measurements of triangulation points to PAT-B format perform
the following actions:
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1. Choose Orientation » Export » Export tie points to PAT-B... or click the drop-
down arrow next to the ki button of the Tie points tab toolbar in the Triangulation
points window and select Export to PAT-B. The Export measurements to PAT-
B window opens.

( . Export measurements to PAT-B [&r
File with point coordinates
Aalen_DMC_training_Brusnikin.xyz |:/
Swap XY

| File with measurements

Aalen_DMC_training_Brusnikin.mea I:/
pix @ mm mcm
Refined camera coordinates

| Synchronize file names

Export selected points only

Ok ] | Cancel

Fig. 164. Export measurements to PAT-B

2. Setthe File with point coordinates checkbox to export coordinates of measured
GCP to file with *.xyz extension and click the _... | button, specify filename and its
location out of active profile resources (see also the description of the file format
which contains geodetic coordinates in Section C.1.1).

% If there is a coordinate system different from source one (left/right), set the Swap X Y
checkbox to swap X and Y coordinates.

% If the Swap X Y checkbox is cleared, GC and tie points coordinates are exported in the
right coordinate system. Otherwise, in the left one.

3. Set the File with measurements checkbox to export coordinates measurements
of all triangulation points to file with *.mea extension and click the _... | button. Then
specify filename and its location out of active profile resources (by default, the
system suggests location at the same folder with file of geodetic coordinates). A
description of the file format see in the Section C.1.2.

Specify measurement units for point coordinates measurements, that are used in
images coordinate system and select pix, mm or mem. If the measurements con-
sider distortion correction and principal point shift, set the Refined camera coordin-
ates checkbox.
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4. [optional] To change file names with *.xyz and *.mea extensions all at once set the
Synchronize file names checkbox. After that when one file name is changed, an-
other file name will automatically receive the same name.

5. [optional] In order to export just selected points from the Triangulation points
window, set the Export selected points only checkbox.

6. Click OK to complete the export operation.
7.2.2. Export of triangulation points to X-Points

The system provides possibility to export triangulation points from current project to a
file of X-Points format. It is possible to export all or just selected points from triangulation
points catalogue, including points with unknown coordinates.

To export all triangulation points of the current project perform the following actions:

1. Choose Orientation » Export > Export tie points to X- Points.... The Export
measurements to X- Points format window opens.

2. Click the _... | button, specify filename and its location out of active profile resources.
3. Click OK to export triangulation points to specified file.

To export only selected triangulation points perform the following actions:

1. Open the Triangulation points (any of the both tabs).

2. Select triangulation points in catalogue, using the Shift key to select multiple points
at once or the Ctrl key to add multiple points to already selected ones.

3. Click the drop-down arrow next to the i button of the Triangulation points win-
dow toolbar and select Export to X-Points.... The Export measurements to X-
Points format window opens.

r !
. Export measurements to X-Points format liE-J

X-Paints file
Aalen_DMC_training_Brusnikin. x-points| _l

Export selected points only

[ OK ]| Cancel |

L™ A

Fig. 165. Export selected triangulation points to X-Points file format

4. Click the _... | button, specify filename and its location out of active profile resources.
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5. Set the Export selected points only checkbox if it is not set automatically.

6. Click OK to perform export of selected points.
7.2.3. Export of tie points catalogue to CSV

The system provides possibility of tie points table export from the current project to a
file with *.csv or *. txt extension.

To export tie points table of current project perform the following actions:

1. Click the drop-down arrow next to the L& button of the Tie points tab toolbar in the
Triangulation points window and select Save active view as CSV.... The Save
window opens.

2. Define a filename and its location out of active profile resources.
3. Click Save to export table to specified file.

7.2.4. Export of GCP catalogue to CSV

The system allows to perform export of GCP list from current project to file with *.csv
or *.txt extension.

To perform export of GCP list click the L button on the GCP list tab of the Triangulation
points window and select Export to CSV.... . The Export GCP catalogue window
opens. Specify a name of text file and its placement out of active profile resources. Click
Save to export GC points to specified file.

GC points are exported to text file with the following list of fields:

NAME, X, Y, Z, CODE, TYPE, STDDEVX, STDDEVY, STDDEVZ, where:

* NAME — GC point name;

* X, Y, Z—coordinates values (the * symbol is used to mark absent coordinates values);
* CODE — a point’s code;

* TYPE — GC point type (control — GCP, check — check);

» STDDEVX, STDDEVY, STDDEVZ — RMS of GCP coordinates.

In the sample shown below the comma symbol is used as fields separator, and the full
stop is used as decimal point. The first row contains fields headers.
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i@ Lister - [E:\delme',gcp.csv]
File Edit Options Help
NAME ,X,¥,Z,CODE,TYPE,STDDEVX ,STDDEVY ,STDDEVZ

1,2589178.930000,6587072
2,2590327.290000,6586268
3,2592166 . 440000,65854606

5,2588804.170000,6584652

8,2586651.650000,6582140

|

0] x|

100 %

.860000,7.760000,1,control,0.100000,0.100000,0.100000 :l
.840000,3.610000,2,control,0.100000,0.100000,0.100000
.780000,4.280000,3,control,0.100080,0.100000,0.1000808
4,2590158.670000,6583583.

5060080,2.930000,4,check,08.100000,0.100000,0.1080000

-120000,8.930000,5,check,0.160000,0.100000,0.100060
6,2586532.330000,6584538.
7,2584970.460000,6582674.

976000,7.020000,6,control,0.100000,0.100000,0.100000
696000,6.650000,7,control,f.100000,0.100000,0.100000

.930000,22.930000,8,control,6.100000,0.100000,0.100000
9,2588212.340000,6580808.

260000,19.220000,9,control ,0.100000,0.100000,0.100000

b

M 4

Fig. 166. Sample of GCP catalogue exported to text file

7.3. Export triangulation points to PHOTOMOD Geomosaic

7.3.1. Export of project tie points to PHOTOMOD Geomosaic

The system provides possibility of quick export of project triangulation points to Geo-
Mosaic and to use them as tie points there.

To export coordinates measurements of project triangulation points to GeoMosaic,
perform the following actions:

1. Choose Orientation > Export » Load triangulation points as GeoMosaic tie
points. The Load triangulation points window opens.

Fig. 167.

i A
. Load triangulation points ﬁ

Select point coordinate sources:
Ground contral point catalogue

Block scheme
adjustment reslts

[ OK ] [ Cancel

hy A

Load triangulation points as Geomosaic tie points

[optional] To export triangulation points from GCP list (see the Section 5.3) the

Ground control point catalogue checkbox is set by default.

[optional] To export triangulation points from the Block scheme layer in 2D-window,

the Block scheme checkbox is set by default.
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4. [optional] To export adjusted points coordinates from GCP catalogue the Adjustment
results checkbox is set by default.

5. Click OK. The system displays information window containing information about
added or skipped points.

6. Click OK. The Triangulation points (Vectors) layer is created. Vector point objects
(triangulation points) are displayed on block scheme in 2D-window. When creating
a project in GeoMosaicusing project images there is a possibility to use the Trian-
gulation points (Vectors) layer as tie points.

7.4. Export of raster outlines of triangulation points

The system allows to create raster outline of triangulation points (as georeferenced
raster images and corresponding world files). Optionally, when outlines are created,
the corresponding triangulation points also are exported to PAT-B and / or CSV files
(see above).

World file is a text file used for georeferencing raster images (raster maps, orthophoto
maps) in geoinformation systems. The name of the world file must match the georefer-
enced image name. There are several ways to set the world files extension:

» The extension is set by the first and /ast letter of the georeferenced file with the letter

w” (as in “world”) at the end:

o image1.png corresponds to the world file image1.pgw;

o image1.tif corresponds to the world file image1.tfw;

o image1.rsw corresponds to the world file image1.rww;

o image1.ntf corresponds to the world file image1.nfw;

o image1.bmp corresponds to the world file image1.bpw.
This method is used by the system when exporting outlines.

[{3 ti

* The extension is set by adding the letter “w” to the georeferenced file extension: image
“image2.jpg” corresponds to the world file “image2.jogw*;

* The *.wld extension is assigned to the world file: the “image3.jpg” image corresponds
to the world file “image3.wld";

To export the raster outlines of the triangulation points, take the following steps:

1. [Optional] Select the triangulation points in the directory using the Shift key to select
multiple points at the same time, or Ctrl to add multiple points to the already selected
points;
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2. Click the [ button on the Tie points catalog tab in the Triangulation Points. The
Outlines export window opens;

i . Outlines export Iﬁﬁ

Export options
Output file

=

[7] save as PAT-B (*.xyz)
] save as CSV (*.csv)

|:| Use image name as suffix
Cutline format

BMp -

Pixel size 0.069 =

Outline size 10 | % 10 5
[] Export selected

Points type

[] control [] Chedk
[] coordinates not used ] Tie

[7] Unused tie point [7] Targeted
[] Measured automatically

Labeling outline centers by symbals

Choose option Symbol color  Symbol size

@ Cirde () Cross :] a

’ oK l ’ Cancel

Ak

Fig. 168. The outlines export window

3. Click the _... | button to specify the names of the export files and their location outside
the active profile;

4. [Optional] To export triangulation points to a PAT-B file the Save as Pat-B (*.xyz)
checkbox is set by default;
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10.

1.

12.

[Optional] Set the Save As CSV (*.csv) checkbox to export triangulation points to
a CSV file (see Section 7.2.3 and Section 7.2.4);

[Optional] Set the Use image name as suffix checkbox to use of one of the images
names where the triangulation point is located as a suffix to the name of the corres-
ponding raster outline;

Choose Outline format — BMP (by default), GeoTiFF, RSW, PNG or NITF;
Specify Pixel size in pixels;
Specify Outline size in pixels;

[Optional] Check the Export selected checkbox to create the outlines of the points
selected in the catalog only (see paragraph 1);

Set Points type to create a raster outline by checking the corresponding check-
boxes:

* Ground control point — to create raster outlines of all ground control points;
» Check point — to create raster outlines of all check points;
 Tie point — to create raster outlines of all tie points;

» Targeted point — to create raster outlines of all densification points (see the “Point
properties” chapter);

* Unused tie point — to create raster outlines of all triangulation points that are
not used in georeferencing (see the “Point properties” chapter);

» Coordinates not used — to create raster outlines of all triangulation points ex-
cluded from orientation (see the “Point properties” chapter);

* Measured automatically — to create raster outlines of all automatically measured
triangulation points (see the “Point properties” chapter);

% To create outlines and / or export files, you must set at least one point type.

[Optional] Check the checkbox Labeling outline centers by symbols if labeling
outline centers is necessary. Specify the following parameters for labeling outline
centers:

+ Symbol shape — Circle or Cross;

+ Symbol color;
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* Symbol size;

Fig. 169. Different ways of labeling outline centers

13. Click OK. Separate raster outline files for all selected triangulation points are created
along with corresponding world files, corresponding csv-files (containing center
coordinates for the separate outline), as well as joint export files for triangulation
points in PAT-B and / or CSV formats (optionally).

< The names of the raster outline files, depending on the export settings, can be different,
for example:

« “7777_3899_3900_0002_1834.bmp” or

« “7777_3899 3900 _0002_1834_fly1_MIIGAIKDSC03900.bmp”

Where:

« “7777 is the specified name of the export files;

+ “3899 3900 0002_1834" is the name of the triangulation point in the directory;

* “fly1_MIIGAIKDSC03900" is a suffix composed of one of the images names where the
triangulation point is located (if the corresponding checkbox was set).

7.5. Import and export of exterior orientation parameters

7.5.1. Export of exterior orientation parameters

The system provides possibility to perform export of list of source exterior orientation
parameters and adjustment results to PAT-B and CSV formats.

In order to export exterior orientation parameters from a project perform the following
actions:

1. Choose Orientation > Import exterior orientation or click the button in the
Exterior orientation parameters window. The Exterior orientation parameters
export window opens.
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F '
’. Exterior orientation parameters export ﬁ

Data to export

i@ Ext. orientation catalogue ) Adjustment results

Expart formats
[”] PAT-B (*.0ri)
C:YUsersi\guk\Desktop\pumepel dainos ana PHOTOMOD\orient. ori
CSV (*.cav)
C:/Users fguk/Desktop Mpumepsl dainos ana PHOTOMOD farient, csv E]
CSY field list
Image code (CODE)
Image name (NAME)
Time {TIME)
XYZ (X, Y, Z)
Tun XYZ (TYPE_XYZ)
¥YZ std. dev. (STDDEVY, STDDEVY, STODEVZ)
Omega, phi, kappa angles (OMEGA_DEG, PHI_DEG, KAPPA_DEG)
Angles type (TYPE_ANGLES)
Angles std. dev. (STDDEVOMEGA_DEG, STDDEVPHI_DEG, STDDEVKAPPA_DEG)

[ Select all l ’ Unselect all ] ’Name, ¥YZ, angles]

Synchronize file names
|:| Swap XY

[ oK l [ Cancel

Fig. 170. Exterior orientation parameters export

2. Inthe Data to export section select data to be exported:

+ ext. orientation catalogue — used to export source data (projection centers co-
ordinates, exterior orientation angles, etc.);

+ adjustment results — used to export adjusted projection centers coordinates
and exterior orientation parameters.

3. Inthe Export format set checkbox or both checkboxes to export data into chosen
formats:
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* PAT-B - is exchange text format with *.ori extension, which is supported by
major applications in different industries (see Section B.1);

* CSV -is exchange text format with *. csv extension, when the data is represented
by table with specified list of fields.

4. Click the _... | button, specify a filename and its placement out of active profile re-
sources.

5. [optional] In order to setup a list of fields to be exported to CSV file, set the following
checkboxes:

* Image code — stated name of image;

* Image name — a name of image;

» Time — precise time from GPS-receiver;

» XYZ — values of projection centers coordinates in meters;

« XYZ type — type of projection centers coordinates;

+ XYZ std.dev. — RMS error of projection centers coordinates in meters;
+ Omega, phi, kappa angles — values of exterior orientation angles in degrees;
» Angles type — type of exterior orientation angles;

* Angles std.dev. — RMS error of exterior orientation angles.

To perform export of all fields, click the Select all button.

To clear all checkboxes click the Unselect all button.

To perform export of just fields with images numbers, projection centers coordinates
and exterior orientation angles, click the Name, XYZ, angles button.

6. [optional] To change file names with *.ori and *.csv extensions all at once set the
Synchronize file names checkbox. After that when one file name is changed, with
*.ori extension, for instance, file with *. csv extension will be renamed automatically.

7. [optional] To swap X and Y coordinates, set the Swap XY checkbox.
é If the Swap X Y checkbox is cleared, the data is exported in the right coordinate system.

Otherwise, in the left coordinate system.

8. Click OK. After that exterior orientation data is exported from thelist of exterior
orientation parameters to selected file.
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7.6. Export georeference data

The system provides possibility to perform export of source data to GIS without prelim-
inary processing inMosaic to files with *. tab or *tfw extension. At that georeference is
performed using projection of image corners on specified plane (with no height specified).

To save georeference data file perform the following actions:

1. Choose Orientation > Create images georeferencingfiles.... The Create images
georeferencing files window opens.

’. Create images gecreferencing files [iE-J

Format

@ ArcInfo Waorld File
MapInfo TAB

Source data

5 et re +
Adjustment results

mported exterior orientaton
LU LTI LT TLa g

@) Block layout

Project on constant altitude: 0.00 1 MeTp

Coordinate system
@ Coordinate system of the project
LatitudeHongitude WGS-84

(04 ] | Cancel

Fig. 171. Save of project images georeference data

2. In the Format section set one of the following formats:

* Arcinfo World File — for further export of saved file with *.tfw extension to
Arclinfo;

* Maplinfo TAB - for further export of saved file with *.tab extension toMapinfo.
3. Inthe Source data section set a source of initial data:

» Adjustment results — adjusted (in third party software) projection centers co-
ordinates and exterior orientation parameters;
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* Imported exterior orientation — exterior orientation parameters;
* Block layout — block layout results.

4. [optional] If it is necessary to perform georeference by projecting images corners
on a plane with specified altitude, input altitude value in meters to the Project on
constant altitude input field.

5. Inthe Coordinate system section set a coordinate system that is used for images
georeference saving Coordinate system of the project or Latitude-longitude
WGS-84.

6. Click OK. After that the system displays information window which contains inform-
ation about saved images georeference data.

7. Click OK. After that georeferenced images are saved to active profile resources in
selected format.

8. Processing report

The system provides possibility for viewing the results of block processing after auto-
matic tie point measurement (UAS) and adjustment.

Processing report contains data on the project’s properties, parameters of automatic
tie point measurement and adjustment, lens calibration, and summary on block errors.

Q The system allows to create the processing report for projects of the “Central projection” type.
Creation of block processing reports for projects of “Satellite scanner imagery”, “Airborne Digital
Sensor ADS”, and “VisionMap A3” types is not provided (see the “Project types” section in the
“Creating project” User Manual).

ﬁ Itis necessary to perform automatic tie point measurement and adjustment before the processing
report creation.

In order to create the processing report choose Orientation » Processing report. After
the operation is complete, the block processing report file opens in standard viewer.
The report file have *.pdf extension.
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(@ Fepon PN )
12w RE a

Block processing report

PHOTOMOD version 6.3.2161 x64

m

Project properties and initial data

Project GeoScan_Seminar_Roma
Report time 6 oktABpA 2017 r_, 16:51:01
Cameras MNEX-5R. x-cam
G3D, metp 0.062
Coordinate system WGS 84 7 UTM 37N
Height range, metp 120.000 - 260.000
Area, metp? 458642 916
Mumber of images 27
Mumber of strips 3
Number of tie points 0
Mumber of ground control points 10
MNumber of check points 1

Processing parameters

Project GeoScan_Seminar_Roma

Report type

Correlator configuration

Calibrate camera COn
Make an adjustment On
Apriori accuracy of measurements on images, 1500
pix ’ B
q i ] 2

Close

Fig. 172. Processing report

Block processing report contains the following main elements and sections:
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» the Project properties and initial data section of a report used to view general
statistics (see also the “Project properties” chapter of the “Creating project” User
Manual) and contains the following information:

o a project name;

o

report generating date;

(0]

camera data;

(0]

GSD (Ground Sample Distance) — a pixel size on ground for digital images;

o

project coordinate system;

o

project heights range in meters;

area of the in m?;

o

(@]

a total number of project strips/images;

o

a number of tie/check/groud control points;
o a block scheme and visual display of project heights range.

» Tie-point statistics by number of measurements report section that contains inform-
ation on tie point distribution by the number of measurements performed;

@ Data on all triangulation points, including GCPs, are displayed in this section.

* Subblocks list report section that contains information on image distribution by
subblocks;
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Tie-iints statistics

1 2 4984

2 3 3576

3 4 1615

4 5 826

5 6 452

6 7 192

7 8 87

8 9 E

9 10 14

10 11 2

11 12 2
Subblocks

Subblock 1 40

Fig. 173. Tie-point statistics and Subblocks report sections

» the Processing parameters section of a report used to view the parameters of
automatic tie point measurement and block adjustment;

Processing parameters

Report type .
Correlator configuration -
Calibrate camera Off
Make an adjustment On
Apriori accuracy of measurements on images, pix 1.000
Assign the camera after calibration On
Delete temporary data On

Adjustment parameters
Initial approximation method: By block scheme
Adjustment method: Bundle adjustment
Systematic error compensation For block
Calibration type: None
Rolling shutter Not compensated
Time of processing -

Fig. 174. The Processing parameters section

* Results of camera calibration.

272



PHOTOMOD 8.1

Aerial triangulation (Windows x64)

Results of camera calibration

Camera XUu150 U150 [selfcal)
Focal length, rmm 55.000 55.094
Principal point (¥/Y), mm 0.000 / 0.000 -0.036/1.829
Pixel size (X/Y), mm 0.005 / 0.005 0.005 / 0.005
Type of distortion, mm —men Formula
Point of syrrmetry (X/Y), mm 0.000 / 0.000 -0.036/1.829
K1 0.000000 -0.000024

K2 0.000000 9.3201558e-09
K3 0.000000 1.830551e-12
K4 0.000000 0.000000

K% 0.000000 0.000000

P1 0.000000 -4.543816e-06
P2 0.000000 -1.024945e-06
P3 0.000000 0.000000

P4 0.000000 0.000000

bl 0.000000 0.000054

b2 0.000000 2.158602e-06

Fig. 175. The Processing results section

» the Exterior orientation parameters accuracy section of a report used to view re-
siduals on linear and angle exterior orientation parameters (see the “The “Report”
tab” chapter of the “Block adjustment” User Manual). Contains the following tables:

o Control exterior orientation parameters;

o Check exterior orientation parameters;

o Systematic errors.
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Exterior orientation parameters accuracy

0.900 meTp
Control exterior orientation parameters
RMS 0.533 0.445 0.034 0.000 0.000 0.000
Mean absolute value 0.334 0.283 0.026 0.000 0.000 0.000
Maximum 1.739 1.429 0.124 0.000 0.000 0.000
Check exterior orientation parameters
| No check exterior orientations |
Global per block -0.000 0.000 -0.000

Fig. 176. The Exterior orientation parameters accuracy section

+ the Points residuals section of a report used to view and analyse the block adjustment

results (see the “Brief residuals report” chapter of the “Block adjustment” User
Manual) and contains the following tables:

o Stereopairs residuals — a table containing tie point measurement difference
between stereopairs (see “Brief residuals report” in the “Block adjustment” User
Manual);

o Errors in images.
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Points residuals

Stereiair residuals

From mean
RMS 0.000 0.000 0.000
Mean 0.000 0.000 0.000
Max 0.000 0.000 0.000
Mutual
RMS 0.000 0.000 0.000
Mean 0.000 0.000 0.000
Max 0.000 0.000 0.000
Errors in ‘lnaies
RMS 0.000 0.000 0.000
Mean 0.000 0.000 0.000
Max 0.000 0.000 0.000

Fig. 177. The Points residuals section

» the Ground control and check points accuracy section of a report used to view
and analyse the block adjustment results (see the “Brief residuals report” chapter of
the “Block adjustment” User Manual) and contains the following tables:

o Ground control point residuals — adjustment residuals on GC points;

o Check point residuals — adjustment residuals on check points.

Ground control and check points accuracy

Ground control point residuals
| No control points l

Check point residuals

DFO3 0.020/0.020/0.030 -0.031 0.102 0.223 0.107
DFO4 0.020/0.020/0.030 -0.029 0.085 0.137 0.100
DFO5 0.020/0.020/0.030 -0.062 0.116 0.122 0.132
DF06 0.020/0.020/0.030 -D.088 0.173 0.104 0.194
DFO7 0.020/0.020/0.030 -0.106 0.159 0.146 0.191
DFO8 0.020/0.020/0.030 -0.097 0.187 0.138 0.211
DF09 0.020/0.020/0.030 -0.145 0.159 0.129 0.215
DF10 0.020/0.020/0.030 -0.168 0.145 0.274 0.225
DF11 0.020/0.020/0.030 -0.171 0.171 0.201 0.242
GTOB 0.020/0.020/0.030 -0.104 0.230 0.109 0.253
GT09 0.020/0.020/0.030 -0.186 0.166 0.185 0.249
GT10 0.020/0.020/0.030 -0.013 0.131 0.075 0.131
Fig. 178. The Ground control and check points accuracy section

275


solver.pdf

PHOTOMOD 8.1 Aerial triangulation (Windows x64)

Appendix A. Number of points recommended for adjustment
of scanner block

There are some recommendations about number of GCP and check points used for
different methods adjustment of images included to scanner mono/stereoblocks.

% For space scanner images it is possible to use only XYZ GCP (with X, Y, Z coordinates).

Rigorous method

Monoblock Stereoblock

FORMOSAT-2
EROS A,B
KOMPSAT-2 4-6
SPOT 1-4 _ per
TERRA/ASTER Image
SPOT 5-4
Resours DK -6

KOMPSAT-2
SPOT 1-4 L
TERRA/ASTER
SPOT5-4

Ground control
points

3-4 3-4

points in points in
double quadruple
averlap area overlap area

Fig. A.1. Number of points recommended for adjustment of scanner block by rigorous method

§, If a monoblock contains images with triple or quadruple overlap area, it is recommended to
measure several points in this area.

ﬁ, Number of GCP could be decreased due to tie points measured in triple or quadruple overlap.
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Ground control
points

Check points

RPC-method
Monoblock Stereoblock
.
QuickBird —
OrbView-3
WorldView-1 1-4 GeoEye-1
GBOEyS- 1 per image IKONOS 1 '4
IKONOS ALOS (PRISM) |
Pleiades KOMPSAT-2 45
ALOS (PRISM) Cartosat-1 (IRS PS)}
KOMPSAT-2 | 45 :
Cartosat-1 (IRS P5) | per image per stereopair

points in

area

double overlap |

34
points in

quadruple
overlap area

Fig. A.2. Number of points recommended for adjustment of scanner block by RPC method

7

Number of GCP could be decreased due to tie points measured in quadruple overlap.
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Generic method

Maonoblock Stereoblock

Landsat 7/ETM+
IRS-1C/PAN 7-10
IRS-1D per

IRS P6 (Resourcesat-1) | image
ALOS (AVNIR-2)

Ground control
points

Not
necessarily

Not
necessarily

Fig. A.3. Number of points recommended for adjustment of scanner block by generic method
g Recommended number of check points on images is not absolute and in many cases is determ-

ined by the customer requirements to specific project. Nevertheless, it is necessary to have
check points available for objective estimation of adjustment accuracy.

Appendix B. Supported formats for import and export of ex-
terior orientation parameters

B.1. PAT-B

PAT-B - is exchange text format with *.ori extension, which is supported by major
applications in different industries.

File with exterior orientation parameters of images in PAT-B format contains adjusted
coordinates of projection centers and matrices of exterior orientation rotation angles.
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The first line of PAT-B format file has the following structure:
Image number, 0.0, X, Y, Z, where:
X, Y, Z — coordinates of projection centers.

Then there are two lines containing 9 values of matrices elements of exterior orientation
rotation angles, as follows:

all, a21, a31, a12, a22
a32, al13, a23, a33

The matrix elements are calculated using the following formulas:

ay = cos(¢) cos(K);

ay = cos(x) sin(¢) sin(®)+cos(®) sin(x);
ay = —cos(x) sin(¢) cos(w)+sin(¢) sin(x);
aj=—sin(k) cos(¢ ),

ay = cos(k) cos(®)—sin(®)+sin( ) sin(k);
ay,=sin(¢ ) cos(k)+ cos(®)+sin( ) sin(k)
;= sin( ¢ );

ayy=—sin(®) cos(®),

ay3;=-cos(®) cos( ),
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& tatal.pat - Notepad B =10] x|
File Edit Format Help

| 825, 0.000, 597844.695, 247926.763, 1566.579 i’
0.647630244617, 0.761943717777, -0.004103315426, -0.761854350979, 0.647448050577
-0.019720640725, -0.012369334572, 0.015897812125, 0.999797108984
824, 0,000, 597368.692, 248461 550, 1580.238
0.664336693507, 0.747128583700, 0.021345657139, -0.747116920044, 0664615547546
-0.010123307074, -0.021750067690, -0.009222417269, 0999720901840
826, 0.000, 598299.412, 247403.933, 1562.141
0.662365016290, 0.749169469683, 0.003703604970, -0.749178167310, 0.662364978392
0.002170029101, -0.000827418675, -0.004212017855, 0.999990757100
823, 0.000, 596888.305, 248981.693, 1590.220
0701803818036, 0.712291267628, -0.010509008051, -0.712368589608, 0.701756676194
-0.008280093983, 0.001547103588, 0.013368525673, 0.999909440395
827,  0.000, 598783.400, 246877 490, 1570337
0.694060755138, 0.719915537297, -0.001134608603, -0.719483983622, 0693697595855
0.033562516739, 0.024949252531, -0.022478092994, 0999435976005
828,  0.000, 599269.838, 246386.326, 1584.112
0.702033986712, 0.712138422978, -0.002673052856, -0.711855401200, 0.701851841927
0.025804646235, 0.020252567146, -0.016212911610, 0.999663430871
829, 0,000, 599765.811, 245892.324, 1592.102
0.691914675583, 0.721972287256, -0.003177755245, -0.721913079496, 0.691904133059
0.010496490288, 0.009776579165, -0.004968610432, 0.999939550964

4 AW

Fig. B.1. Sample of PAT-B file

Appendix C. Supported formats for import and export of tri-
angulation points

C.1. PAT-B

C.1.1. Format of file containing points geodetic coordinates

File with *.xyz, *.txt or *.csv extension, containing points geodetic coordinates is a
table.

Each line of *.xyz, *.txt, *.csv file:
GCP number, X, Y, Z
where X, Y, Z — GC point coordinates.

Fields delimiter is space or multiple spaces.
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-lo/x]

File Edit Format Help

[ 0 i’
1000 FRO100,276 231791, 548 Gl. 510
1001 FATBZ6.420 152887, 720 B3.370
1004 EELE e 185558, 5582 B9, 400
1006 FAF7OE. 228 1859083, 001 BE.770
1007 F38314. 070 185087,457 B5.620
1010 FA5402. 564 188344, 507 B5.070
1011 748846, 762 231131.168 B9.420
1012 748855, 885 231150.154 5. 900
1013 F31073.938 185601.147 BGE.T20
1015 T318590. 541 1848759, 543 7. 080
1016 T29725. 385 182720, 881 BS. 840
1017 EEDEEER-T 15816585, 725 5. 980
1020 FIS097. T4 1585045, 319 B4 . 980
1022 FROZZE.TET 228921, 5268 Sl.&/50
1024 T29891.482 1759153, 277 B9.TTO0
1028 FI1AZE. 042 180643, 222 B5.480
1030 FR1F1E. 725 22B220.513 B7. 840
1034 F42255.148 187081, 558 B85.520
1036 F43012. 594 185768, 826 85.210
10359 730047, 065 157182, 261 85. 780
1040 75lad0, 685 225829, 529 86,820
1043 F26232.128 1596774, 850 85.220
1044 726995, 051 1595021, 404 85,690
1047 F33245,655 154675, 020 87,520
1051 FR2733. 565 226217.4534 G0, 810
1053 739164 ,198 1570988, 542 89,140
1055 738450, 680 1559300,315 89,750
1087 FA82BB.777 200%45,145 83,380
108G FAEELS. FEE 200044 ,153 B83.830
1061 Fh2B85, 382 223527.521 B6. 5970
1064 740400, 688 18595910, 717 BE.440
10646 FAO710, 441 1871058, 327 B5.130
1070 FH3886.930 223975.453 0,820 -

4] A

Fig. C.1. Sample of file with adjusted geodetic coordinates of points

C.1.2. Format of file containing measurements of points coordinates
on images

File with *.mea, *.txt or *. csv extension, containing measurements of points coordinates
on images is a table. The table includes sections of the same format, each of them
corresponds to individual image of a block.

The first line of each section has the following structure:
Image number, image focal length, 0

The second and successive lines contain a table of points:
Point number (name), X, Y

where X, Y — points coordinates relative to image principal point (in mm or mcm).

ﬁ In some cases the file contains point coordinates relative to reference point of camera coordinate
system (in mm, mcm or pixels).

Fields delimiter is space or multiple spaces.

The end of each section is marked by a line with -99 number.
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1ol x]
Mafin  MNpaeka ©®opWaT BWA  Chpaska
ROS_S8E7 153406.0 Q -
0556 04575, 2 F3257.1
0911 -286602.7 7B350.2
wlz2 -8748.1 54028, 7
w13 -B9702.6 -19562,2
*15 -55554.4 -102344, 2
w15 TEla3.4 11952.5
w18 -7686.1 -51046.6
w20 35020.3 -62369.1
w2B -5454.7 —-69827.9
w27 BE731.86 3098L.7
w2E -11151.3 19984, 7
w2AG 10400,8 22578.4
w30 Ga327.1 -66900,9
w31 GoE25.6 BY397.2
w32 -B023.0 Qo370.8
w33 o962, 0 G3612.0
RER -16869.1 Q6e717.5
-95
ROD_=86 153406.0 Q
0911 -050l19,9 98400.8
0908 -14494, 2 50413, 8
0504 47960, 2 -7TB357.2
w1z -B6365.9 -73273.9
w16 4603.4 -10688.4
w17 -53629.9 -5952.0
w1E 84809, 3 70194, 2
w15 BE135.2 -16205.9
wag -41678.9 -85134.0
w2l -6980, 8 47309, 0
w2 AO9%50, 2 -7814.9
el 5} -B4487.6 -L0262.6
w27 18174.2 FEEE8.0
w2E -B3022.1 2575.9 -
[« ;d

Fig. C.2. Sample of file with measurements of points coordinates on images

C.2. PAT-B (Trimble Inpho)

C.2.1. Format of file containing points geodetic coordinates

File cont.pat, containing points geodetic coordinates, consists of two tables.

Each line of first table contains:
* Point name;
» X-coordinate;

* Y-coordinate;

* Numerical designation that determines whether a point belongs to GC points (1) or

to the check points (2);

* Number of measurements in Trimble Inpho project (do not imported to PHOTOMOD

project).
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Each line of second table contains:
* Point name;
» Z-coordinate;

* Numerical designation that determines whether a point belongs to GC points (1) or
to check points (2);

* Number of measurements in Trimble Inpho project (do not imported to PHOTOMOD
project).

Fields delimiter is space or multiple spaces. The end of each table is marked by a line
with -99 number.

S
®aiin  lpaexa Mowce Bug  Kogwpoekn Cwertakcne  Ongun  Makpocer  3anyck  Mnarweer Okna 7 X

o o =] elghl D‘ |ﬁﬂb‘&“3 ='>|~—'I.‘"—'-I.|_='~' LJ@|°'E‘E‘E|@
E\mage.pat 3 E]cont pat ﬁl

20 ©-37-125 oT 137 7454137.470 6275839.341 1 0 -

21 ©-37-125_0T_138 7455051.074 6280291.680 1 0

22  0-37-125_0T_139 7459460.382 6264836.935 1 0

22 ©-37-126_oT 005 7465718.666 £282372.277 1 0

24 ©-37-126_o0T_07 7465288.012 6264783.589 1 0

25 -99

26 0

27 ©-37-113 oT 001 132.71¢ 1 0

28 ©-37-125_ET 001 142.312 2 3

2% 0-37-125_ET_01 224.17% 2 3

20 ©-37-125 KT 01-2 225.%36 2 3

21 ©-37-125_KT 02 217.481 2 3

22 0-37-125_ET_03 186.790 2 3

33 0-37-125_RT_04 212.051 2 3

24 ©-37-125 KT 264 194.574 2 3

35 0©-37-125_KT 364 184.127 2 3

36 0-37-125_0T_001 212.959 1 0

27 ©-37-125 oT_003 142.352 1 0

38  ©-37-125_oT 004 15¢6.064 1 0

29 0-37-125_0T_03 165.159 1 0

4 0-37-125_0oT_05 201.610 1 0 =

41 ©-37-125 oT 06 169.822 1 0

42 ©-37-125_oT 08 240.934 1 0

43 0-37-125_0T_116 143.828 1 0

44 ©-37-125 oT_136 207.132 1 0

45 ©-37-125_oT 137 194.259 1 0

46 0-37-125_0T 138 167.106 1 0

47 0-37-125_oT_139 215.348 1 0

48  ©-37-126 _oOT 005 218.877 1 0

49  ©-37-126_oT 07 198.15¢ 1 0

5 —95 -
Normal text file length: 2171 lines: 51 Ln:1 Col:1 Sel:0|0 Des\Windows ANSI as UTF-8 INS

Fig. C.3. Sample of file with adjusted geodetic coordinates of points
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C.2.2. Format of file containing measurements of points coordinates
on images

File images.pat, containing measurements of points coordinates on images is a table.
The table includes sections of the same format, each of them corresponds to individual
image of a block.

The first line of each section has the following structure:

Image number, image focal length (in mcm)

The second and successive lines contain a table of points:

Point number (name) X, Y

where X, Y — points coordinates relative to image principal point (in mm or mcm).

Fields delimiter is space or multiple spaces. The end of each section is marked by a
line with -99 number.

B o ] |
®aiin  lpaexa Mowce Bug  Kogwpoekn Cwertakcne  Ongun  Makpocer  3anyck  Mnarweer Okna 7 X
o o oolLE_ﬂl D‘ |ﬁﬂ}';§£"‘§ '3'|-".‘"—'-I.|_='~' LJ@|°'E‘E‘B|@
E[image pat rﬁlEJ-:-:-mt.pat ]
1 001 01 20220625 053316 RGE 92000.000 -
2 -99
2 001_02_20220625_053303_RGB 52000.000 E
4 -5%9
5 001_03 20220625 _053251_RGE 92000.000
& 0-37-126_0OT_005 —-6612.511 -5216.859
7 -59
8 001 04 20220625 053238 RGE 92000.000
2 ©-37-125_ET_001 -13690.341 -13590.58¢
10 ©-37-125_0T_03 -13293.272 -40803.682
11 ©-37-126_oT_005 16003.650 -5476.514
12 -99
12 001_05_20220625_053226_RGB 52000.000
14 ©0-37-125_RT_001 8640.511 -13636.655
15 0©-37-125 oT 03 9125.512 -40834.341
16 -99
17 001_06_202208625_053214_ RGB 52000.000
18 0©-37-113 oT 001 -16752.389 8804.067
19 -99
20 001_07_20220629_053201_RGB 52000.000
21 0-37-113_oT 001 5656.889 8847.150
22 -99
22 001_08_20220629_ 053149 RGB 92000.000
24 0-37-113_o0T_001 27887.742 9045.502
25 -5%9
26 001_09_ 20220629 053137_RGBE 92000.000
27 0-37-125_0T 004 -7021.280 552.277
28 -59
2% 001_10 20220629 053124 RGE 92000.000
20 ©-37-125_oT_003 -22955.339 -3642.600
31 ©-37-125_0T 004 15277.580 281.531 -
Normal text file length: 7575  lines: 243 Ln:1 Col:1 Sel:0|0 Des\Windows ANSI as UTF-8 INS

Fig. C.4. Sample of file with measurements of points coordinates on images
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